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Настоящите упражнения са разработени с цел усвояване работата с 

Географски Информационни Системи (ГИС). Те придружават и покриват 

основната част от практическите теми, разгледани в учебника „Курс по 

Географски Информационни Системи” (К. Попов, 2006), Представените 

тук упражнения са осъвременени така, че да могат да се изпълняват с по-

новите версии 10.х на софтуера ArcGIS.  

Задачите и тяхното изпълнение са представени в подробна форма, 

като за допълнителна информация за възможностите на софтуера към 

всяко упражнение можете да ползвате съответната глава от учебника или 

ръководствата, придружаващи програмата. 

Упражненията са разработени на базата на софтуера ESRI ArcGIS 

версия 10.х, дарен на МГУ от ESRI България, а за примерни данни са 

използвани основно данни, разпространявани заедно с този софтуер. Целта 

на упражненията е студентите да могат в голяма степен самостоятелно да 

усвоят основните похвати и анализи, използвани в ГИС. 
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Упражнение 1. Въведение в ArcGIS. 

Софтуерният продукт ArcGIS, разработван от Environmental Systems Research Institute (ESRI), 
представлява една от най-популярните и мощни комерсиални географски информационни системи. 
ГИС продуктите на ESRI работят на различни платформи, като настолни, сървърни, мобилни и 
онлайн. Софтуерът ArcGIS се предлага в три варианта на лицензиране, наречени ArcView, ArcEditor 
и ArcInfo, като най-ниското базово ниво ArcView съдържа широк спектър от средства за обработка и 
визуализация на гео-данни, а ArcEditor и ArcInfo предлагат допълнителни разширени възможности 
за анализ и работа с данните. Фамилията ArcGIS съдържа няколко програми: ArcMap, ArcCatalog, 
ArcGlobe и ArcScene. Основната от тях е ArcMap, която предоставя пълноценна ГИС-среда, докато 
ArcGlobe и ArcScene са специализирани за работа в триизмерна среда, а ArcCatalog представлява 
файлов мениджър за управление на данните. В допълнение към настолната фамилия ArcGIS ESRI 
предлага и така наречените „разширения”, като 3D Analyst, Spatial Analyst, Network Analyst и др., 
които представляват специализирани модули, предоставящи разширени възможности за работа с 
триизмерни данни, пространствени и мрежови анализи и др. Подробна информация относно 
продуктите на ESRI и техните възможностите може да намерите на сайта на компанията: 
www.esri.com. 

 

Първото упражнение има за цел да демонстрира основните компоненти и организацията на 
ГИС. Всички данни и компоненти от ГИС са организирани и структурирани в цялостна система, 
наречена „документ” или “проект”. В проекта се запомня кои данни са използвани при настоящата 
работа, как те са организирани и визуализирани и различни допълнителни настройки, като 
използвани проекции, анализи и резултати от обработката на данните и т.н.  

Стартирайте програмата ArcMap, като щракнете два пъти върху нейната икона. Другият начин 
да заредите програмата е от бутона Start да изберете Programs > ArcGIS > ArcMAP 10. При 
зареждане програмата извежда първоначален прозорец (с надпис в горната част ArcMap - Getting 

Started), чрез който ви се предлага да заредите вече създаден проект/карта (Existing Maps) или да 
създадете нова карта (New Maps), като използвате различни шаблони (Templates).  

 

Прекъснете тази първоначална функция за автоматично зареждане на съществуващи карти или 
шаблони, като използвате бутона Cancel.  

http://www.esri.com/
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На следващата фигура е показан основния изглед на програмата ArcMap. Можете да увеличите 
максимално прозореца на програмата, да заеме цялата площ на монитора, като използвате средния 
от трите бутона в горната дясна част на прозореца (Maximize).  

Голямата централна част на прозореца на програмата служи за визуализиране на данните, а 
лентата вляво (обозначена като Table Of Contents) се използва за показване и управление на 
съдържанието на картата, т.е. какви данни (слоеве) са заредени и как да бъдат визуализирани.  

Подобно на другите софтуери, в горната част на прозореца е разположена лентата с менюта 
(File, Edit, View и т.н.), като тук се намират основно стандартните функции за създаване и запис на 
картата; изрязване, копиране и вмъкване на данни (Cut, Copy, Paste) и др. Под основната лента с 
менютата са разположени и ленти с групи от икони (Toolbars), обединени според тяхното 
предназначение. Ако задържите курсора върху някоя икона, се появява надпис каква функция 
изпълнява тя, а за да включите или изключите дадена група можете да използвате менюто Customize 

> Toolbars или да щракнете с десния бутон на мишката върху празното пространство до менюто. 
Както виждате, списъкът с групи от икони (Toolbars) е доста голям, затова е препоръчително 
постоянно заредени да останат само най-често използваните, като Standard, Tools, Layout, Draw, 

Editor, Effects, а останалите да се включват само при нужда. Всяка група икони може да бъде 
отворена като плаваща лента, движена в прозореца на програмата, но можете и да фиксирате 
положението й, ако я преместите над, под, вляво или вдясно на работната площ.  

За да се упражните, включете и подредете изброените по-горе групи икони, както е показано 
на долната фигура. 

 

Нека сега разгледаме накратко менютата на програмата, но ако нещо не разберете – не се 
притеснявайте – при изпълнението на следващите упражнения ще разберете за какво служат и как се 
прилагат отделните команди.  

Менюто File предоставя стандартни възможности за създаване на нов проект (New) или 
зареждане на съществуващ проект (Open), за записване (Save, Save As, Save A Copy), за зареждане на 
данни (Add Data), настройки на страницата и разпечатване (Page and Print Setup, Print Preview, Print), 
експортиране на картата в други формати, като JPEG, TIFF, PDF (Export Map) и т.н. От това меню е 
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възможно и задаването на различни настройки на документа (Map Document Properties), като име, 
описание, автор и др., като важна опция тук е възможността за записване на относителните пътища 
до данните (Store relative pathnames to data sources), която ще разгледаме по-късно.  

Менюто за редакция Edit също съдържа стандартни функции, като отмяна или повторение на 
последното действие (Undo, Redo), изрязване, копиране, вмъкване и изтриване на данни (Cut, Copy, 

Paste, Delete), копиране на картата за да може да бъде вмъкната в друга програма или документ 
(Copy Map to Clipboard), както и за маркиране и размаркиране на всички елементи (Select All 

Elements, Unselect All Elements) и увеличаване на изгледа върху (максимизиране на) маркираните 
елементи (Zoom to Selected Elements).  

Чрез менюто на изгледа View може да превключвате между стандартния изглед за работа с 
данните (Data View) и изгледа за предпечатно композиране на окончателната карта (Layout View), да 
създавате и управлявате диаграми (Graphs) и отчети (Reports) по данните, да включвате и изключвате 
плъзгачите вдясно и под картата (Scroll Bars), лентата със статуса (Status Bar); помощните рулери, 
водещи линии и мрежа за подреждане (Rulers, Guides, Grid) в окончателната карта. Също така, от 
това меню можем да опресним или да временно да спрем изчертаването на картата (Refresh, Pause 

Drawing, Pause Labeling), което е полезно когато работим с големи обеми от данни и изчертаването 
на екрана става много бавно. От тук се задават и различни настройки на текущата карта (Data Frame 

Properties), които ще разгледаме по-нататък.  

Менюто Bookmarks служи за записване и управление на характерни текущи изгледи от картата. 

Менюто Insert предоставя функции за добавяне на нова карта към текущия проект (Data 

Frame), тъй като понякога е необходимо окончателния продукт да съдържа не една, а повече карти. 
Например, често при подготовката на разпечатвания продукт освен основната карта се добавят и 
други, като карта на фактическия материал, обзорна карта и др. Също така, чрез това меню, 
предимно при подготовката на окончателния план (Layout) могат да се добавят различни заглавия и 
надписи (Title, Text, Dynamic Text), различни рамки (Neatline), задължителните елементи за всяка 
окончателна карта, като легенда, стрелка за посоката на севера, мащабна линия или надпис (Legend, 

North Arrow, Scale Bar, Scale Text). Това меню позволява и вмъкването на картинка (Picture) или 
динамични обекти/документи от други програми (Object).  

Менюто Selection предоставя разнообразни и удобни начини за маркиране на обекти от 
картата, а менюто Geoprocessing съдържа множество функции за пространствена обработка на 
данните. Различните начини за маркиране, както и основните методи за гео-обработка ще бъдат 
подробно разгледани в някои от следващите упражнения.  

Менюто Customize дава достъп до различни потребителски настройки. Както вече видяхме, от 
тук могат да се включват и изключват отделните групи икони за бърз достъп до функциите на 
програмата (Toolbars). Също така, от тук могат да се активират или деактивират различни 
разширения (Extensions), които обогатяват възможностите на програмата, да се зареждат и 
управляват различни допълнения (Add-In Manager) и стилове  за изчертаване (Style Manager), както и 
да се задават основните настройки на програмата (ArcMap Options).  

Менюто Window позволява отварянето и затварянето на помощни прозорци, като обзорен 
прозорец (Overview), прозорец за увеличение върху част от картата (Magnifier) и допълнителен 
прозорец (Viewer). Също от това меню могат да се включват и изключват помощните ленти и 
прозорци за съдържанието на картата (Table of Contents), за достъп до дяловете и папките на 
компютъра (Catalog), за търсене на данни, карти и инструменти (Search), както и за настройки на 
растерни изображения (Image Analysis).  

Менюто Help съдържа няколко опции за извикване на помощна информация, която е на 
английски език и е особено пълна и полезна. 

Нека да разгледаме възможните настройки на програмата и на текущата карта, илюстрирани 
на следващата фигура.  



 7 

  

Настройки на програмата (ArcMap Options) Настройки на картата (Data Frame Properties) 

 

Настройките на програмата се активират чрез менюто Customize > ArcMap Options и позволяват 
промяната на някои основни параметри (General), на различни настройки при работата с данните 
(Data View) и окончателните планове (Layout View), като закръгляне на показваните координати, 
показване на спомагателни линии и рулери и др. Чрез опцията Metadata се избира стила на 
показване на метаданните (това е допълнителна информация за това, какво се съдържа в дадени 
данни, каква е тяхната проекция, прецизност, различни статистики и др.). Опциите Tables, Raster и 
CAD дават достъп до специфични настройки при работата с атрибутни таблици, растерни и чертожни 
данни, като цветове и шрифт на таблиците, и начини на изобразяване на растерните и CAD данни. 
Чрез функцията Display Cache могат да се настройват някои параметри на кеширането на данните, 
което позволява по-бързото изобразяване на големи обеми от данни. По принцип, зададените в 
програмата настройки по подразбиране са оптимални и рядко се налага да бъдат променяни.  

 

Настройките на картата са достъпни чрез менюто View > Data Frame Properties или чрез 
двойно щракване вдясно върху групата на слоевете Layers от съдържанието. Тук може да зададете 
име и описание на картата (General > Name, Description), мерни единици (Units), пространствен 
обхват или мащаб (Data Frame), координатна система (Coordinate System), начин на осветяване при 
работа с височинни данни (Illumination), изчертаване на координатни мрежи върху картата (Grids), 
кеширане на данните (Feature Cache), да управлявате групите с надписи/анотации върху картата 
(Annotation Groups), да задавате индикатори за обхвата на картата (Extend Indicators), рамка и фон 
(Frame) и големина и разположение на картата в окончателния план (Size and Position). В следващите 
упражнения ще видим как работят на практика повечето от тези настройки.  

След като приключите с разглеждането на менютата и функциите, спрете програмата от 
менюто File > Exit. Ако ви пита дали да запишете промените в картата, отговорете с No.  
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Упражнение 2. Визуализиране на данни. 

В това упражнение ще използваме готови примерни данни, затова се уверете, че имате 
копирана папката \ESRI_Data на вашия компютър. 

Стартирайте програмата ArcMap. Изключете първоначалния прозорец (ArcMap – Getting 

Started) чрез бутона Cancel.  

Нека заредим едни примерни данни за държавите в света, които се намират в поддиректория 
\ESRI_Data\world\data\ и са записани като файл country.sdc. Зареждането на данни става чрез менюто 

File > Add Data > Add Data или по-удобно – чрез иконата  Add Data, намираща се в лентата под 
менюто и изобразена със знака “плюс”. И така, изберете тази икона и ще се отвори прозореца за 
зареждане на данни Add Data, илюстриран на следващата фигура. В горната част на този прозорец 
има средства за навигация в папките на вашия компютър, като чрез Look In: се придвижете до 
споменатата директория \ESRI_Data\world\data\. Ако делът от хард диска, където са записани 
данните не се вижда в дървовидната структура на опцията Look In:, можете да го добавите чрез 

иконата  Connect To Folder, намираща се вляво. След като се придвижите по споменатия път и 
отворите папката \data, в средната част на прозореца ще видите списък с данните, съдържащи се в 
тази папка. Маркирайте файла country.sdc и го заредете като натиснете бутона Add.  

 

 

 

Когато данните се заредят в полето за визуализация, в лявото поле Table Of Contents, което 
служи за подреждане на съдържанието и легенда, ще се появи името на файла, с малък бутон и 
кутийка с отметка пред него. Като щракате върху бутона, той се изобразява със символ „плюс” или 
„минус” и съответно се показва или скрива легендата под слоя, показваща с какъв цвят са 
изобразени държавите върху картата. Може да смените цвета като щракнете върху легендата 
(цветния правоъгълник под името на слоя). Чрез кутийката пред името на слоя пък можете да 
включвате и изключвате визуализирането на тези данни. Обърнете внимание, че като изключвате 
визуализирането, данните все пак остават заредени в проекта. Ширината на полето за съдържанието 
може да бъде променяна, като прихванете рамката между него и бялото поле за визуализиране на 
данните и я преместите вляво или вдясно. 

Нека сега добавим още данни. Изберете отново бутона Add Data. В прозореца за добавяне на 
данни маркирайте файла cities.sdc, после от клавиатурата натиснете и задръжте натиснат клавиша 
Ctrl и щракнете последователно и върху файловете rivers.sdc и world30.sdc. По този начин ще 
маркирате едновременно три слоя с данни, след което потвърдете с бутона Add. Данните ще се 
заредят в полето на картата. В слоя world30 се съдържа географска координатна мрежа, изобразена 
на плътен фон, а слоевете rivers и cities съдържат данни за по-големите градове и реки в света. Вече 
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имате заредени примери за трите типа графични данни, с които работи ГИС – точкови, линейни и 
полигонови. В лявото поле на съдържанието можете да променяте подредбата на слоевете, като ги 
прихващате с мишката и ги местите нагоре или надолу. Това подреждане оказва влияние на начина 
на визуализиране на данните, като първо се изчертават най-долните слоеве, а накрая – най-горните. 
За да бъдат видими всички данни, обикновено е необходимо най-отдолу да разположите 
полигоновите слоеве, над тях да бъдат линейните слоеве, а най-отгоре да преместите точковите 
слоеве. В нашия случай, за да имаме възможно най-добра видимост на заредените данни, 
преместете най-отдолу слоя world30, над него разположете слоя country, още по-горе преместете 
слоя rivers, а най-отгоре разположете слоя cities. Също така, можете да промените цветовете на 
слоевете. Например, щракнете върху цветния правоъгълник под слоя world30 и в новия прозорец 
Symbol Selector изберете син цвят на запълване (Fill Color) и черен контур (Outline Color), както е 
показано на следващата фигура. Освен това, можете да направите държавите жълтеникави, а реките 
– сини и с по-дебели линии (Width: 2).  

 

 

 

Когато искате да работите с даден слой е необходимо да го маркирате. Това става, като 
щракнете върху неговото име в дясното поле на съдържанието, при което той ще се оцвети. 
Маркираният слой се нарича още текущ или активен. Можете да маркирате и няколко слоя 
едновременно, като щракнете с мишката върху един от тях, натиснете и задържите натиснат клавиша 
Ctrl и щракнете върху останалите слоеве. Нека изпробваме тази възможност. Маркирайте 
едновременно слоевете world30 и cities. Сега нека ги премахнем от проекта – щракнете с десния 
бутон на мишката върху някой от маркираните слоеве и от появилото се контекстно меню изберете 
Remove. Виждате, че избраните слоеве вече не присъстват в полето на съдържанието, т.е. те вече не 
са заредени и не се използват в този проект. Върнете отново двата слоя world30 и cities като 

използвате бутона  Undo за отмяна на последното действие или като ги заредите отново с бутона 
Add Data и пак ги преместете на подходящите им места в съдържанието. 

Следващите функции, които ще използваме, са увеличаване, намаляване и придвижване на 

картата. За тази цел ще ползвате поредицата икони  (Zoom In, Zoom Out, Pan, 

Full Extent, Fixed Zoom In, Fixed Zoom Out, Go Back To Previous Extent, Go To Next Extent). Функциите 
на изброените бутони са аналогични както в други програми, като щракайки с някой първите два 
върху картата съответно ще я увеличите или намалите, а изчертавайки правоъгълник с тях върху 
картата съответно пропорционално ще увеличите или намалите видимата площ. Избирайки бутона 
Pan можете да хванете картата и да я преместите, за да видите други нейни части, а чрез иконата Full 

Extent ще промените изгледа така, че да се виждат отново всички данни (целия обхват на картата). 
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Бутоните Fixed Zoom In и Fixed Zoom Out съответно увеличават или намаляват картата с равномерна 
стъпка, последните два – Go Back To Previous Extent, Go To Next Extent – връщат предишния или 
следващия обхват на картата. Изпробвайте ги, за да разберете как работят.  

Друга много удобна възможност за увеличаване/ намаляване и придвижване по картата, дори 
когато сте избрали или извършвате друга функция, предоставя средния бутон Scroll на мишката. 
Преместете курсора върху картата и завъртете колелцето напред-назад и ще видите, че картата се 
увеличава или намалява. Натиснете и задръжте средния бутон на мишката – така ще „хванете” 
картата и ще можете да я отместите (функцията Pan).  

Обърнете внимание, че когато с мишката движите курсора върху картата, в долната дясна част 
(в полето на статуса) се изписват текущите координати на точката, която е посочена от върха на 
курсора. Освен това, над картата, след бутона да добавяне на данни е показан и текущия мащаб, в 
който е визуализирана картата. Този мащаб може да бъде и ръчно променян. Например, щракнете в 
бялото поле на мащаба и задайте някакъв кръгъл мащаб, близък по стойност до този, който е 
изписан в момента. Щраквайки на стрелката вдясно от полето на мащаба пък се отваря контекстно 
меню, от което също можете да изберете някакъв предварително зададен кръгъл мащаб.  

Друга полезна и често използвана функция е идентификацията на обектите. За да получите 

информация за даден обект изберете бутона за идентификация  и щракнете върху интересуващият 
ви обект. Ще се появи прозорец за идентификация (Identify), показан по-долу и съдържащ наличната 
информация за този обект, представена в таблична форма. Чрез опцията Identify From можете да 
зададете дали да се идентифицират обектите от най-горния слой (Top-most layer), от видимите или 
позволените за избиране слоеве (Visible layers, Selectable layers), от всички слоеве (All layers), или 
просто да изберете желания слой от списъка. Изпробвайте тази функция, като разгледате 
информацията за някои държави, реки и градове. 

 

 

 

Чрез бутона за идентификация можете да получите информация и едновременно за няколко 
съседни обекта от избрания слой, като начертаете правоъгълник около тях. Списъкът с избраните 
обекти ще се покаже в полето над таблицата, а избирайки някой от обектите, информацията за него 
ще се покаже в таблицата и същевременно мястото на обекта ще бъде посочено на картата чрез 
кратка флаш-анимация. Щракайки с десен бутон върху някой от обектите, се появява контекстно 
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меню с полезни функции, като наново показване на локацията му (Flash), увеличаване или 
придвижване до обекта (Zoom To, Pan To), при което той ще се разположи в центъра на картата, и др.  

При работа с данни в ГИС често се налага да маркираме част от обектите от картата, за да 
работим само с тях, а не д всички данни. Маркирането и премахването на маркиране на обекти най-

просто става чрез иконите  Select Features… и Clear Selected Features. Щраквайки върху 
стрелката на бутона Select Features се отваря меню, от което можете да избирате дали да маркирате 
обектите като ги оградите с правоъгълник (Select by Rectangle), полигон (Select by Polygon), ласо 
(Select by Lasso), кръг (Select by Circle) или линия (Select by Line). Маркирайте няколко съседни обекта 
от картата, да видите как работи тази функция, след което ги размаркирайте чрез бутона Clear 

Selected Features.  

Ако искате да маркирате обекти само от даден слой, отидете в полето на съдържанието вляво 

и чрез иконата  List by Visibility превключете режима на представяне на съдържанието. В този 
режим, щракайки върху иконката пред всеки слой, можете да го правите видим или невидим, а 
щракайки върху иконата вдясно от всеки слой, можете да позволявате или забранявате маркирането 
на обекти от дадения слой. Например, забранете маркирането на обекти за всички слоеве, освен за 
слоя cities. После маркирайте чрез правоъгълник няколко съседни града – виждате, че сега се 
маркират само градове, а обектите от другите слоеве не се маркират. Щракнете с десния бутон на 
мишката върху картата и ще се появи контекстно меню, където освен вече разгледаните функции за 
увеличаване, намаляване, преместване и идентификация, има опции за увеличаване или 
преместване върху маркираните обекти (Zoom To Selected Features и Pan To Selected Features), както 
и за размаркиране (Clear Selected Features). След като ги изпробвате, размаркирайте обектите, 
разрешете маркирането и за останалите слоеве в полето на съдържанието и върнете съдържанието в 

първоначалния режим с иконата  List By Drawing Order. В някои от следващите упражнения ще 
разгледаме още няколко по-специфични и прецизни методи за маркиране на данни, а другите 
режими на съдържанието ще обясним малко по-долу. 

Намирането на някой обект може да се извършва чрез бутона-бинокъл  Find, при което се 
отваря прозореца за търсене, показан на следващата фигура.  
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Тази функция търси зададената от вас фраза в базата данни за обектите. Например, нека 
намерим град София – в полето Find: напишете Sofia, а в полето In: задайте слоя cities и натиснете 
бутона Find. В резултат, град София ще бъде намерен и показан в долния край на прозореца, където 
се изписват резултатите от търсенето. Включването на опцията Find features that are similar to or 

contain the search string разширява параметрите на търсене и ще включи в списъка на намерените 
обекти такива, които съдържат подобен на зададения за търсене текст или при които зададения 
текст е част от по-голяма фраза. Чрез опцията Search: може да укажете дали зададената фраза да се 
търси във всички колонки от атрибутната таблица (All fields) или да зададете само една колонка, по 
която да се търси (In field:). Ако не знаете в кой слой се намира търсения обект, може в полето In: да 
зададете да се търси във всички слоеве (All layers). Освен това, щраквайки с десния бутон на мишката 
върху намерения обект в долната част на прозореца, ще се отвори контекстно меню с познатите ви 
вече функции за увеличаване, преместване, показване на обекта върху картата и др. След като 
разгледате как работи функцията за търсене, затворете прозореца Find с бутона Cancel.  

Нека пак разгледаме някои от настройките на картата. В полето на съдържанието щракнете два 
пъти върху групата Layers, за да отворите прозореца с настройки (Data Frame Properties). 
Обикновено повечето от желаните настройки се извършват в началото, след като заредите данните. 
От опцията General, в полето Name можете да зададете собствено име на картата, например “Карта 
на света”, а в полето Description може да напишете някакво кратко обяснение. Ако данните съдържат 
информация в каква проекция са създадени, мерните единици Map и Display в полето Units ще бъдат 
попълнени автоматично, но чрез Display можете да промените в какви мерни единици да ви се 
показват координатите в долния ляв край на прозореца на програмата. Чрез бутона OK потвърдете 
настройките.  

За да измерите разстоянието, например между два града, изберете бутона-линия  Measure. 
Ще се отвори малък прозорец Measure за измерване на разстояния и площи. От неговото меню, чрез 
стрелката до символа за сума нагласете мерните единици за разстояние на километри, както е 
показано на долната фигура.  

 

 

 

Сега измерете разстоянието между два града по права линия, като щракнете на първия и след 
това на втория. Виждате, че при движението си, курсора на мишката автоматично се привързва към 
даден град или характерна точка от контурите на държавите и реките, за да може измерването да е 
по-прецизно. Можете да продължите измерването до трети, четвърти град и т.н.. Измерените 
разстояния се изписват в прозореца Measure, като първата стойност (Segment) показва дължината на 
последния сегмент от начертаната полилиния, а (Length) показва цялата дължина на полилинията. За 
да спрете измерването, щракнете два пъти в последната точка. Имайте предвид, че точността на това 
измерване зависи, естествено, от точността на данните и прецизността на проекцията, в която 
работите. След като упражните измерването на разстояния, затворете прозореца Measure.  

Особено важен е изборът на координатна система. Възможността за работа в различни 
координатни системи и проекции е една от главните отличителни черти между ГИС и другите 
софтуерни продукти за чертане, като например CorelDraw, стандартният AutoCAD, Adobe Illustrator и 
др. Задаването на координатна система става отново в прозореца за настройки на картата (Data 

Frame Properties), чрез опцията Coordinate System, показана на долната фигура.  
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Първо чрез бутона Full Extent нагласете да се вижда цялата карта на света. После отворете 
настройките на картата, изберете Coordinate System и обърнете внимание, че в полето Current 

Coordinate System автоматично е зададена координатната система, в която са начертани тези 
примерни данни – в дадения случай това е географска координатна система използваща световната 
геодезична система WGS 1984. Освен това, в долното поле Select a coordinate system: има папка с 
предварително зададени координатни системи (Predefined) съдържаща две папки с географски и 
проекционни системи (папките Geographic Coordinate Systems и Projected Coordinate Systems). Както 
подсказват имената им, в едната папка са обединени проекции, базирани на ъглови географски 
координати (географска дължина и географска ширина), а другата папка съдържа проектирани 
системи, чиито координати за измервани в метри, футове, ярдове и др.  

Нека разгледаме някои координатни системи. От папката Projected Coordinate Systems отворете 
папката world, изберете Sinusoidal (world) и потвърдете избора с бутона Apply, без да затваряте 
прозореца с настройките. На заден план ще видите как изглежда картата на света в тази избрана 
система. Имайте предвид, че преобразуването на координатите и пречертаването на картата в 
новоизбраната координатна система се извършва в реално време, използвайки временната памет на 
компютъра, без реално да се променя информацията за координатите във файловете с данни. От 
\Projected Coordinate Systems\ world\ изберете и приложете (с бутона Apply) и други координатни 
системи. Например, разгледайте Polyconic (world), Stereographic (world), Azimuthal Equidistant 

(world), Cylindrical Equal Area (world), Mercator (world) и други. При избора на някои системи може 
да се появи прозорец, предупреждаващ че преобразуването може да не бъде прецизно и трябва 
чрез опцията Transformations да изберете метод на трансформация – засега го игнорирайте като 
изберете бутона Yes, за да видите резултатите.  

След като приключите с разглеждането на предварително дефинираните координатни 
системи, нека видим как става задаването на собствена система. Първо върнете първоначалната 
система, като от \Predefined\ Geographic Coordinate Systems\world\ изберете WGS 1984 и потвърдете с 
бутона OK. После увеличете и нагласете картата така, че в средата да се вижда България и част от 
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съседните държави. Виждате, че площта на България изглежда удължена в изток-западно 
направление, което се дължи на свойствата на тази проекция, т.е. тук географските дължини и 
ширини (измервани чрез ъгли) са представени във вид на ортогонална координатна система. За да 
зададете нова проекция отворете отново прозореца за настройки на картата и от бутона New 
изберете Projected Coordinate Systems. В новия прозорец системите се настройват чрез задаване на 
име (Name), тип на проекцията (Projection), линейна мерна единица (полето Linear Unit) и някои 
параметри, като централен меридиан (Central Meridian), мащабен фактор (Scale Factor), базова 
географска ширина (Latitude Of Origin), отместване по посоките изток и север (False Easting и False 

Northing) и стандартни паралели (Standard Parallel 1 и 2). Достъпните за настройки параметри 
различни, в зависимост от избрания тип проекция. Задайте някакво име (Name) на вашата нова 
система, например My System, а от списъка с проекции (полето Projection, опцията Name:) изберете 
Transverse Mercator. Линейните единици би трябвало автоматично да се настроят на „метри“. После, 
в долната част на прозореца трябва да зададем географската координатна система и сфероид, 
асоциираща с тази проекция, затова изберете бутона Select и от папката \Spheroid-based\ изберете 
Krasovsky 1940.prj и потвърдете с бутона Add. Накрая задайте за Central Meridian стойност 24 и 
потвърдете с бутона OK. Така дефинираната нова координатна система ще се появи в списъка – 
изберете я и потвърдете с OK. Вероятно ще се появи прозореца, предупреждаващ че 
преобразуването може да не бъде прецизно – игнорирайте го като изберете бутона Yes, за да видите 
резултатите. Сега площта на България би трябвало повече да ви прилича на картите, изобразявани в 
атласите. Накрая пак върнете първоначалната координатна система \Predefined\ Geographic 

Coordinate Systems\world\WGS 1984. 

Следващото нещо, което ще разгледаме, са режимите и настройките на изобразяване в полето 
на съдържанието (Table Of Contents). Вече обърнахме внимание на някои от иконите, разположени 

над съдържанието  (List By Drawing Order, List By Source, List By Visibility, List By 

Selection, Options). Нека сега ги разгледаме всичките. Първата и най-често използвана опция (List By 

Drawing Order) показва списъка на заредените слоеве с данни според последователността им на 
изчертаване. Както вече видяхме, в този режим можете да включвате и изключвате изчертаването на 
даден слой чрез отметката пред неговото име, както и да показвате и скривате неговата легенда. 
Вторият режим (List By Source) показва за файловете и пътищата (папките) в които са записани 
данните. Третият режим (List By Visibility) показва слоевете според това, дали са видими или не, като 
чрез иконките пред всеки слой можете да включвате и изключвате изчертаването му, а с иконките 
вдясно от слоя можете да разрешавате и забранявате избирането (маркирането) на обекти от слоя. 
Четвъртият режим (List By Selection) е удобен при маркиране на обекти от картата, като при него 
слоевете се сортират според броя на маркираните обекти, като се изписват имената на маркираните 
обекти и щракайки върху всеки – върху картата се показва неговото положение. Подобно на предния 
и в този режим също можете чрез иконките пред и зад слоевете да включвате и изключвате 
изчертаването и маркирането по всеки слой. Последната икона (Options) дава достъп до някои 
настройки на лентата на съдържанието, като изписване или не на маркираните обекти (Show selected 

features in selection list), начин на сортиране и с какви символи да се изобразяват легендите (Patches). 
Освен това, във всеки от режимите щракването с десния бутон на мишката върху името на даден 
слой отваря контекстно меню с разнообразни и често използвани функции. Изпробвайте различните 
режими, за да разберете как работят, а накрая се върнете в първоначалния режим на изписване на 
слоевете според последователността им на изчертаване.  

Друго, много полезно и често използвано средство при работа с данните в ГИС са настройките 
на отделните слоеве. Прозорецът с настройки за даден слой (Layer Properties) е достъпен или чрез 
двойно щракване върху името на слоя или ако щракнете с десния бутон върху името на слоя и от 
контекстното меню изберете Properties. Отворете настройките на слоя cities за да ги разгледаме.  

В прозореца за настройки (Layer Properties), първата група общи настройки (General) позволява 
да се промени името на слоя (Layer Name), да се добави някакво текстово описание (Description), 
както и да се зададе минимален мащаб (Minimum Scale) и максимален мащаб (Maximum Scale) за 
визуализиране на обектите от темата. Последната функция е много удобна, особено когато имате 
много данни и картата ви изглежда претрупана. Например, сменете името на слоя от cities на 
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ГРАДОВЕ. За да не затваряме и отваряме често прозореца за настройки, приложете промяната с 
бутона Apply и го преместете встрани, за да видите промяната в полето на съдържанието. Имайте 
предвид, че настройването на имена, надписи и цветове в полето на съдържанието е много важно, 
тъй като тези настройки автоматично се отразяват в легендата на окончателната карта. После 
включете опцията Don’t show layer when zoomed и в полето In beyond: (maximum scale) задайте 
1 : 100 000 000 и потвърдете с ОК (някои настройки се прилагат само след потвърждаване с ОК и 
затварянето на прозореца). След това използвайте бутоните Zoom… за да променяте мащаба. Ще се 
убедите, че градовете се виждат само когато избрания мащаб е по-детайлен от 1 : 100 000 000. 
Накрая отворете отново прозореца за настройки на слоя с градовете и включете обратно опцията 
Show layer at all scales и потвърдете с Apply, за да може градовете да се виждат при всички мащаби.  

Следващата група в прозореца за настройки (Layer Properties) е свързана с източника на 
данните (Source). Тук се показва детайлна информация да пространствения обхват на данните (в 
полето Extent) и типа на файла с данни, пътя до него, координатната му система и др. (в полето Data 

Source). Много полезен е бутонът Set Data Source, чрез който можете да укажете къде и в кой файл са 
записани данните от текущия слой. Случва се да преместите някои файлове с данни или да ги 
преименувате и при отварянето на проекта, програмата да не може да ги намери, понеже в проекта 
се записват само пътищата и имената на файловете, но не и самите данни. Тогава чрез бутона Set 

Data Source можете да укажете до промененото място или име и данните ще бъдат коректно 
заредени.  

В групата Selection може да се променят символа и оцветяването, чрез които се маркират върху 
картата избраните обекти. Тази функция е полезна, например, когато зададения по подразбиране 
цвят или символ съвпадат с избрания начин на визуализиране на данните – в такъв случай 
маркираните обекти няма да се отличават ясно от останалите и промяната на цвета или символа за 
маркиране ще ги направи по-различими.  

Групата Display дава достъп до някои допълнителни настройки за визуализиране на данните. 
Чрез Scale symbols when a reference scale is set се включва мащабирането на символите при зададен 
референтен мащаб и увеличаване или намаляване на картата. Обикновено за референтен мащаб се 
избира мащаба, в който ще се разпечатва окончателната карта и се задава в настройките на картата 
(чрез менюто View > Data Frame Properties > General > Reference Scale). Задаването и 
разпечатването в референтен мащаб ни подсигурява, че големините на текстовете, надписите и 
символите ще бъдат точно такива, каквито са зададени, докато при разпечатване в мащаб различен 
от референтния големините на текста и символите могат да бъдат променени, за да се виждат по-
добре.  

Друга опция от групата Display позволява изписването на информация за обектите при 
посочването им с курсора (полето Display Expression). За тази цел трябва да се включи опцията Show 

MapTips using the display expression, а от полето Field да се избере чрез коя колона от атрибутната 
таблица да се надписват обектите или чрез бутона Expression да се зададе по-комплексен израз за 
изписване. Например, за слоя с градовете включете опцията Show MapTips…, за Field задайте 
CITY_NAME и потвърдете с ОК. Така при преместването на мишката върху някой град, до курсора ще 
се изпише името на града.  

Полето Hyperlinks от групата Display служи за привързване на външна информация към 
обектите. Например, към даден град можете да привържете негова снимка и като щракнете върху 
него тя да се показва. Тук се задават поле за връзка и дали чрез щракването върху обекта ще се 
отваря някакъв документ, интернет адрес или изпълнима програма (скрипт). На тази тема също ще 
имаме отделно упражнение по-късно. 

Много важни са функциите от групата Symbology в прозореца за настройки (Layer Properties). 
Тук се указва как да бъдат класифицирани и изобразени обектите върху картата, което се отразява и в 
легендата на крайния продукт. За разлика от обикновените чертожни програми, в ГИС данните се 
съхраняват във външни за проекта файлове и начина им на визуализиране (например, с какъв цвят и 
тип да са линиите, с какви символи да са точките и т.н.) се определя именно тук. На тези функции ще 
се спрем подробно в друго упражнение.  
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В групата Fields можем да сортираме колоните в атрибутната таблица, да включваме и 
изключваме показването на дадена колона, както и да я показваме с друго име (псевдоним - Alias) 
без да се променя оригиналното име във файла с данни.  

Групата Definition Query служи за извличане на извадка от данните, отговаряща на определена 
дефиниция. Често се налага в дадена карта да работим само с част от данните и вместо да създаваме 
нов файл, в който ненужните данни са изтрити, можем просто да ги изключим чрез някаква 
дефиниция. Например, понеже в момента разглеждаме настройките на слоя с градовете, нека 
покажем само градовете в САЩ. Изберете бутона за създаване на заявки (Query Builder) и в новия 
прозорец от списъка с колоните на атрибутната таблица (в горната част на прозореца) намерете и 
щракнете два пъти върху “CNTRY_NAME”, така че да се появи в долното текстово поле. След това 
щракнете веднъж върху бутона със знака за равенство. После изберете бутона Get Unique Values и в 
средната част ще се появи списък с държавите (в атрибутната таблица на слоя с градовете има 
колона “CNTRY_NAME”, в която е написано за всеки град в коя държава се намира). Намерете 
‘United States’ и щракнете два пъти върху него, за да се появи и този параметър в долното текстово 
поле. Така в долното текстово поле следва да получите израза "CNTRY_NAME" = 'United States'. Ако 
се затруднявате, можете да въведете израза и ръчно. Потвърдете с ОК. По този начин, върху картата 
ще бъдат показвани само градовете от САЩ – другите градове ще останат скрити, въпреки че ги има 
във файла с данни. Ако е необходимо, увеличете или намалете мащаба, за да се уверите, че се 
виждат само градовете от САЩ. Отворете отново прозореца с настройки на слоя с градовете, 
изберете бутона Query Builder и в новия прозорец натиснете бутона Clear да премахнете зададената 
дефиниция, след което потвърдете с ОК и после с Apply, за да покажем отново всички градове.  

Следващата група настройки на слоя се отнасят до надписването на обектите (групата Labels). 
Тук се включва и изключва надписването на обектите, задава се шрифт и цвят и как да са 
разположени надписите спрямо обектите и др. Чрез опциите от групата Joins & Relates пък можем да 
свързваме данни от различни атрибутни таблици. По-късно ще имаме отделни упражнения, свързани 
с надписването на обектите и създаването на връзки и засега няма да разглеждаме тези настройки. 

Настройките от групата Time се използват за данни, които се изменят във времето. Чрез тези 
настройки можем да проследяваме как се изменят обектите, но за тази цел в атрибутната таблица 
трябва да има една или две времеви колони, указващи времето или периода на промени.  

Функциите от групата HTML Popup също позволяват показването на информация, по донякъде 
подобен начин на Hyperlinks. От тук можем да настроим дали да се показва информацията от 
атрибутната таблица (As a table of the visible field) или да се отваря URL връзка или XLS страница. За 
да видите как действа тази функция, уверете се че е включена опцията Show content for this layer using 

the HTML Popup tool и че е избрано As a table of the visible field. Потвърдете с ОК, за да се затвори 
прозореца с настройките и изберете иконата  HTML Popup. След това, когато щракнете с курсора 
върху някой обект, ще се появява прозорец с наличната информация за него, извлечена от 
атрибутната таблица.  

В края на това упражнение ще запишем проекта, който създадохте досега. От менюто File 
изберете Save. В новия прозорец, в полето File name изтрийте всичко и кръстете проекта с някакво 
име, като например вашето име или MyFirstProject. В горната част, чрез опцията Save in: трябва да 
укажете къде да се запише документа – изберете някоя ваша работна папка от компютъра или някоя 
временна директория, като c:\Temp. Потвърдете с бутона Save и излезте от програмата чрез менюто 
File > Exit. После стартирайте отново програмата ArcMap. В началния прозорец Getting Started би 
трябвало да видите вашия проект, понеже по подразбиране се показват последните документи 
(Recent) с които е работено. Маркирайте го и го отворете с бутона Open. Виждате, че проектът се 
зарежда точно така, както сте го записали последния път, т.е. зареждат се същите данни и се 
визуализират по същия начин, запомнени са и конкретните настройки, които сте правили. 

Когато имате по-дълги упражнения или работа с ГИС, можете да записвате проекта си и по-
късно или друг ден да продължите работата си от там до където сте стигнали. 

Всъщност, проектът се записва в специфичен файлов формат и съдържа именно информация за 
използваните данни и извършените настройки. Във файла на проекта освен имената на файловете с 
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данни, се помнят и пътищата, където те са записани. Това често създава проблеми, особено когато 
преместите данните в друга директория или на друг компютър. Тогава, при отваряне на проекта, 
програмата няма да може автоматично да намери и зареди данните. Имайте предвид тази 
особеност, когато записвате окончателните карти и проекти на компакт диск, който ще трябва да 
може да се чете и на друг компютър. За да избегнете това неудобство можете да записвате данните и 
проекта в поддиректории на една обща папка и да включите опцията за запаметяване на 
относителните пътища до данните (Store relative pathnames to data sources), която е се намираше в 
настройките на документа (File > Map Document Properties). Другата възможност, която вече 
разгледахме е чрез бутона Set Data Source от прозореца с настройки на слоя да укажем верния път и 
име на файла с данни.  

 

Освен примерните данни, които ползваме, програмата предлага и онлайн достъп до базови 
карти, които могат да ви служат като подложка за вашата карта. За тази цел трябва естествено да 
имате активна интернет връзка, като скоростта на зареждане на базовите карти зависи от скоростта 
на вашия интернет достъп, така че при по-стар компютър и по-бавен интернет може да е нужно доста 
време докато заредите някоя карта. За да видим как действа тази възможност, изтрийте слоевете 
country и world30 (щракате с десен бутон върху тях и избирате Remove). След това изберете от 
менюто File > Add Data > Add Basemap. Ще се появи прозорец с наличните онлайн карти – изберете 
някоя и потвърдете с бутона Add. Картата ще се зареди и името и ще се появи като група или слой в 
съдържанието, от където можете да я включвате, изключвате и триете. Имайте предвид, че някои 
базови карти са съставени само за отделни части на света, а други не съдържат информация при 
увеличаване в по-детайлен мащаб.  

 

С това завършваме второто, доста дълго упражнение. Надявам се да ви е било интересно. 
Затворете програмата по вече познатия начин – чрез менюто File > Exit, като не е нужно да 
записвате новия вариант на документа с базовите карти.  
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Упражнение 3. Работа с таблици. 

В това упражнение ще разгледаме основните действия при работа с табличната информация в 
ГИС. Както вече знаете, информацията за свойствата и характеристиките на графичните обекти, 
изобразени на картата, се записва под формата на таблици в база данни. Тази информация се нарича 
още атрибутивна или атрибутна информация, а таблиците – атрибутни таблици. 

Стартирайте програмата ArcMap, изключете началния прозорец и заредете слоя с държавите 
(\ESRI_Data\ world\ data\ country.sdc). 

Отворете атрибутната таблицата на слоя country, като щракнете с десен бутон върху него и от 
контекстното меню изберете Open Attribute Table. Разгледайте съдържанието на тази таблица. 
Виждате как информацията е въведена и как е организирана в полета (колоните) и записи 
(редовете). Тук трябва да припомним, че един от основните показатели за прецизността на данните е 
именно доколко детайлна и достоверна е информацията, въведена в таблиците от базата данни. 

Нека сега демонстрираме връзката между графичните обекти от картата и таблицата. 
Направете прозореца на таблицата по-малък и го преместете така, че да виждате както таблицата, 
така и картата. Маркирайте обект от таблицата, като щракнете върху бутончето в началото на неговия 
ред и ще видите че той се маркира и в прозореца на картата. Ако държавата, която сте избрали е с 
малка площ и не я виждате ясно на картата, използвайте следната процедура: маркирайте я в 
таблицата, след това щракнете с десен бутон на мишката върху бутончето за маркиране на реда и от 
контекстното меню използвайте функциите Flash, Zoom, To или Pan To, за да я видите върху картата. 
После може да използвате вече познатия бутон Full Extent от лентата с икони на прозореца на 
картата, за да видите отново цялата карта.  

Също така, ако маркирате обект от картата, той автоматично ще се маркира и в таблицата. 
Изберете бутона за графично маркиране (Select Features by Rectangle) и маркирайте няколко 
държави и ще видите, че те се маркират и в таблицата.  

В прозореца на таблицата също можете да използвате функцията за идентификация на обекта. 
За тази цел щракнете с десен бутон в началото на реда и от контекстното меню използвайте 
функцията Identify. Когато приключите с идентифицирането на обекти от таблицата, затворете 
прозореца с резултатите от идентификацията. 

Често се налага да работите с информацията от дадено поле (колона) от таблицата. Можете да 
маркирате цялата колона, като щракнете върху нейното име, изписано в сивия правоъгълник, в 
горната част на таблицата. Маркирайте, например, полето с имената на държавите (CNTRY_NAME) и 
ще видите, че то се оцвети. Сега щракнете с десния бутон върху името на колоната и от появилото се 
контекстно меню използвайте функциите за сортиране (Sort Ascending и Sort Descending), за да 
сортирате имената на държавите по азбучен ред, съответно в нарастващ или намаляващ ред. В 
ArcMap, пък и в повечето други ГИС, обектите в таблицата се подреждат по реда на тяхното 
въвеждане. Сортирането на данните (числови или текстови) често се оказва много удобно, когато 
обработвате или анализирате информацията, а дори и когато просто търсите някой обект сред много 
други в голяма таблица. 

В таблицата можете да маркирате и няколко обекта едновременно. Това става, като маркирате 
реда на първия обект, натиснете и задържите клавиша Ctrl от клавиатурата и с мишката маркирате и 
другите желани обекти. Ако искате лесно да маркирате няколко последователни реда от таблицата, 
трябва да щракнете с мишката върху началото на първия ред, след това натиснете и задръжте 
клавиша Shift и маркирайте и последния ред. Изпробвайте тези функции, за да добиете представа 
как работят. 

В горната част на прозореца на таблицата има ред от икони  (Table 

Options, Related Tables, Select By Attributes, Switch Selection, Clear Selection, Zoom To Selected, Delete 

Selected). Първия бутон (Table Options) отваря мею за достъп до често употребявани функции и 
настройки на таблицата, а втория (Related Tables) се използва при работа със свързани таблици. 
Третата опция (Select By Attributes) служи за маркиране на обекти от таблицата, подобно на вече 
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разгледаната функция за задаване на дефиниции. Чрез иконата Switch Selection можете да 
превключите между маркираните и немаркираните обекти, т.е. маркираните – да се размаркират, а 
немаркираните – да се маркират. Последните икони са за премахване на маркирането (Clear 

Selection), увеличаване на картата върху маркираните обекти (Zoom To Selected) и изтриване на 
маркираните обекти (Delete Selected), но изтриването е достъпно само когато е разрешена 
редакцията на данните. Имайте предвид че в почти всички ГИС за да промените физически нещо в 
заредените данни трябва да включите специален режим на редакция, което е направено от 
съображения за защита на данните от неволни промени и контрол на достъпа до информацията.  

В долната част на прозореца на таблицата има още два полезни бутона , чрез които се 
превключва между режим на показване на всички редове от таблицата (Show all recors) и показване 
само на редовете на маркираните обекти (Show selected records).  

Когато работите в таблицата, също можете да търсите обект по зададен израз. Преди това е 
желателно да маркирате колоната, в която да се извършва търсенето. Например, от бутона Table 

Options използвайте Find & Replace, за да намерите България (въведете Bulgaria).  

Чрез функцията за задаване на извадка (бутона Select By Attributes) можете да извършвате по-
сложни операции за търсене на един или повече обекти, по един или няколко показателя. 
Намерените по този начин обекти, които отговарят на зададените критерии на търсене, се маркират 
и образуват т.нар. извадка от всички данни. Изберете бутона Select By Attributes и намерете, 
например, всички територии, принадлежащи на Великобритания, които нямат собствено 
самоуправление. За целта в прозореца за дефиниране на израза, щракнете два пъти върху полето 
"STATUS" (от списъка в горната част на прозореца), след това изберете знака за равенство, изберете 
бутона Get Unique Values и от получения списък в средната част на прозореца щракнете два пъти 
върху 'Non-Self-Governing Territory of the UK'. В резултат, в долното бяло поле на прозореца трябва 
да получите израза "STATUS" = 'Non-Self-Governing Territory of the UK'. Желаният израз може да 
бъде и ръчно написан в това бяло поле. После потвърдете с бутона Apply и всички територии без 
собствено управление, принадлежащи на Великобритания, ще се маркират в таблицата. Можете да 
използвате бутона Show selected records, за да видите в таблицата само избраните обекти, а чрез 
Zoom To Selected да увеличите картата върху тях.  

В долната част на прозореца на таблицата има информационно поле, което показва какъв е 
броят на маркираните обекти и колко са всичките обекти (редове) в таблицата. Например, ако все 
още са маркирани териториите на Великобритания от горния пример, ще видите информация “10 

out of 249 selected”, което значи, че са маркирани 10 обекта (получена е извадка 10 обекта) от 
всичките 249 обекта (в случая – държави), съдържащи се в таблицата. 

Избирането на няколко обекта може да става и графично, както бе описано по-горе. 
Преместете таблицата така, че да виждате по-добре картата и от главния прозорец на програмата 
изберете бутона за графично маркиране (Select Features by Rectangle). Щракнете върху една държава, 
натиснете и задръжте натиснат клавиша Shift и с курсора щракнете върху още няколко други 
държави. Така в таблицата ще получите извадка за маркираните от вас държави. За да видите по-
добре може пак да използвате режима на показване само на избраните редове (Show selected 

records). 

Накрая ще разгледаме настройките на таблицата. Както вече видяхме, част от настройките са 
обединени в групата Fields от прозореца с настройки на слоя (Layer Properties). Например, опитайте 
да разместите колоните от таблицата, да изключите някои от тях, а на други да промените името чрез 
опцията Alias. Трябва да имате предвид, че поради някои ограничения на често използваната база 
данни dBase, не можете да използвате дълги имена за колоните и не можете да използвате 
специални символи. Все пак, ако искате, при създаването на нова колона можете да зададете 
някакво съкратено име, а тук в полето за разширено име (Alias), можете да въведете друго, по-дълго 
име, с което колоната ще се изписва в таблицата и което ще се “помни” в дадения проект.  

Друга част от настройките са достъпни от самия прозорец на таблицата, чрез бутона Table 

Options, където освен често използваните функции, имате възможности да експортирате 
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маркираните или всички обекти в нова таблица (Export), както и да настроите как да изглежда 
таблицата (Appearance).  

Можете да повторите разгледаните в това упражнение действия с таблици, като използвате и 
други примерни данни от поддиректория \world\data\. Особено полезно е с други данни да повторите 
тези функции, които са ви били по-трудни за разбиране и усвояване. 

След като приключите, затворете програмата ArcMap (File > Exit), като можете да запишете 
проекта, например с името exercise3. 
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Упражнение 4. Формати на данните, достъпни за четене и работа с ArcGIS. 

В средата на ArcGIS, информацията се записва и съхранява в специфични за тази програма 
формати. Освен това, програмата може да се работи и с външни данни, записани в различни 
формати от други програми. По-популярни формати, достъпни за четене и работа в ArcGIS и 
категоризирани според техния тип са следните: 

Географски данни (обекти): 

• ESRI Shape файлове – работен формат на ArcGIS. Файловете са с разширения *.shp (за 
геометрични обекти), *.dbf (атрибутна информация във вид на база данни) и *.shx (за връзка 
между графичните обекти и табличната информация); 

• Гео-база данни (Geodatabase) – присъщи за ArcGIS формати. Различават се персонални гео-
бази данни (в Microsoft Access формат), файлови гео-бази данни и др.;  

• ARC/INFO области (coverages), за PC или Unix платформи; 

• AutoCAD (*. DWG) и Microstation (*. DGN) - CAD чертежи; 

• AutoCAD DXF – популярен формат за обмяна на чертожна информация между софтуерните 
системи. 

Атрибутни данни: 

• dBASE файлове – популярна база данни, вградена в ArcView, но може да се инсталира и 
ползва самостоятелно; 

• XLS – таблиците от Microsoft Excel могат да се четат директно в ArcGIS;  

• Сървъри за бази данни, като ORACLE, INGRES, SYBASE, INFORMIX и т.н.; 

• INFO таблици – таблични данни от ARC/INFO; 

• ASCII файлове, в които данните са разделени със запетая или табулация. 

Изображения: 

• ARC/INFO GRID; 

• BSQ, BIL, BIP – стандартни формати при сателитните и аерофото изображения; 

• BMP – “битмап” формат, популярен в операционната система Windows; 

• JPEG – компресиран растерен формат; 

• SUN raster – популярен UNIX растерен формат; 

• Tiff – TIFF формат, LZW компресиран TIFF и GeoTIFF; 

• Erdas (*.lan) – формат от популярен софтуер за обработка на дистанционни данни; 

• Erdas Imagine изображения (*.img) – друга разновидност на горния формат; 

• Image catalogs – каталози, съдържащи информация за използваните изображения; 

• Run length compressed – компресиран растерен формат. 

Грид-данни: 

• ARC/INFO GRID; 

• ASCII raster – текстови растерен формат; 

• Binary raster – двоичен растерен формат; 

• USGS DEM (Digital Elevation Model) – Цифров Модел на Релефа – популярен формат за 
изобразяване на информация за надморските височини; 

• US DMA Digital Terrain Elevation Data (DTED) – Цифров Модел на Терена – също формат за 
изобразяване на релефа. 

 

Нека упражним някои от множеството възможности за работа с външни данни. Стартирайте 
програмата ArcMap. Първо ще заредим данни във формат на популярната чертожна програма 
AutoCAD. Имайте предвид, че много често кадастралните планове и друга информация относно 
населените места в България могат да се намерят именно в такъв формат. Изберете бутона за 
добавяне на слоеве (Add Data) и отидете в директорията \ESRI_Data\CAD\, където се съхраняват 
други примерни данни. В списъка ще видите два файла – index.dwg и parcels.dwg. За разлика от ГИС, 
при чертожните програми цялата информация (точки, линии, полигони, надписи) се съхранява във 
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файла на чертежа. Заредете файла index.dwg. Понеже в чертежите обикновено не се съхранява 
информация за използваната координатна система, вероятно ще се покаже предупредителен 
прозорец Unknown Spatial Reference – игнорирайте го с бутона OK. Ще се зареди целия чертеж, а в 
полето на съдържанието всички елементи ще се появят под като група. Щракнете бутончето със 
символ „плюс“ пред групата, за да видите съставните слоеве на чертежа. Можете да включвате и 
изключвате отделните слоеве, което ще ви помогне да се ориентирате какво съдържат. Освен това, 
можете да изтриете отделни слоеве. Изтрийте цялата група като щракнете с десен бутон върху 
INDEX.DWG Group Layer и изберете Remove. Друга възможност е да заредите само някои от 
слоевете в даден чертеж. Изберете отново Add Data и от списъка щракнете два пъти върху файла 
index.dwg. Той ще се отвори подобно на папка и ще видите съставните му слоеве. Изберете 
Annotation, Polyline и Polygon и ги заредете. Заредете и данните от CAD-файла parcels.dwg. Виждате, 
че последните се отнасят само за една част от картата. Можете да разгледате и таблиците, свързани с 
отделните слоеве. 

 

Имайте предвид, че тези външни чертожни данни могат да бъдат само визуализирани, но не 
могат да бъдат редактирани. Ако ви се налага да редактирате такива външни данни, ще трябва първо 
да ги преобразувате в гео-база данни или Shape-формат. Това става като щракнете с десен бутон 
върху даден слой от списъка в съдържанието и от менюто използвате Data > Export Data. 
Програмата ще ви пита къде, с какво име и в какъв формат да запише преобразуваните данни, а 
после ще ви попита дали искате да ги добавите в текущия прозорец за визуализация. Ако искате да 
изпробвате тази функция, в прозореца Export Data използвайте иконката-папка Browse и запишете 
експортираните данни в Shapefile формат (чрез опцията Save as type) в някоя ваша работна папка на 
компютъра.  

 

Примерните данни за градовете, държавите и реките (от папката \ESRI_Data\ world\ data\), 
които използвахме в предните упражнения, също са записани в специфичен “.sdc” формат. Това е 
така нареченият Smart Data Compression формат, при който информацията е в компресиран вид и не 
може да бъде променяна. Все пак, данните от този формат могат да бъдат експортирани по 
споменатия начин в стандартни Shape-формат или гео-база данни, в които да бъдат достъпни за 
редакция. 

 

Сега нека разгледаме и възможността за зареждане на изображения. Тази функция е много 
полезна, понеже често се налага използването на сканирани карти, а понякога и аерофото или 
сателитни снимки. В ГИС среда изображенията се използват често като подложка, върху която да 
чертаете и въвеждате необходимата информация. Програмата ArcGIS може директно да чете 
изображения, записани в разнообразни формати, като и TIFF, JPEG, BIL и др.  

Изтрийте всички чертожни слоеве, които разглеждахме досега. Изберете бутона за добавяне 
на слой (Add Data) и в дясната част на новия прозорец отидете в директорията \ESRI_Data\images\. В 
списъка на файловете ще видите едно изображение, заснето от френския спътник SPOT и записано с 
името spotimg.bil. Заредете го и го разгледайте, като може да използвате бутоните Zoom... за да 
променяте детайлността на изобразяване. 

Нека разгледаме някои настройки, които можем да приложим върху това изображение. 
Щракнете два пъти върху името на слоя в съдържанието за да отворите прозореца за настройки 
Layer Properties. Понеже този слой съдържа изображение, настройките са по-различни от тези, които 
вече разгледахме. Изберете групата Symbology. Заредената снимка е едноканална, затова и се 
изобразява като черно-бяла. В полето Stretch чрез опцията Type можете да избирате различни 
методи за промяна на контраста – изберете ги един по един за да ги разгледате, като потвърждавате 
избора с Apply. Възможно е програмата да ви попита дали да пресметне хистограмата на 
изображението – потвърдете с Yes. Накрая затворете прозореца за настройки на слоя. От менюто 
Window > Image Analyst можете да отворите прозореца за анализ на изображенията, който съдържа 
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богат набор от функции за обработка. Тук, когато маркирате изображението от списъка, можете да 
променяте яркост, контраст, прозрачност, гама-корекции. Освен това, можете да променяте 
цветовата палитра, да прилагате различни филтри и т.н. 

Изтрийте изображението от SPOT и заредете файла austin.sid – това е мултиспектрално 
изображение с висока разделителна способност. Отворете настройките на слоя и в групата Symbology 
ще видите, че на всеки канал (Band 1, 2 и 3) е присъден определен цвят (съответно Red, Green, Blue). 
От тук може да променяте кой канал с какъв цвят да се изобразява. Освен това, в лявата горна част на 
прозореца можете да промените режима от RGB Composite на Stretched и да разгледате всеки от 
каналите поотделно. Не забравяйте когато променяте нещо, да потвърждавате с бутона Apply, а 
накрая затворете прозореца с OK. Други полезни функции от контекстното меню на слоя са Zoom To 

Layer, която свиват картата така, че да се вижда целия слой и Zoom To Raster Resolution, която 
увеличава изображението 1:1 на екрана, т.е. един пиксел от екрана изобразява един пиксел от 
изображението.  

 

Накрая изтрийте и това изображение и разгледайте и останалите от папката. Понеже снимката 
SPRINGS1.JPG е по-голяма, може програмата да ви попита дали да създаде пирамидална структура, 
която спомага за по-бързото изобразяване – потвърдете с Yes.  

 

След като приключите работа, затворете програмата без да записвате проекта. 
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Упражнение 5. Добавяне на графика и текст. 

В това упражнение ще разгледаме основните функции за работа с текст и графика. Имайте 
предвид, че разгледаните тук методи за създаване на помощни графични обекти и текст се запомнят 
в екрана на проекта (в някои ГИС наричан “козметичен” слой), но не се записват към данните. Ако 
добавените обекти и текст не бъдат записани в проекта, те ще бъдат загубени. Манипулациите с 
реалните пространствени графични и текстови обекти в данните са подобни на разгледаните тук, но 
ще бъдат описани в следващо упражнение. 

 

Стартирайте програмата ArcMap и се уверете, че групата икони за чертане Draw , показани на 
следващата фигура, е включена. Ако не е – включете я чрез менюто Customize > Toolbars > Draw.  

 

 

 

Изчертаването на графични обекти става чрез бутонното меню . По подразбиране то е 
настроено за чертане на правоъгълници. Обърнете внимание, че в десния край на иконата има малка 
стрелка, което обозначава, че това не е един бутон, а падащо меню с няколко бутона. Щракнете 
върху стрелката и бутонното меню ще се отвори. Както виждате, графичните фигури, които можете да 
създадете чрез това меню са: правоъгълници, полигони, окръжности, елипси, полилинии, криви, 
линии чрез свободно чертане и точки. Начертайте последователно по няколко от различните фигури, 
за да видите как работят тези функции. След като сте начертали някоя фигура, нейните параметри 

могат да бъдат променяни. За тази цел изберете желаната фигура чрез курсора за маркиране  и ще 
можете да я преместите или да промените нейните размери и форма като придвижите някое от 
маркиращите я квадратчета. С натиснат клавиш Shift или Ctrl можете да маркирате едновременно 
повече обекти. Когато имате един или няколко обекта и щракнете с десния бутон на мишката, ще се 
отвори контекстно меню с полезни функции, като изрязване, копиране, изтриване, групиране (Group) 
и разгрупиране (Ungroup), подреждане (Order), преместване (Nudge), подравняване (Align) и др. 
Изпробвайте изброените за да видите как работят. 

Ако начертаете много обекти и ви е трудно да работите, изтрийте някои от тях, като ги 
маркирате и натиснете клавиша за изтриване (Delete) от клавиатурата. 

 

Цветовете и начина на изобразяване на начертаните обекти също могат да бъдат променяни. 
За тази цел щракнете два пъти с мишката върху желания обект и ще се отвори прозорец с неговите 
настройки (Properties). От тук можете да промените параметри като цвят на запълване (Fill Color) и 
цвят на контура (Outline Color), дебелина на линията (Outline Width), и др., като параметрите за 
настройване зависят от типа на обекта. Чрез бутона Change Symbol може да промените символа, като 
изберете от предварително зададени стилове от прозореца Symbol Selector (показан на следващата 
фигура). Изпробвайте различните варианти, като задавате различни цветове, щриховки, линии и т.н. 
на начертаните от вас графични обекти. 
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Избрания символ може да бъде допълнително редактиран чрез бутона Edit Symbol от 
прозореца Symbol Selector (предната фигура), при което се отваря прозореца за редакция на 

символите Symbol Property Editor, показан на следващата фигура. Тук с бутоните  можете 
да добавяте и махате съставни компоненти на символа и да ги преподреждате, а в дясната част 
можете да променяте типа на всеки компонент (Type) и да задавате съответните му настройки, като 
цвят, ъгъл на завъртане (Angle), отместване (Offset), гъстота (Separation), тип и цвят на линията и т.н. 
Естествено, възможните настройки се променят както в зависимост от типа на дадения компонент от 
символа (плътно запълване, щриховка, точков символ, картинка и др.), така и от типа на начертания 
обект (точка, линия или полигон). Така, чрез опцията за редактиране на символ, можете да създадете 
свои собствени символи, които ги няма в списъка. 
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За да се упражните, например изберете някой начертан полигон от картата, изобразете го чрез 
избрана от вас щриховка, после променете цвета на щриховката и контура от прозореца Symbol 

Selector, а накрая променете и ъгъла и гъстотата на щриховане от прозореца Symbol Property Editor. 
След това променете и някой линеен и точков обект от картата, за да видите какви настройки се 
предлагат и за тях.  

 

Както виждате, предлаганите по подразбиране цветове и типове обекти не са много 
разнообразни, но програмата съдържа голям брой символи, които по подразбиране са изключени. 
За да станат достъпни изберете отново бутона Change Symbol и от прозореца Symbol Selector 
изберете бутона Style References. В новия прозорец има голям списък със символи, групирани по 
области. Включете например Geology 24K, потвърдете с OK и ще видите че в долния край на 
предварително зададения списък в прозореца Symbol Selector ще се появят нови геоложки символи, 
които са различни в зависимост дали променяте точка, линия или полигон. Разгледайте още и други 
групи символи, но не включвайте много от тях едновременно, че ще ви е трудно да се ориентирате и 
работата ще се затрудни.  

 

Надписването на текст става чрез текстовото бутонно меню . Разгледайте и изпробвайте 
различните типове надписване. Въвеждайте някакви произволни текстове. Използвайте настройките 
от лентата за чертане за да промените шрифта, големината и цвета на въведените от вас надписи. 
Освен това, щраквайки два пъти върху текста ще се отвори прозорец с повече настройки, в който 
можете да промените текста, да го завъртите, да промените разстоянието между буквите и редовете 
и др.  

 

След като разгледате и разберете как работят различните настройки на начертаните графични 
обекти и текст, излезте от програмата, като не е нужно да записвате проекта. 
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Упражнение 6. Създаване и редакция на легенди. Класификация. 

Сега ще разгледаме различни варианти за изобразяване на данните чрез създаване на 
унифицирани легенди и класификации за обектите. Стартирайте програмата ArcMap и заредете 
слоевете cities.sdc и country.sdc от поддиректория \ESRI_Data\ world\ data\. Ако е необходимо, 
преподредете ги така, че точковия слой (градовете) да е отгоре. Отворете настройките на слоя с 
градовете (cities) като щракнете два пъти върху неговото име в съдържанието от ляво. 
Класифицирането на данните е достъпно в групата Symbology от прозореца за настройки на слоя 
(Layer Properties), показани на следващата фигура. Тук, в горната лява част, в полето Show са 
групирани и изброени възможните методи за класифициране на данните. Вече обяснихме, че при 
географските информационни системи във файловете с данни се помнят единствено координатите 
на обектите, а начина им на изобразяване върху картата (цвят, символ, вид линия и т.н.) се задава в 
проекта (наричан още документ). Така обединяването или разделянето на обектите в групи, които да 
се изобразяват с еднаква символика върху картата се извършва чрез класифицирането на данните и 
се отразява в легендата. В следващите стъпки ще разгледаме основните методи за класификация на 
данните. 

 

 

Изобразете градовете от слоя cities, като използвате последователно следните методи за 
класификация: 

• Единствен символ (Single symbol). Задава се като в полето Show (от групата Symbology в 
прозореца за настройки на слоя) изберете Features > Single Symbol. Това е най-простия 
метод, при който всички обекти се изобразяват по един и същ начин и се задава по 
подразбиране, когато зареждате нови данни. От полето Symbol, щраквайки върху бутона с 
примерния символ, можете да промените цвета и вида на символа по ваше усмотрение, като 
използвате уменията си от предното упражнение. С бутона Apply потвърдете избраните 
настройки. 

• Цветова градация (Graduated color). Класифицирайте градовете според населението. За тази 
цел в полето Show изберете Quantities > Graduated color, а в класификационното поле Fields 
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за стойност (Value) изберете POP_RANK (както е показано на следващата фигура). За брой на 
групите Classes задайте 7. В атрибутната таблица на градовете има колона POP_RANK, в 
която градовете са класифицирани от 1 до 7 в зависимост от тяхното население, като с 1 са 
обозначени най-големите градове, а със 7 – най-малките. По този начин върху картата ще 
отбележим по различен начин градовете от отделните класове. В централната част на 
прозореца ще се появи предлаганата по подразбиране класификация на градовете, като в 
първата колонка (Symbol) са показани символите за изобразяване на всеки клас, във втората 
колонка (Range) са стойностите, обуславящи класовете, а в третата колонка (Label) се 
предлага надписването за всеки клас. Разгледайте възможността за промяна на цветовете и 
вида на символите, като избирате чрез двойно щракване всеки един от предлаганите 
примерни символи. От полето Color Ramp можете промените цветовата градация, а 
щракайки върху името на колонката Symbol и избирайки Flip Symbol, можете да обърнете 
цветовете в градацията. Щраквайки върху Range пък можете да промените посоката на 
сортиране, а щраквайки с десен бутон върху даден ред се отваря контекстно меню, от където 
можете още да изтриете даден клас (Remove Classes) и др. Освен това, в табличната част 
можете ръчно да промените границите на класовете или техните надписи. Например, в 
колонката Label за първия клас, вместо „1” можете да напишете „най-големи градове”. 
Обърнете внимание, че така приложената класификация се отразява като легенда в полето на 
съдържанието от основния прозорец на програмата. Освен това, чрез бутонът Import можете 
да приложите готова схема на класификация от друг слой (ако има подходяща такава) или 
записана от по-стара версия на програмата (във формат *.avl). 

 

• Символна градация (Graduated symbol). Отново класифицирайте градовете според 
населението (POP_RANK). За целта в полето Show изберете Quantities > Graduated symbol. 
Сега отделните класове ще бъдат представени с еднакви по форма и цвят символи, но с 
различна големина. Тук също можете да променяте цветовете и вида на символите, като 
изберете примерния символ от бутона Template или щракате върху всеки един символ. 
долната лява част. Чрез Symbol Size можете да зададете желаната големина за първия и 
последния символ, а с последния бутон от реда да създадете градация между избраните две 
големини. Останалите бутони имат аналогични функции на разгледаните по-горе. 
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Изключете визуализирането на градовете за да не ви пречат и изобразете държавите (слоя 
country), като използвате следните типове легенди: 

• Уникална стойност (Unique value). Класифицирайте държавите според техните имена, така че 
всяка държава да е изобразена с различен цвят. В полето Show изберете Categories > Unique 

value, а в класификационното поле Value Field изберете CNTRY_NAME (както е показано на 
следващата фигура). С бутона Add All Values добавете всички възможни обекти в списъка за 
класификация и вижте резултата. Това е може би най-често използвания метод за 
класификация, чрез който може да групирате обектите по някакъв признак. Например, при 
изчертаване на геоложка карта можете в колонка от атрибутната таблица да указвате за всеки 
полигон какъв тип скала представя, после да класифицирате и всички полигони от даден тип 
скала ще бъдат изобразени по еднакъв начин, а от различните типове скали – по различен.  
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• Точкова (Dot). Класифицирайте държавите според тяхното население – в полето Show 
изберете Quantities > Dot density, а от Field Selection изберете POP2007 и чрез стрелката 
надясно го прехвърлете в десния списък, както е на долната фигура. Така най-гъсто 
населените държави ще бъдат изобразени с точкова мрежа с най-голяма плътност. Чрез 
бутона Exclusion изключете държавите, за които няма данни (в атрибутната таблица те са 
обозначени с -99999, което в случая е код за липса на данни). За тази цел, в новия прозорец 
задайте израза "POP2007" = -99999 и потвърдете с ОК. Потвърдете с бутона Apply и 
разгледайте резултатите. Чрез опцията Dot Value и плъзгача над нея може да променяте 
стойността, представяна от една точка, а чрез Dot Size – да променяте големината на точките. 
Задайте по-големи и по-малки плътности за да видите как действа тази функция. Все пак, не 
задавайте много високи плътности, понеже това силно ще затрудни и забави работата на 
програмата. Чрез опциите Symbol и Background можете да промените начина на представяне 
на точковите символи и фоновия цвят. 

 

 

• Диаграма (Chart). Класифицирайте държавите според тяхното население (POP2007) и площ 
(SQKM). За тази цел, в полето Show изберете Charts > Pie, а от Field Selection изберете 
последователно POP2007 и SQKM и чрез стрелката надясно ги прехвърлете в десния списък, 
както е на долната фигура. Потвърдете с бутона Apply. В резултат, всяка държава ще бъде 
представена чрез кръгова диаграма, представяща съотношението между нейните площ и 
население. Можете да промените цветовете на отделните параметри, като щракате два пъти 
върху полетата, показващи техните текущи цветове. Както в предния пример, чрез бутона 
Exclusion изключете държавите, за които няма данни за населението. Чрез бутоните 
Properties и Size можете да настроите как да изглеждат диаграмите. От полето Show можете 
изпробвате и другите типове диаграми – стълбовидна (Bar/Column) и наложена (Stacked).  
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• Цветова градация (Graduated color). Изобразете държавите според тяхното население 
(Quantities > Graduated color, а за Fields изберете POP2007), както е показано на следващата 
фигура. Чрез опцията Classes изпробвайте различен брой класове. Изберете бутона Classify и 
разгледайте възможните типове класификация. В прозореца за класификация (Classification) 
можете да зададете желания тип, броя на класовете, както и ръчно да зададете прагови 
стойности. В същия прозорец, чрез бутона Exclusion изключете държавите, за които няма 
данни за населението. Припомнете си обясненията на предлаганите типове, представени в 
теоретичната част за класификация в ръководството (К. Попов, 2007). Изпробвайте различни 
типове класификация. 

 

• Изобразете отново държавите чрез цветова градация (Graduated color) според населението 
(POP2007), но като го нормализирате спрямо цялото население (виж следващата фигура). За 
тази цел, от Normalization задайте <PERCENT OF TOTAL>. Така държавите ще бъдат 
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класифицирани в зависимост от техния процентен дял от общото население на планетата. 
Пак, чрез бутоните Classify и Exclusion изключете държавите, за които няма данни за 
населението (те просто няма да се изчертават на картата). Можете да нормализирате 
населението и по площта за всяка държава (Normalization = SQKM), за да видите държавите с 
най-голяма плътност на населението на единица площ. 

 

След като усвоите методите за класификация и представяне на данните, създайте карта на 
държавите и градовете, като ги класифицирате по избран от вас начин, който смятате за най-
подходящ. Във ваша работна папка можете да запишете проекта, например с името Exercise6. 

 

Както казахме, начинът на изобразяване на данните се записва във файла на проекта, а не в 
самите данни. Въпреки това, има възможност да запишете начините на изобразяване на даден слой 
така, че да можете да го зареждате и в други проекти, без да се налага там да го класифицирате 
наново. Това е особено полезно когато често използвате едни и същи данни в различни карти. 
Например, често използвате данни за градовете и реките и искате при зареждането им в нов проект 
(нова карта) реките винаги да бъдат изобразени със син цвят, а градовете де се показват чрез точки с 
различна големина в зависимост от броя на жителите. Това става чрез така наречените layer-файлове 
(.lyr). За да запишете начина на визуализиране на даден слой, след като го класифицирате и/или 
изобразите с желаните символи, щракнете с десен бутон върху името на слоя и от контекстното 
меню изберете Save As Layer File. В така създадения layer-файл се записва кои данни от кои папки по 
какъв начин са изобразени. По този начин може да запишете начина на визуализиране на данни не 
само от един слой, но и от цяла група. За да разгледате възможностите на layer-файловете, 
премахнете слоевете, с които работихте досега и от \ESRI_Data\ world\ data\ заредете файловете 
Countries.lyr, Major Rivers.lyr и World Cities.lyr. След като ги разгледате, изтрийте от картата тези 
слоеве и от \ESRI_Data\ world\ заредете World Map.lyr. В полето на съдържанието вижте какви данни 
се заредиха. Освен това, увеличете върху някой континент, после върху държава, да видите как се 
променя визуализирането и надписването на данните. Както сами ще се убедите, като layer-файл 
може да запишете дори готова карта, която да ползвате като основа в бъдещите си проекти.  

След като разгледате организацията и начините на изобразяване на данните от World Map.lyr, 
затворете програмата без да записвате проекта. 
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Упражнение 7. Надписване на данните. 

Стартирайте програмата ArcMap и заредете слоя с държавите (country) от директория 
\world\data. Настройте параметрите за надписване на country, като отворите прозореца с настройки 
на слоя и в групата Labels за поле за надписване (Label Field) задайте колоната с имената на 
държавите (CNTRY_NAME), както е на долната фигура. Увеличете картата така, че да виждате част от 
някой континент. 

 

 

В началото ще разгледаме възможностите за различни видове ръчно надписване. От лентата за 

чертане Draw отворете бутонното меню за надписване и изберете бутона за надписване (Label). 
В появилия се прозорец за настройки на надписите се предлагат две опции – чрез Placement можете 
да укажете надписите автоматично да се разполагат на най-доброто място или където сте щракнали с 
мишката, а Label Style ви предлага да използвате стиловете, зададени в прозореца за настройки на 
слоя или да изберете от списъка със стилове. Засега няма да променяме настройките тук, затова 
преместете този прозорец да не ви пречи или го затворете. Щракнете върху някоя държава и 
нейното име ще се появи като надпис върху картата. По този начин надпишете още няколко 

държави. Включете бутона с курсора за избиране  и като маркирате даден надпис, можете, по 
познатия ви вече начин, да промените неговия цвят, големината и вида на шрифта. Освен това, в 
прозореца за настройки на слоя (горната фигура) можете да настроите тези параметри преди да 
започнете надписването и после те ще се прилагат по подразбиране за нововъведените надписи. 
Накрая вероятно ще е удачно да настроите шрифта за надписване на черен, с големина 10 или 12 pts. 
Можете да промените даден надпис и чрез двойно щракване върху него. Ще се отвори прозореца за 
настройки на текста (Properties), в който можете да промените текста, подравняването, разстоянието 
между редовете и ъгъла на завъртане на надписа. Ако не ви харесва разположението на някой 
надпис, можете да го преместите на друго място, като го прихванете с курсора за избиране. 
Изтриването на ръчно поставените надписи също става ръчно, като ги маркирате и натиснете 
клавиша за триене (Delete или Del) от клавиатурата. 

Чрез бутона Label Styles от прозореца за настройки на слоя можете да изберете различни 
стилове за надписване – изпробвайте ги, за да видите как действат. Има и стил, при който при 
преместване на надписа се появява водеща линия до мястото на надписване.  
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От настройките на слоя задайте за колона за надписване - площта на държавите (Label Field: 
SQKM) и пак надпишете няколко държави. После върнете Label Field на CNTRY_NAME, ръчно 
надпишете няколко държави и променяйте мащаба на визуализиране на картата, за да видите как се 
променят големините на надписите. Накрая изтрийте всички ръчно поставени надписи. 

 

Освен ръчно, можете да надписвате обектите и автоматично, като от контекстното меню на 
слоя включите Label Features или в групата Labels от прозореца за настройки на слоя включите 
опцията Label features in this layer. Както виждате, това е една и съща функция, но е достъпна от две 
различни места – понеже е често използвана е включена в контекстното меню, отварящо се като 
щракнете с десния бутон на мишката върху слоя. Сега всички държави ще са надписани с техните 
имена, както е зададено в настройки на слоя, като надписите не могат да бъдат премествани и 
променяни ръчно. Изключването на автоматичното надписване става по същия начин – чрез 
деактивиране на опцията Label Features от контекстното меню или Label features in this layer от 
прозореца за настройки на слоя.  

 

Сега нека разгледаме и останалите настройки на надписите, намиращи се в групата Labels от 
прозореца за настройки на слоя. Ако сте изключили автоматичното надписване на държавите – 
включете го отново. Чрез бутона Placement Properties се настройва разположението на надписите 
спрямо обектите, като някои от опциите са различни в зависимост дали надписвате точкови, линейни 
или полигонови обекти. В новия прозорец Placement Properties (виж следващата фигура) изпробвайте 
предлаганите различни ориентации на надписите (Polygon Settings). Полето Duplicate Labels предлага 
три варианта за работа с дублиращи се надписи (ако има такива): да се премахнат дублиращите се 
надписи, да се сложи по един надпис на обекта или да се надпише всяка част от обекта (когато 
обектът е съставен от няколко части). Групата Conflict Detection пък съдържа функции за избягване на 
застъпването между съседните надписи. Имайте предвид, че ако надписите са много, при 
автоматичното надписване някои от обектите могат да останат ненадписани именно за да не се 
застъпват надписите. Тук чрез опциите Label Weight и Feature Weight се задават различни нива на 
забрана надписите и обектите от този слой да бъдат припокривани от надписи от други слоеве. 
Включването на опцията Place overlapping labels позволява показването на застъпващите се надписи.  
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Както вероятно се досещате, бутонът Scale Range от групата Labels в прозореца за настройки на 
слоя служи за задаване на мащаби, в които да се извършва надписването. Например, задайте за 
минимален мащаб 1 : 50 000 000 (minimum scale), а за максимален 1 : 10 000 000 (maximum scale). 
Така надписите на държавите ще се виждат само ако мащабът на картата е в този интервал. 
Изпробвайте го и после изключете мащабите, като изберете отново Use the same scale range as the 

feature layer.  

 

Друга много полезна възможност е автоматично да надпишем обектите по различен начин, в 
зависимост от групите в които сме ги класифицирали. Например, в прозореца за настройки на слоя се 
прехвърлете в групата Symbology и класифицирайте държавите според населението (POP2007) в пет 
класа, както го правихме в предното упражнение. После се върнете на групата настройки за 
надписване Labels и от Method изберете Define classes of features and label each class differently. После 
от новопоявилите се бутони изберете Get Symbol Classes, чрез което програмата ще прочете 
зададените от вас класификационни групи и те ще станат достъпни за разделно надписване. Чрез 
опцията Class изберете първия клас и за него задайте по-дребен шрифт и по-бледи букви. После от 
опцията Class избирайте последователно всеки следващ клас и му задавайте все по-голям шрифт и 
по-ярки букви от същия цвят. Накрая потвърдете с Apply и в резултат най-гъсто населените държави 
ще бъдат надписани с най-големи и най-контрастни надписи. След като разгледате възможността за 
различно надписване на класовете, се върнете на метода на еднакво надписване на всички обекти 
(за Method задайте обратно Label all the features the same way).  

В полето Text String можете да зададете и по-сложен израз за надписване на обектите. 
Изберете бутона Expression и в новия прозорец маркирайте FIPS_CNTRY от списъка и с бутона 
Append го добавете в полето отдолу. Ще получите израза [CNTRY_NAME]  & " " & [FIPS_CNTRY]. 
Потвърдете с OK да затворите прозореца и с Apply да приложите промените. Сега държавите ще се 
надпишат с техните имена, следвани от съкращението за всяка държава, тоест по този начин 
надписахме държавите не чрез една, а чрез две колони от атрибутната таблица.  

Накрая изключете надписването на държавите и затворете прозореца с настройки на слоя. 

 

От същата папка \world\data заредете слоя с реките (rivers.sdc) и отворете прозореца с неговите 
настройки. В групата Labels разгледайте възможните настройки за ориентация на надписите чрез 
бутона Placement Properties. Тук в полето Orientation може да направите надписите хоризонтални, 
паралелни на линията, огънати по линията и перпендикулярни. В полето Position може да настроите 
надписите да са над, върху или под линията, като чрез Orientation System ориентацията може да се 
настройва както спрямо страницата, така и спрямо линията, а чрез Offset можете да промените 
разстоянието между линията и надписа. Чрез опцията Location along the line можете да укажете дали 
надписа да се поставя на най-подходящото място (At Best) или в началото (At Start) или в края (At 

End) на линията. Останалите настройки действат по същите начини, които разгледахме в предната 
стъпка при надписването на държавите. Включете надписването на реките и изпробвайте различните 
варианти за ориентация и разполагане на надписите. Освен това, можете да зададете син цвят както 
за реките, така и за надписите. Също така, можете да изпробвате както автоматично, така и ръчно 
надписване. След като се упражните, премахнете всички надписи на реките.  

 

От същата папка добавете и слоя с градовете и увеличете изгледа върху някоя държава, за 
която са нанесени повече градове. В прозореца за настройки на слоя разгледайте възможните 
разположения на надписите (пак чрез бутона Placement Properties). Понеже това е точков слой, тук 
възможните положения на надписите са встрани около точката (Offset label horizontally around the 

point), върху точката (Place label on top of the point), завъртени под някакъв ъгъл (Place label at 

specified angles), и завъртени под различни ъгли от колона в атрибутната таблица (Place label at an 

angle specified by a field). В първия случай надписа се разполага на най-подходящото място около 
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точката, като на схемата с цифри са показани приоритетите на разполагане – т.е. програмата се 
опитва да разположи надписа на мястото, обозначено с „1“ и ако там има конфликт с друг надпис го 
мести в някое положение „2“, а ако и там има конфликт – опитва някоя позиция „3“. С бутона Change 

Location може да изберете и някоя друга схема за разполагане на надписите спрямо точките. 
Изпробвайте няколко различни схеми за надписване. Освен това, изпробвайте и втория варианти за 
надписване върху точките, както и третия – за надписване под определен ъгъл (тук чрез бутона 
Angles ще трябва да зададете един или няколко ъгъла на завъртане).  

 

След като упражнихте различните варианти за надписване на точкови, линейни и полигонови 
слоеве, изберете някой участък от картата (например, увеличете върху няколко държави) и 
надпишете всички видими обекти, като използвате вече научените похвати. Оформете надписите 
върху картата както смятате за най-добре, като избягвате наличието на припокриващи се надписи. 
Също така, стремете се да не използвате много едри или дребни шрифтове. След като оформите 
картата така, както според вас е най-удачно, можете във вашата работна папка да запишете проекта 
(например, с името exercise7) и затворете програмата. 
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Упражнение 8. Диаграми. 

В това упражнение ще разгледаме възможностите за създаване на графични диаграми. Много 
често е удобно да изобразите характеристиките на някои обекти, като в картата вмъкнете някакви 
диаграми или таблици.  

Стартирайте програмата ArcMap и от поддиректория \world\data заредете слоевете с данни за 
градовете и държавите (cities.sdc и country.sdc). Увеличете картата върху някой континент по ваш 
избор и маркирайте няколко съседни държави. Отворете атрибутната таблица на държавите и чрез 
иконата Show selected records покажете само маркираните държави. Намалете и преместете 
прозореца на таблицата, за да не ви пречи при работата с картата.  

Работата с диаграми е достъпна от менюто View > Graphs (виж долната фигура). Там има 
няколко функции за създаване на нова диаграма (Create), за създаване на нова матрица тип 
„скатерплот“ (Create scatterplot matrix), както и за управление (Manage) и зареждане (Load) на вече 
съществуващи диаграми.  

 

Изберете View > Graphs > Create за да създадете нова диаграма. В новия прозорец Create 

Graph Wizard (виж следващата фигура) се задават параметрите на диаграмата. От менюто Graph type 
можете да изберете какъв тип и разновидност да бъде графиката: стълбовидна (Bar), линейна (Line), 
площна (Area), XY- диаграма (Scatterplot), и др. От Layer/Table, можете да изберете по данните от кой 
слой да се строи диаграмата, а чрез Value field се задава колоната с данни от атрибутната таблица. 
Например, нагласете типа на графиката на Vertical Bar, за слой изберете country, а за Value field 
изберете POP2007, както е показано на следващата фигура. Така ще създадем графика, показваща 
вариациите на населението в държавите, при която всяка държава е показана със вертикално 
стълбче, чиято височина зависи от големината на нейното население.  
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Виждате, че стълбчетата на маркираните държави също са маркирани. Чрез опцията X field 

(optional) можем да зададем променлива от друга колона в таблицата, по която държавите да се 
подредят по оста Х. Следващата опция X label field служи за избор на колона от таблицата, чрез която 
да се надпишат държавите по оста Х. Тук можете да изберете FIPS_CNTRY, за да надпишем 
държавите чрез техните кодове (ако обектите са много, поради липса на място не всички ще бъдат 
надписани). Опциите Vertical axis и Horizontal axis служат за указване от коя страна да бъдат 
разположени вертикалната и хоризонталната оси. Чрез Add to legend се включва и изключва 
легендата към графиката, а Show labels (marks) показва стойностите и надписите за всеки обект. 
Можете да настройвате още цвета, стила на стълбчетата и др. 

В долния край на прозореца на диаграмата има бутон Add, чрез който можем да добавим нови 
данни (New Series) или някаква функция (New Function), за създаване на по-комплексна графика. 
Например, използвайте Add > New Function за да добавите функция – тази нова компонента в 
графиката ще се покаже като нова група над бутона Add. За тип на функцията (Function type) изберете 
„средна стойност“ (Average), а за източник на пресмятане изберете вече готовата графика (Vertical 

Bar). Така към стълбовидната графика за населението на държавите ще се добави хоризонтална 
линия, показваща къде попада средната стойност (средната населеност). Както виждате средната 
населеност не е голяма и има само няколко държави, които са със значителен брой на населението. 
Чрез червеното хиксче до името можете да изтриете добавената функция от графиката.  

Изберете бутона Next от прозореца на диаграмата и ще се прехвърлите на следващата стъпка. 
Тук можете да избирате дали върху графиката да се показват всички обекти от слоя (Show all features/ 

records on graph), при което да се маркират избраните обекти (Highlight currently selected features/ 

records) или графиката да показва само маркираните обекти (Show only selected features/ records on 

the graph). Чрез Title и Footer може да зададете заглавие над и текст под графиката, а чрез Graph in 

3D view може да добавите триизмерен ефект към графиката. Полето Graph legend служи за 
показване или скриване на легендата към графиката, както и за нейното надписване и избиране на 
положението й. В най-долното поле Axis properties можете за всяка ос по отделно да зададете 
заглавие (Title), дали да е видима (Visible) и дали да е в логаритмичен мащаб (Logarithmic). Ако е 
необходимо, с бутона <Back можете да се върнете на предната стъпка.  

 

След като настроите диаграмата както ви харесва, изберете бутона Finish и тя ще се появи като 
отделен прозорец от проекта. Можете да затворите графиката – тя няма да се изтрие. За да я 
отворите пак, от главното менюто изберете View > Graphs > Manage, което ще отвори прозореца за 
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управление на графиките (Graph Manager). Вашата графика ще бъде в списъка в този прозорец и 
можете наново да я отворите като щракнете два пъти върху нейната икона. В прозореца за 
управление на графиките има и няколко икони за създаване на нова графика, отваряне на 
съществуваща и изтриване, както и иконата Properties за промяна на настройките на диаграмата. 
Чрез последната икона може да променяте вече зададените настройки на графиката. Освен това, 
щракайки с десния бутон върху диаграмата от списъка ще се отвори контекстно меню, чрез което 
можете да отворите (Open), разпечатате (Print), запишете (Save), експортирате като картинка (Export) 
и т.н. избраната диаграма.  

В прозореца на самата диаграма, щраквайки с десен бутон върху някой от обектите, също се 
отваря контекстно меню, чрез което можете да идентифицирате дадения обект (Identify) и пак да 
разпечатате, преименувате, запишете и т.н. графиката. Освен това, ако маркирате още обекти или 
размаркирате някои, това ще се отрази и върху графиката. 

 

За да се упражните, създайте нова диаграма и разгледайте и останалите типове графики. За 
целта може да използвате и данните за площите на държавите от колоната SQKM. Основните типове 
диаграми и възможните им области на приложение са следните: 

• Линейни / площни диаграми – подходящи са за представяне на тенденции във времето или 
пространството; 

• Стълбовидни (лентовидни) диаграми – за сравняване на индивидуални стойности; 

• Кръгови диаграми – за представяне на взаимоотношения между части, както и отношение на 
една част спрямо цялото; 

• Точкови XY диаграми (scatter plot) – показват зависимостта между двойка променливи, както и 
тенденциите в структурата на данните 

Изпробвайте опцията за промяна на типа на графиката (Graph type), като задавате различни 
типове. Ще се убедите, че някои типове са по-удачни за представяне на вашата графика в сравнение с 
други, а трети са въобще неприложими в дадения случай. Вероятно, за изобразяването на 
населеността на избраните от вас държави най-удачни ще се окажат някои от вариантите на 
стълбовидните или кръговите типове. 

Създайте нова графика, която да е тип XY-диаграма (Scatter Plot) и да показва отношенията 
между населението и площите на маркираните държави. За целта, например, по ординатата (Y field) 
задайте POP2007, а по абсцисата (X field) изберете SQKM. След като диаграмата е готова, опитайте 
да добавите и махнете някои държави към графиката, като ги маркирате и размаркирате върху 
картата. От контекстното меню на диаграмата отворете настройките (Properties) и променете някои 
настройки, за да се упражните.  

В края на упражнението оформете съставените от вас диаграми така, че да бъдат в окончателен 
вид, който според вас е най-подходящ. Ако е необходимо, редактирайте текстовете, настройте 
цветовете и другите параметри. Накрая запишете целия проект, като го кръстите, например, с името 
exercise8 и затворете програмата. 
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Упражнение 9. Използване на планове: Създаване на окончателни карти. 

Окончателната карта е основният изходен продукт от ГИС. Когато я подготвяте, обръщайте 
особено внимание на нейния дизайн и структура. Чрез окончателната карта вие представяте вашите 
данни, резултати и интерпретации. Стремете се да подчертаете елементите, които са най-важни в 
картата и избягвайте да претрупвате картата с прекалено много информация, от което тя да бъде 
трудно разбираема. Ако има някакви предварителни изисквания или стандарти за създаване на 
определен тип карти, винаги трябва да се съобразявате с тях. Обикновено, преди да изготвите 
окончателната карта следва да изберете необходимия мащаб и картографска проекция. 

Стартирайте програмата ArcMap и заредете слоевете cities.sdc, drainage.sdc, country.sdc и 
world30.sdc от поддиректория \world\data\. Подредете слоевете в последователността, в която бяха 
изброени. След това увеличете върху някой континент по ваш избор.  

Като използвате настройките на слоя cities задайте подходящо име (Layer Name:) с което искате 
слоя да фигурира в окончателната легенда, например “градове”. Чрез настройките на легендата 
класифицирайте градовете според техния статут (дали са столици или не). За целта, в групата 
Symbology изберете Show > Categories > Unique Value, а за Values Field: Status. Чрез бутона Add All 

Values добавете всички възможни класове в списъка на класификацията. В резултат ще получите 
около шест класа градове, като е показано на долната фигура. Първите три класа представят 
столиците на държавите и провинциите, а останалите три са градове от по-нисък ранг. 

 

 

 

Маркирайте първите три класа (реда), щракнете върху тях и от контекстното меню изберете 
Group Values – по този начин ще обединим първите три класа в една група. После маркирайте и 
последните три класа и ги обединете и тях в една група. Така ще получим две групи: столици на 
държави и провинции и градове от по-нисък ранг. В колонката Label може да ги надпишете 
съответно „столица“ и „град“, както е показано на следващата фигура. Освен това, за столиците може 
да зададете по-голям и контрастен символ, а за градовете – по-малък и блед. Също така, можете да 
изключите началния ред, изобразяващ некласифицираните обекти (<all other values>), понеже няма 
такива и не е необходимо да го виждаме в легендата.  
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Върху картата надпишете няколко столици, като подберете подходящ шрифт и цвят. Можете да 
използвате познатите ви вече похвати за ръчно или автоматично надписване, но не надписвайте 
много градове, понеже после ще нанесем още информация върху картата и тя може да стане 
претрупана. 

 

Изберете слоя с дренажните системи (drainage) и по подходящ начин надпишете дренажните 
системи на реките (имената са въведени в полето SYSTEM от атрибутната таблица). Ако е 
необходимо, преместете някои от отделните надписи и променете ъгъла им на завъртане. Например, 
оцветете реките в синьо и надписите им също ги направете сини, с наклонени букви (курсив). 

После в групата Fields от настройките на слоя с дренажните системи изключете 
визуализирането на полетата ObjectID и Shape. В полето Alias задайте подходящи надписи за 
колоните, например, за SYSTEM, BASIN_AREA, DISCHARGE и SED_LOAD напишете съответно 
“Система”, “Площ”, “Дебит”, “Утайконатрупване”. 

Създайте нова диаграма, която да показва отношенията между площите на басейните и 
техните дебити. За тази цел използвайте информацията в атрибутната таблица, въведена в полетата 
площ на басейна на реката (BASIN_AREA) и дебит (DISCHARGE). Вероятно, най-добре ще е да 
представите диаграмата, като използвате тип Scatter Plot. Настройте големината на прозореца и 
елементите на диаграмата – надписите, цветовете и т.н.  

С извършеното до тук направихме кратък анализ на дренажните системи, като фокусирахме 
върху избрания от вас континент. Чрез съставената карта представихме площното разпространение 
на дренажните системи, а наличната информация изведохме във вид на таблица. Освен това, 
изготвихме и диаграма, която да представя даден анализ на информацията – в нашия случай – 
отношението между дебитите и площите от дренажните системи. Следващата стъпка ще бъде да 
организираме тези три елемента на ГИС (картата, таблицата и диаграмата) във вид на окончателна 
карта. 

В допълнение може да настроите и слоевете country и world30, като им зададете подходящи 
цветове и имена. Например, може да ги кръстите съответно „държави“ и „географска мрежа“. 

От главния прозорец на програмата превключете в режим на план (окончателна карта). 
Превключването между режимите за работа с данните и плана става чрез първите два от малките 
бутони  (Data View и Layout View), разположени долу вляво под картата, пред 
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хоризонталния плъзгач. Когато включите в режим на план, ще видите страница и върху нея ще бъде 
разположена картата. Настройките на страницата може да зададете чрез главното меню File > Page 

and Print Setup. Например, нагласете страницата да е с големина А4, ориентирана по ширина 
(Landscape) и потвърдете с ОК. После, като прихващате картата в краищата, я свийте за да стане по-
малка и я разположете в лявата половина на страницата.  

Отворете (ако междувременно сте го затворили) или се прехвърлете в прозореца на таблицата 
на дренажните системи и от нейното бутонно меню Table Options изберете Add Table to Layout. По 
този начин ще добавим и таблицата върху страницата на плана. Вече може да затворите прозореца 
на таблицата, а върху плана можете да увеличите или свиете размерите на таблицата така, че да се 
виждат само интересуващите ни колони. Разположете таблицата, например, в средната дясна част на 
страницата така, че да не се припокрива с картата.  

Прехвърлете се върху прозореца на диаграмата или ако сте го затворили – го отворете чрез 
View > Graphs > Manage. Щракнете с десния бутон на мишката върху диаграмата и от контекстното 
меню изберете Add to Layout за да я добавим в плана. Вече затворете прозореца на диаграмата, а 
върху страницата я разположете в горната дясна част. Ако е необходимо, променете и размерите на 
диаграмата.  

 

След като разположихме основните елементи върху страницата, нека добавим и 
спомагателните, като легенда, мащаб и т.н. Това става от главното меню Insert. Изберете Insert > 

Legend за да добавим легенда. Ще се появи нов прозорец, в чието ляво поле има списък на всички 
слоеве, а в дясното – на слоевете, които ще бъдат включени в легендата. Чрез стрелките между двата 
списъка можете да прехвърляте или премахвате слоеве в десния списък. Например в десния списък 
оставете само слоевете на градовете и реките. Чрез стрелките в десния край на прозореца можете да 
преподреждате слоевете в десния списък, а отдолу можете да зададете и броя на колоните в 
легендата. С бутона Next може да се прехвърлите на следващата стъпка, където се указва заглавието 
на легендата и неговия шрифт, цвят и др. На третата стъпка (пак с бутона Next) се задават рамка и фон 
за легендата, а на четвъртата – настройките на типовите символи. На последната пета стъпка пък 
могат да се задават разстоянията между елементите и текстовете в легендата. На всяка стъпка има 
бутон Preview, чрез който може да се види как изглежда легендата при текущите настройки, а 
натискайки още веднъж бутона Preview – можем да продължим на следващата стъпка. Накрая с 
бутона Finish ще завършим настройването на легендата и ще я видите върху страницата. Преместете 
легендата в празното място в дясната долна част на страницата.  

Чрез Insert > North Arrow нека добавим и символ за посоката на севера. Ще се отвори 
прозорец, от който изберете някой от символите, а чрез бутона Properties можете да промените 
големината, цвета и ъгъла на завъртане. Потвърдете с ОК и преместете появилия се символ за севера 
на свободно място върху страницата, някъде около картата.  

Пак от менюто Insert изберете Scale Bar за да добавите и линия, изобразяваща мащаба. 
Маркирайте някоя от предлаганите мащабни линии и потвърдете с ОК (по-късно ще разгледаме 
нейните настройки). Преместете мащабната линия под картата. Може да променяте нейната ширина, 
като я прихванете от левия или десния край и я свиете, при което автоматично ще се променят и 
надписите на мащабната линия.  

Накрая нека добавим и заглавие на картата. Изберете Insert > Title, в новия прозорец въведете 
някакво заглавие, например „Карта на дренажните системи“ и потвърдете. Преместете заглавието 
над картата. Чрез настройките от лентата за чертане можете да промените големината, вида и цвета 
на шрифта, а щракайки два пъти върху заглавието, можете да промените и текста, подравняването, 
разстоянието между буквите и т.н. От менюто Insert > Text можете да добавите и обикновен текст, 
например за обяснение, автор и т.н. Чрез Insert > Dynamic Text можете да добавите така наречения 
динамичен текст, като текуща дата и час, дата на записване, координатна система и др., който ще се 
промени, когато се промени съответния параметър.  
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Вече добавихме всички основни и спомагателни компоненти в окончателната карта и ги 
разположихме върху страницата. Вероятно сте получили някакъв план, подобен на долната фигура. 

 

Между иконите вероятно имате и лентата Layout, а ако не – включете я чрез Customize > 

Toolbars > Layout. Чрез бутоните на тази лента  можете 
да увеличавате и намалявате изгледа на плана, да местите, виждате цялата страница или в мащаб 
приблизително 1:1 спрямо разпечатката, да увеличавате и намалявате плана с фиксирана стъпка, да 
виждате предходното или следващото положение, както и да задавате мащаба на изобразяване на 
плана върху екрана и др. Обърнете внимание, че има две отделни групи икони за увеличаване/ 
намаляване – с едната се увеличава и намалява изобразяването на данните в самата карта (променя 
се мащаба на картата), а с другата група икони (от лентата Layout) се увеличава и намалява върху 
страницата (както тук я наричаме– план или окончателна карта). Изпробвайте как действат бутоните 
за увеличаване/ намаляване от лентата Layout. Освен това, можете да увеличавате и намалявате 
върху страницата като я посочите с курсора на мишката въртите колелцето на scroll-бутона. 
Задържайки натиснат scroll-бутона пък можете да прихванете и преместите страницата. Също така, 
маркирайки два и повече компонента от страницата, можем да използваме функциите от бутона за 
чертане Drawing или достъпни чрез десния бутон от контекстното меню на картата за групиране, 
подравняване подреждане и т.н.  

Сега поотделно ще разгледаме настройките на отделните компоненти. Маркирайки и 
щраквайки с десен бутон на мишката върху всеки компонент ще отвори контекстно меню, от което 
има достъп и до настройките (Properties) на дадения елемент. Нека започнем с картата. Винаги може 
да се върнете обратно в режима за работа с данни и да промените нещо по нея. Обърнете внимание, 
че ако промените начина на визуализиране на картата в режима за работа с данните (например, ако 
увеличите, намалите или преместите картата), извършените промени ще се отразят и върху плана. 
Например, изтрийте слоя world30 от съдържанието (той няма да ни трябва повече). Това е така 
наречената “жива връзка” между картата и окончателния план. Освен това, в режима на плана, 
щраквайки два пъти върху картата от страницата пак можете да работите с отделните обекти от 
картата, например можете да маркирате някой ръчно поставен надпис и да го преместите, да 
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изместите областта, която се вижда на картата и т.н. Размаркирането на компонент става просто като 
щракнете върху празно място от страницата. Маркирайте картата от страницата и чрез десен бутон 
изберете Properties. Ще се отвори познатия ви вече прозорец за настройки на картата, където ако е 
необходимо можем да правим допълнителни настройки. Например, изберете групата Data Frame и 
променете обхвата на картата (Extent) от автоматичен на фиксиран (Fixed Scale), а в появилото се 
поле за мащаб (Scale) задайте някакъв кръгъл мащаб, близък до текущия (например 1 : 50 000 000) и 
потвърдете с Apply. Така ще зададем точен мащаб на картата и ако разпечатваме страницата, картата 
ще бъде именно в този мащаб. После се прехвърлете в групата Grids и изберете бутона New Grid за 
да поставим координатна мрежа върху картата. Ще се появи прозорец, в който стъпка по стъпка се 
настройва координатната мрежа – за сега само потвърждавайте с Next и накрая с Finish и Apply, за да 
видите резултата. Освен това, от групата Frame за фонов цвят (Background) задайте синьо и 
потвърдете с ОК – така можем да попълним липсата на морета и океани върху картата.  

Щракнете два пъти върху мащабната линия или с десен бутон от нейното контекстно меню 
изберете Properties за да я настроим. В отворилия се прозорец с настройки (показан на долната 
фигура), в първата група Scale and Units можем да укажем чрез колко главни (Number of divisions) и 
второстепенни интервала (Number of subdivisions) да се изобразява мащабната линия. Използвайте 
опцията Division Units да нагласите мащаба да се показва в километри, а чрез Label Position може да 
укажете къде да се разположи надписа за мерната единица. В полето Label може да въведете как 
точно да се надпише мерната единица. В следващата група от прозореца (Numbers and Marks) чрез 
честотата на надписване (Frequency) се указва дали да се надписват само главните интервали 
(divisions) или да се надписват и второстепенните интервали (subdivisions), краищата (ends) или други 
варианти, а чрез Position се задава положението на надписите спрямо линията. В групата Format 
може да се настроят цвета и шрифта на надписване и стила на линията. Във Frame може да се зададе 
рамка, фон и светлосянка, което обикновено не се прави за мащабната линия. Чрез групата Size and 

Position може по-прецизно да зададете размерите на мащабната линия и нейното местоположение 
върху страницата. След като направите желаните настройки, потвърдете с ОК и върху страницата 
хванете мащабната линия в десния край и променете ширината й така, че надписите да са кръгли 
числа.  

  

Сега щракнете два пъти върху легендата, за да разгледаме и нейните настройки. В нейния 
прозорец (виж долната фигура) чрез първата група Legend може да се зададе заглавие (Title) на 
легендата, което с опцията Show може да се показва и скрива, а чрез бутона Symbol се избира 
шрифта, цвета и големината на текста. В полето Patch се настройват големината и как да изглеждат 
символите в легендата, а чрез Spacing between се задават разстоянията между елементите. Във 
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втората група Items се определят настройките за всеки слой от картата. Освен това, ако легендата е 
голяма чрез Columns може да я направите в повече от една колони, а чрез Place in new column може 
да укажете маркирания слой от списъка да започне на нова колона в легендата. Например, изберете 
реките (от десния списък), включете Place in new column и потвърдете с Apply да видите как действа.  

  

Бутонът Style от групата Items отваря нов прозорец (левия от долната фигура), в който може да 
се промени стила на легендата като се избере някой от шаблоните. От тук чрез бутона Properties 
може в легендата да показвате и скривате името на слоя (Show Layer Name), надписите на 
елементите (Show Labels) и заглавието на слоя (Show Heading), както и чрез прилежащите им бутони 
да променяте шрифта им за надписване (десния прозорец от долната фигура). Например, 
маркирайте слоя с градовете, включете и изключете името и заглавието на слоя и променете шрифта, 
за да видите как работят тези функции.  

  

Настройките на останалите компоненти от плана също могат да бъдат променяни. Щраквайки 
два пъти върху диаграмата може да промените както нейните параметри, така и големината и 
разположението й върху страницата. Отваряйки настройките на таблицата от плана може да и 
зададете рамка, фон и светлосянка (Frame) или също да промените големината и разположението й 
върху страницата (Size and Position). По подобен начин може да промените и настройките на символа 
за посоката на севера.  

Чрез лентата за чертане Draw могат да се начертаят и някакви допълнителни графични 
елементи. Най-често това са спомагателни елементи, като стрелки, линии, правоъгълници и др., 
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които биха ви помогнали да оформите плана по-добре. Не забравяйте, че тези спомагателни 
елементи не са пряко свързани с данните и се запомнят единствено в дадения проект. 

Сега е време да направите окончателното аранжиране на всички обекти в плана, като ги 
подредите по подходящ начин и донастроите техните размери. Подредете ги така, че да не се 
застъпват. Освен това, нагласете размерите им така, че елементите да са пропорционални и да не са 
много големи или много малки. Ако е необходимо, донастройте надписите и цветовете.Например, 
окончателната карта няма да изглежда добре ако графиката е голяма и с “тлъсти” надписи, а 
таблицата е дребна, свряна някъде по ъглите и нечетлива. За да изглежда добре вашият план, 
можете да нагласите картата (която в този случай е основния елемент) да е най-голяма и да заема 
около половината или повече от листа, а останалите елементи да са по-дребни и подредени около 
картата. В други случаи може някоя графика да е основният елемент, който показва резултатите от 
вашето изследване и върху който искате да фокусирате вниманието. Тогава следва графиката да 
бъде най-едра и да заема централно място, а картата, която бихте използвали само за илюстриране 
на местоположението на изследвания район може да бъде по-малка и разположена в някой край. 
Все пак, дизайна на вашия план винаги е донякъде субективен, особено ако не подготвяте някаква 
карта с предварително зададени стандарти и изисквания. 

Накрая, нека да добавим и рамка на картата. За тази цел от главното меню изберете Insert > 

Neatline. Ще се отвори прозореца за настройки на рамката, показан на долната фигура. Трите опции в 
горната лява част на този прозорец ви предлагат да оградите с рамка някой предварително маркиран 
елемент (Place around selected element(s)), да оградите всички елементи от плана (Place around all 

elements) или да разположите рамката по границите на страницата (Place inside margins).  

 

Изберете, например, третия вариант (Place inside margins). Опцията Rounding служи за 
заобляне на ъглите на рамката. Чрез Border изберете някакъв шаблон за рамката, а чрез Background 
може да изберете цвят за запълване. Последната функция е удобна, когато искате цялата карта да е 
разположена на някакъв цветен фон. Опцията за светлосянка (Drop shadow) добавя допълнителен 
тримерен ефект на рамката. Нагласете настройките по ваш вкус и потвърдете с ОК. Рамката ще се 
появи върху страницата. Ако рамката не ви харесва, изтрийте я с клавиша Delete, след което я 
направете отново. По аналогичен начин може самостоятелно да оградите и някои елементи от плана, 
като предварително ги маркирате.  

Рамката беше последният елемент, с който завършихме подготовката на окончателната карта 
(плана). Ако имате принтер, можете да разпечатате този план, като използвате менюто File > Print. 
От друга страна, чрез менюто File > Export Map можете да запишете плана като картинка в някакъв 
стандартен формат (Metafile, JPEG, PDF, EPS и т.н.), която ще може да се чете и от други програми. 
Последната възможност е много полезна, когато искате да вмъкнете окончателната карта в някой 
документ или отчет, например, писан на Microsoft Word. 

Поздравления. Направихте първата си самостоятелна карта в среда на ГИС. Запишете проекта 
(от менюто File > Save As), като му дадете някакво име, например “exercise9” или “drainage map”. 
Затворете програмата с File > Exit.  
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Упражнение 10. ГИС Анализ: Запитвания към данните (Querying). 

Една от основните отличителни черти на ГИС, в сравнение с други чертожни програми е 
възможността за извършване на различни анализи на пространствените данни. В това упражнение 
ще разгледаме по-подробно някои основни похвати, които вече сте употребявали в предишните 
задачи, както и някои по-специфични операции с данните. 

Стартирайте програмата ArcMap и заредете познатите ви данни от слоеве cities.sdc и 
country.sdc от директория \world\data\. Отворете атрибутната таблица на слоя с градовете, намалете 
големината й и я преместете за да виждате добре и картата. Вече знаете, че в ГИС съществува връзка 
между графичните обекти от картата и техните характеристики, записани в таблицата. 

Нека припомним вариантите за графично маркиране на обектите от картата: 

Основният начин е чрез бутонното меню  за избиране на обекти (Select Features…). 
Обектите могат да бъдат маркирани поотделно чрез щракване върху тях или чрез изчертаване на 
правоъгълник, полигон, ласо и др., около обектите от картата. 

Друга възможност за графично избиране на обекти е чрез средствата за чертане  от лентата 
Draw. За тази цел изберете желаната фигура от бутонното меню, като линия, полигон, окръжност и 
т.н. Например, можете да свържете интересуващите ви обекти посредством начупена линия или да 
ги оградите с полигон или правоъгълник. Начертайте избраната фигура върху картата. След това 
натиснете от главното меню изберете Selection > Select by Graphics и всички обекти, които попадат в 
графичния елемент или допират неговите граници ще се маркират. 

За премахване/размаркиране на избора от картата и базата данни се използва бутонът за 

“изчистване на избора”  (Clear Selected Features) или менюто се избира Selection > Clear Selected 

Features. 

Упражнете вариантите за маркиране чрез изчертаване на различни графични обекти. За 
удобство може да превключите таблицата в режим на показване само на избраните обекти, за да ги 
виждате по-ясно.  

 

Друг, често използван в ГИС похват е извършването на запитвания към базата данни: 

Най-бързият начин за визуализиране на информацията от базата данни, отнасяща се за даден 

географски обект е използването на бутона за “идентифициране на обект”  (Identify). Тази функция 
извлича и визуализира атрибутната информация от всички колони в таблицата, привързана към 
маркирания обект. 

Друга възможност е използването на средството за запитвания по атрибути. Избирането на 
обекти се извършва чрез задаване на израз, използвайки полетата и стойностите от базата данни. За 
да се изведе прозореца за съставяне на запитвания изберете менюто Selection > Select By Attributes. В 
новия прозорец, за да съставите израза трябва първо да укажете с данните от кой слой (Layer) ще 
работите. После от списъка избирате полето (колоната), по което ще се извършва запитването, като 
щраквате два пъти с мишката върху него. След това, с единично щракване избирате оператор и 
накрая с двойно прищракване избирате стойност от колоната или тип на критерия, които се извличат 
чрез бутона Get Unique Values. За отделяне на групите в израза се използват обикновени (кръгли) 
скоби. Методите за съставяне на запитвания (Method) са следните: 

Съставяне на нова извадка (Create a new selection): Образуване на нова извадка, чрез зададения 
израз. Всички обекти, които отговарят на критериите от зададения израз, се маркират и 
образуват извадка от данните. 

Добавяне към извадката (Add to current selection): Добавя нови обекти към съществуващата вече 
извадка, обикновено чрез формулиране на нов израз за търсене. 
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Премахване от извадката (Remove from current selection): Премахва обекти от съставената вече 
извадка чрез задаване на нов израз. 

Избиране от извадка (Select from current selection): Извадка от извадката. Осъществява се ново 
търсене и маркиране, само сред обектите от вече съществуваща извадка. 

Нека, например, съставим извадка, съдържаща всички градове от Русия. Отворете атрибутната 
таблица на слоя cities, ако вече не сте я отворили. Функцията за запитвания е достъпна и от таблицата 
– от иконата Table Options изберете Select By Attributes. Съставете израза "CNTRY_NAME" = 'Russia', 
като щракнете два пъти с мишката върху полето "CNTRY_NAME" от горния списък, после изберете 
бутона за равенство, а накрая изберете Get Unique Values и от появилия се списък в средата 
щракнете два пъти върху 'Russia'. Ако се затруднявате да зададете израза чрез мишката, можете да 
го изпишете ръчно в бялото текстово поле, разположено в долната част на прозореца. Изберете 
метода за нова извадка (Create a new selection) и потвърдете с Apply. Разположете прозорците на 
таблицата и за съставяне на заявки така, че и двата да са видими, но да виждате добре и картата. Без 
да затваряте прозореца за съставяне на заявки, прехвърлете се в прозореца на таблицата и с бутона 
Show selected records изведете данните от получената извадка. Разгледайте маркираните градове, за 
да се убедите, че те са от Русия. От лентата на таблицата изберете иконата за увеличаване върху 

маркираните обекти , за да ги видите и на картата.  

Нека сега към получената извадка да добавим и градовете от САЩ. В прозореца за дефиниране 
на извадките премахнете стария израз, като го изтриете от долното текстово поле и по аналогичен 
начин задайте нов израз "CNTRY_NAME" = 'United States'. После за метод задайте добавяне към 
извадката (Method > Add to current selection) и потвърдете с Apply. В новата извадка, в таблицата, 
вече ще са маркирани всички градове от Русия и САЩ. Разбира се, те ще са маркирани и на картата в 

което може да се уверите пак чрез иконата за увеличаване върху маркираните обекти .  

Накрая, нека от така получената извадка да отстраним градовете с население по-малко от пет 
милиона. Задайте нов израз "POP_CLASS" = '5,000,000 and greater' и използвайте метода за 
избиране от извадка (Select from current selection). Вижте полученият резултат в таблицата и на 
картата – следва да са маркирани само градовете от Русия и САЩ с повече от пет милиона жители. 

 

Сега, докато имаме маркирани обекти върху картата, затворете прозореца за дефиниране на 
заявки и в полето на съдържанието щракнете с десен бутон върху името на слоя с градовете. В 
контекстното меню на слоя има обособена група от функции за работа с маркирани обекти 
(Selection), от където също можете да увеличите или преместите върху избраните обекти, да 
премахнете маркирането, да превключите между маркираните и останалите обекти (тоест да 
размаркирате маркираните и маркирате останалите - Switch Selection), да маркирате всички обекти 
(Select All), да направите само обектите от този слой да могат да бъдат избирани (Make This The Only 

Selectable Layer), да копирате атрибутните данни за избраните обекти (Copy Records For Selected 

Features), да обособите маркираните обекти като нов слой от картата (Create Layer From Selected 

Features) и така да може да боравите с тях все едно са отделни данни, както и да отворите таблицата 
само с избраните обекти (Open Table Showing Selected Features).  

 

Също от контекстното меню на слоя, чрез Data > Export Data можете да запишете данните от 
слоя в нов файл (виж долната фигура), като с опцията Export може да укажете дали да се запишат 
само маркираните обекти (Selected features) или всички обекти от слоя (All Features) или всички 
видими обекти от картата (All Features in View Extent). Сега не е необходимо да експортираме 
данните, затова само затворете прозореца с Cancel и размаркирайте всички обекти.  
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Добавяне и свързване на външни бази данни и електронни таблици в ArcGIS. 

Сега ще разгледаме някои начини за добавяне на информация в ГИС. Първият вариант е когато 
в табличен вид вече сте въвели информация за точкови обекти и освен допълнителната описателна 
информация имате и координатите на точките (отчетени, например, чрез GPS). 

Използвайте отново слоевете cities и country от директория \world\data\. Увеличете картата 
така, че да обхваща България. Както виждате, в слоя cities има информация само за няколко града от 
България. Заедно с това ръководство се разпространява и една директория, наречена \Add_XY_Data, 
в която има таблица, наречена bulgarian_towns.xls, съдържаща координатите на още няколко 
български града. Копирайте тази директория, заедно с таблицата, във вашата работна папка. Ако 
нямате копие от тази таблица, можете да я създадете, като въведете данните в Microsoft Excel, а 
информацията, която се съдържа в таблицата е показана по-долу.  

Таблица с информацията от примерния файл bulgarian_towns.xls. 
NAME X_COORD Y_COORD 

Vidin 22.874300 43.990400 

Pernik 23.034800 42.603800 

Blagoevgrad 23.093100 42.015700 

Pazardzik 24.324800 42.190800 

Plovdiv 24.751000 42.144200 

Asenovgrad 24.870500 42.004700 

Gabrovo 25.317300 42.875400 

Kazanlak 25.393100 42.618700 

Stara Zagora 25.633800 42.425800 

Sliven 26.316100 42.681900 

Jambol 26.518000 42.480700 

Pleven 24.618100 43.409200 

Veliko Tarnovo 25.632100 43.074800 

Ruse 25.969700 43.840200 

Sumen 26.930700 43.273300 

Dobric 27.828300 43.570700 

Използвайте бутона Add Data и заредете таблицата \Add_XY_Data\bulgarian_towns.xls. Понеже 
електронните таблици от Microsoft Excel могат да съдържат повече от една таблица, когато щракнете 
два пъти върху .xls файла, той ще се отвори подобно на папка. В нашия файл имаме само една 
таблица ‘Bulgarian Towns$’ – отворете я. Таблицата ще се появи като нов слой в съдържанието, но 
градовете от нея не се появиха върху картата, понеже тази таблица не е свързана с графични обекти 
от картата, т.е. тя не е атрибутна таблица на някой слой. За да разгледате таблицата, в полето на 
съдържанието щракнете с десен бутон върху нея и изберете Open. Както виждате, в тази таблица са 
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въведени някои по-големи български градове, като в отделни колони са зададени техните имена и 
координати (географски дължина и ширина). Сега ще добавим тези градове върху картата. За тази 
цел щракнете с десния бутон върху името на таблицата от съдържанието и от контекстното меню 
изберете Display XY Data. В новопоявилия се прозорец укажете в кои колони от таблицата са 
координатите, като за X Field и Y Field задайте съответно полетата X_COORD и Y_COORD. В долната 
част на прозореца се посочва координатната система, в която са определяни координатите – тук по 
подразбиране е зададена географска система WGS 1984, но с бутона Edit може да се укаже и друга 
система. Понеже в нашия случай координатната система е зададена вярно, само потвърдете с ОК. 
Ще се появи предупредителен прозорец, че таблицата не съдържа Object-ID поле, поради което 
няма да можете да извършвате някои операции с обектите – само потвърдете с ОК – ако е 
необходимо, по-късно можем да експортираме тези данни в стандартен за ГИС формат (например в 
shape-файл). В картата ще се появи нов слой, съдържащ добавените градове. Както казахме, 
въведените по този начин данни (от таблици с налични X,Y координати) могат да бъдат 
визуализирани, но не могат да бъдат графично редактирани. За да бъде възможно възприемането 
им като стандартни за ArcGIS данни, те могат да се запишат и в shape-файл, като щракнете с десен 
бутон върху слоя ('Bulgarian Towns$' Events) и от контекстното меню използвате познатата опция Data 

> Export Data. Иначе с  може да видите информацията за добавените градове.  

Свързване (Joining) на таблици или на бази данни към таблица. 

Друг начин за добавяне на информация към даден слой е осъществяването на връзка между 
атрибутните таблици. Когато две бази данни имат общо поле и описват едни и същи обекти, 
информацията от таблиците може да бъде обединена (свързана). Когато двете таблици са свързани, 
обектите могат да бъдат класифицирани по обединената информация. 

Нека упражним свързването, като използваме примерните данни от слоевете cities и country, 
като в таблицата на градовете добавим и информацията за държавите. Използвайте следната 
последователност: 

1. Отворете таблиците на двата слоя. Те ще се отворят в един и същ прозорец, но можете да се 
прехвърляте между отделните таблици, като избирате името на съответния слой от долната дясна 
част на прозореца (виж долната фигура). Обърнете внимание, че и в двете таблици има колона 
CNTRY_NAME – тя ще бъде общото поле при свързването. 

 

2. Прехвърлете се в таблицата на cities. От първата икона Table Options изберете Joins and Relates > 

Join. Ще се отвори прозореца за настройване на свързването (показан на следващата фигура). 
Между другото, същите функции за свързване са достъпни и от настройките на слоя.  

3. В прозореца на свързването изберете Join attributes from a table, с което указваме, че ще свързваме 
въз основа на атрибутната информация. В първото поле, отбелязано с 1., се задава общата колона 
от таблицата-приемник (в нашия случай от таблицата на cities) – тук изберете CNTRY_NAME. Във 
второто поле се посочва от кой слой е таблицата-източник, от която ще бъде добавяна 
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информацията – посочете слоя country. В третото поле се задава и общата колона от таблицата-
източник – тук също изберете CNTRY_NAME. В полето с настройки Join Options се определя дали 
обединената таблица да съдържа всички редове от двете (Keep all records) или само тези, които 
си съответстват (Keep only matching records) – може да оставите Keep all records. Бутонът Validate 

Join служи за проверка на съответствието на данните от общата колона в двете таблици. 
Потвърдете свързването с ОК.  

 

Разгледайте резултата в таблицата cities. Тук за всеки град беше посочен в коя държава се 
намира. След свързването в реда на всеки град е добавена и информацията за държавата, като 
население (POP2007), площ на държавата (SQKM) и др. По този начин се разширяват възможностите 
за анализ на градовете, като се използва и допълнителната информация за държавата, към която 
принадлежи дадения град. Например, населението на даден град може да се раздели на 
населението на цялата държава, за да се види какъв процент от общото население живее в дадения 
град. 

Свързването може да бъде премахнато чрез менюто Table Options > Joins and Relates > Remove 

Joins (но сега не го правете).  

Освен това, свързването между таблиците има следните особености: 

• Типовете взаимовръзки между записите от двете таблици са едно-към-едно или много-към-
едно. В първия случай на всеки ред от таблицата-източник съответства един ред от таблицата-
приемник, а във втория случай на един ред от таблицата-източник съответстват по един или 
повече реда от таблицата-приемник. Важно: взаимовръзки от типа едно-към-много не се 
поддържат и свързването води до непредсказуеми резултати. 

• Свързването е временен (виртуален) процес, при който информацията във файловете на 
таблиците не се променя. За да бъде запазен резултатът от свързването на таблиците, той 
може да бъде записан (експортиран) в нова таблица. 

Накрая, без да изключвате свързването, запишете проекта (например, с името exercise10) и 
затворете програмата чрез менюто File > Exit. Стартирайте отново програмата ArcMap и заредете 
същия проект. Вижте запомнило ли се е свързването между таблиците? 
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Упражнение 11. Задаване на пространствени заявки (Spatial Queries). 

В предишното упражнение разгледахме няколко основни похвата за запитвания и анализ на 
атрибутивните данни в ГИС. Сега ще демонстрираме два подобни метода за анализ, които, обаче, се 
базират на пространствените взаимоотношения между данните. 

 

Пространствени заявки. 

Пространствените заявки използват функции на подобие, съдържание и пресичане с цел 
привързване на информацията между два слоя. Обекти от един слой могат да бъдат използвани за 
избиране/маркиране на обекти от друг слой.  

Стартирайте програмата ArcMap и от директория \ESRI_Data\europe\basemap\ заредете 
слоевете cities.sdc, mjrrivers.sdc и country.sdc. Подредете и визуализирайте подходящо тези данни 
върху картата. Както виждате, тези слоеве съдържат информация съответно за градовете, големите 
реки и държавите в Европа. Можете да отворите атрибутните таблици на слоевете и да разгледате 
каква информация е привързана към тези географски обекти. Накрая затворете атрибутните таблици 
и увеличете картата в прозореца на изгледа така, че да се вижда по-детайлно някоя част от Европа. 

Сега, нека разгледаме как работят пространствените заявки. Например, нека задачата ни е да 
изберем градовете, които са разположени на разстояние до 1 km от коя да е река. За тази цел, от 
главното меню изберете Selection > Select By Location. Ще се отвори прозореца за пространствени 
заявки, показан на следващата фигура.  

 

В горната част на прозореца, като метод на избиране задайте „избиране на обектите от“ 
(Selection method > select features from). В полето за слой за избиране на обекти (Target layer(s)) 
включете слоя с градовете (cities). Като слой-източник (Source layer), чрез който се задава критерия, 
изберете слоя с главните реки (mjrrivers). По-долу, като метод за пространствено избиране (Spatial 

selection method) посочете „обектите от слоя за избиране са на разстояние (3d) от обектите от слоя-
източник“ (Target layer(s) features are within a distance of (3d) the Source layer features). Най-отдолу, 
чрез бутона за мерните единици изберете километри, а в текстовото поле отпред въведете „1“ и се 
уверете че е включена опцията за прилагане на разстояние за търсене (Apply a search distance). 
Потвърдете така зададените критерии с бутона Apply и всички градове, които са на разстояние до 1 
km от някоя река ще бъдат маркирани на картата. Може да затворите прозореца за пространствени 
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заявки. Отворете атрибутната таблица на градовете и чрез иконата Show selected records покажете 
само маркираните градове, за да видите резултата от направеното пространствено запитване. 

Нека сега маркираме всички градове, намиращи се на разстояние до 10 km от река Дунав. 
Първо затворете атрибутната таблица и изчистете резултатите от предното маркиране, като 
използвате иконата  Clear Selected Features. След това отворете таблицата на реките и изберете 
Table Options > Select by Attributes. В прозореца за атрибутни заявки задайте израза "NAME" = 

'Dunav', за да маркирате река Дунав, потвърдете с Apply и затворете прозореца с Close. Всъщност, 
така маркирахме участъка от териториите на България и Сърбия, защото тук реката се нарича по този 
начин. От таблицата използвайте иконата Zoom to Selected за да видите маркирания участък от реката 
и затворете прозореца на таблицата. След като маркирахме реката, от главното меню изберете 
Selection > Select By Location. В прозореца за пространствени заявки като метод на избиране отново 
задайте select features from. В полето за слой за избиране пак включете градовете (Target layer(s) > 

cities). Като слой-източник (Source layer) нека пак е слоя с главните реки (mjrrivers) и се уверете, че е 
включена опцията Use selected features – така критерия ще се прилага само спрямо маркираната река, 
а не за всички реки. Като метод за пространствено избиране (Spatial selection method) посочете Target 

layer(s) features are within a distance of (3d) the Source layer features. Нагласете мерните единици на 
километри, а в текстовото поле отпред въведете „10“ и се уверете че е включена опцията за 
прилагане на разстояние за търсене (Apply a search distance). Потвърдете така зададените критерии с 
бутона Apply и всички градове, които са на разстояние до 10 km от маркирания участък на река Дунав 
ще се маркират на картата. Може да видите резултата в атрибутната таблица на градовете. 

Сега добавете слоя urban.sdc, който се намира в същата поддиректория и също съдържа 
информация за по-големите градове в Европа, но представени под формата на полигони. Изключете 
визуализацията на предишния слой cities, без да го премахвате от легендата. От слоя mjrrivers отново 
маркирайте участъка на река Дунав, ако междувременно сте я размаркирали и увеличете върху нея с 
бутона Zoom To Selected. Новата задача е да изберем всички градове от слоя urban, през които 
минава река Дунав. от главното меню изберете Selection > Select By Location. В прозореца за 
пространствени заявки като метод на избиране отново задайте select features from. В полето за слой 
за избиране сега включете градовете urban. Като слой-източник (Source layer) нека пак е слоя с 
главните реки (mjrrivers) и се уверете, че е включена опцията Use selected features. Като метод за 
пространствено избиране (Spatial selection method) сега посочете „обектите от слоя за избиране 
пресичат (3d) обектите от слоя-източник“ (Target layer(s) features intersect (3d) the Source layer 

features). Сега не прилагаме разстояние за търсене и опцията за прилагане на разстояние за търсене 
(Apply a search distance) трябва да е изключена. Потвърдете така зададените критерии с бутона Apply 
и всички градове, през които минава маркирания участък на река Дунав ще се маркират на картата. 
Имайте предвид, че така маркирахме градове, които се разполагат и от двете страни на реката, като 
Белград, а не само на единия й бряг, като Русе. Може да видите резултата в атрибутната таблица на 
градовете. Чрез тази задача демонстрирахме още един факт – а именно, че начинът на въвеждане и 
изобразяване на данните в ГИС (в случая разглеждахме едни и същи градове като точки и като 
полигонови обекти) оказва влияние и върху възможните анализи, които можете да приложите върху 
данните. 

Помислете как бихте могли да използвате заявките тип “тема в тема”, когато работите с 
цифрова геоложка карта. Например, бихте могли да маркирате всички разломи, които секат избрано 
интрузивно тяло. Или, ако върху геоложката карта наложите информацията за местоположенията на 
пробите, можете да маркирате всички проби, взети от даден тип скали или намиращи се на дадено 
разстояние от избран водоизточник и т.н. 

 

Пространствено свързване (Spatial Join). 

Подобно на обикновеното свързване на атрибутните таблици, което вече разгледахме, 
пространственото свързване дава възможност за прехвърляне на информацията от една таблица в 
друга. Разликата е, че пространственото свързване се извършва на базата на взаимното 
разположение на обектите от двата слоя. Подобно на атрибутното, пространственото свързване се 
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задава в прозореца за настройки на слоя-приемник (в групата Joins & Relates) или от таблицата (Table 

Options > Joins and Relates > Join).  

Възможните типове пространствено свързвате зависят от типа на свързваните обекти (точки, 
линии или полигони) и се базират на пространствените взаимоотношения между тях, като 
съдържане, пресичане, близост. Например, при свързване между точков и полигонов слой са 
възможни два типа пространствени свързвания: 

Обектите попадат вътре в… (falls inside) – свързва всички обекти от двете таблици. За да се 
използва коректно тази връзка, дадена група от обекти от слоя-приемник трябва да се намира 
напълно в някой обект от втория слой. Например, ако даден парцел (от слой 1) не попада напълно 
в дадена община (от слой 2), то пространственото свързване няма да свърже техните атрибути. 

Обектите са най-близко до… (closest to it) – свързва всички полета, въз основа на най-близкото 
разстояние и добавя поле за разстояния в атрибутната таблица. 

Нека извършим двата типа пространствено свързване, като отново използваме слоевете cities, 
mjrrivers и country от директория \ESRI_Data\europe\basemap\. Отворете прозореца за настройки на 
слоя cities и от групата Joins & Relates в лявото поле (Joins) изберете бутона Add за да добавим 
свързване. В прозореца за свързване (виж долната фигура). От най-горната опция изберете вида на 
свързване да е пространствено (Join data from another layer based on spatial location). После, за слой-
източник посочете country (опция 1.), а за тип на пространственото отношение задайте „обектите 
попадат вътре в…” (falls inside от опция 2). В долната част на прозореца, чрез иконата-папка задайте 
някакво име на файла с резултатите и посочете да се запише в някоя временна или във вашата 
работна директория. Потвърдете с ОК, програмата ще извърши пространственото свързване и новия 
слой с резултатите ще се добави на картата.  

 

Отворете атрибутната таблица на новия слой за да видите резултатите. Чрез пространствения 
анализ програмата е определила за всеки град в коя държава попада и е добавила информацията за 
тази държава към реда на този град.  

Направете още едно свързване в слоя cities, като за слой-източник посочите mjrrivers, а за тип 
на пространственото отношение задайте „най-близко до” (closest to it) и вижте резултата. В новия 
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слой към реда на всеки град е добавена информацията за най-близката река, а в последната колона 
Distance е показано и разстоянието до нея.  

Помислете как бихте могли да използвате пространственото свързване при работа с геоложки 
данни. Например, ако имате полигонов слой, показващ разпространението на различните скали и го 
наложите с точков слой с мрежата на опробване, чрез пространствено свързване можете в таблицата 
с пробите да добавите колона, която показва от какъв тип скала е взета дадената проба. 
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Упражнение 12. Хипервръзки (Hyperlink). 

“Хипервръзките” е една атрактивна функция в ГИС, която работи подобно на Интернет 
страниците. Тя служи за привързване на външна информация, като снимки, текстови документи и 
др., към географските обекти от картата. За целта, освен външните документи, е необходимо в 
атрибутната таблица да присъства колона, съдържаща пътя до документа и неговото име. Освен 
това, в настройките на слоя трябва да се дефинира в коя колона са зададени външните документи 
какъв е техния тип. 

За това упражнение ще използваме данните, намиращи се в директория Hyperlink, която се 
разпространява заедно с това ръководство. Копирайте тази папка заедно с данните във вашата 
работна директория. В папката Hyperlink има два слоя във Shape-формат за ArcGIS, наречени bg-

borders и bg-towns. Първият съдържа държавните граници на България, а вторият съдържа няколко 
по-големи градове – областни центрове. Освен това, в директорията има и сканирани карти (снимки) 
на областите в България, чиито областни центрове са въведени в слоя bg-towns. 

Ако нямате копие от тези примерни данни, можете лесно да си ги създадете. Например, 
можете да заредите познатия ви вече слой country, да маркирате България и да експортирате само 
нея в нов файл. Градовете пък можете да намерите в слоя cities от папката 
\ESRI_Data\europe\basemap\, от където можете да маркирате и експортирате само използваните тук 
градове. Освен това, показаните по-долу фигури изобразяват карти на областите в България, 
използвани в това упражнение. Ако нямате примерните данни, можете да сканирате и използвате 
следващите фигури. 

 

 
Бургас (burgas.gif) 
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Хасково (haskovo.gif) 

 

 
Ловеч (lovech.gif) 
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Монтана (montana.gif) 

 

 
Пловдив (plovdiv.gif) 
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Разград (razgrad.gif) 

 
 

 
София (sofia.gif) 
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Варна (varna.gif) 

 

Задачата ни ще бъде да създадем нов проект, който да съдържа карта с местоположението на 
по-големите градове. Освен това, ще свържем тези градове със сканираните карти на техните 
области така, че като щракнем върху някой град от картата, да се появява картата на неговата област. 

 

Стартирайте програмата ArcMap и заредете слоевете bg-borders и bg-towns. Ще получите една 
опростена карта на България, показваща държавните граници и няколко по-главни града. Понеже 
данните са в географски координати, картата може да ви изглежда „сплескана” в направление север-
юг, но това може да се оправи ако приложим някоя стандартна проекция. Например, от главното 
меню изберете View > Data Frame Properties и в прозореца за настройки на картата, в групата 
Coordinate System задайте Predefined\ Projected Coordinate Systems\ UTM\ WGS 1984\ Northern 

Hemisphere\ WGS 1984 UTM Zone 35N.  

Отворете атрибутната таблица на слоя bg-towns. В нея, освен стандартните полета FID и Shape, 
има и колона с името на всеки град. Сега трябва да създадем нова колона, в която за всеки град да 
укажем къде се намира (пътя) и как се казва картинката, изобразяваща картата на неговата област. 
Най-елегантният начин да направим това е първо да създадем две помощни колони. В едната ще 
въведем пътищата до картинките, а в другата – имената на картинките. След това ще създадем трета 
колона, в която ще обединим информацията от предните две и в нея ще се изпишат точният път и 
име на всяка картинка, съответстваща на дадения град. Ако някой преди вас вече е използвал тези 
данни и е създал и попълнил трите нови колони в таблицата, просто ги изтрийте като щракнете с 
десен бутон върху името им и изберете Delete Field.  

Първо нека създадем необходимите ни колони. В прозореца на таблицата изберете Table 

Options > Add Field, за да добавим нова колона. В новия прозорец кръстете колоната (опцията Name) 
с името PATH. Това трябва да е текстова колона, за това настройте Type на Text. За ширина на 
колоната (Length) задайте по-голямо число, например 80, понеже пътищата понякога може да се 
изписват с много букви. Накрая потвърдете с ОК и новата колона ще се появи в таблицата на bg-

towns. Понеже зададохме голяма дължина за колоната, тя ще изглежда доста широка – можете да я 
свиете като прихванете в горния и край, вдясно от името. Сега да създадем втората помощна 
колонка, съдържаща имената на картинките. Изберете пак Table Options > Add Field. В прозореца за 



 61 

дефиниране на колоната я кръстете (Name), например, с името IMAGE. Настройте Type на Text, а за 
ширина на колоната (Length) можете да зададете по-малко число (20 е предостатъчно), понеже 
имената на картинките в нашия случай са по-къси. Накрая пак с Table Options > Add Field създайте и 
третата колона, като я кръстите Hyperlink, настройте Type на Text и за ширина на колоната (Length) 
задайте 120.  

Следващата стъпка е да попълним трите нови колони. За да го направим, трябва да разрешим 
редактирането на данните – щракнете с десен бутон върху името на слоя в съдържанието и от 
контекстното меню изберете Edit Features > Start Editing. Възможно е да се появи прозорец, 
предупреждаващ че координатната система на данните е различна от тази на картата – затворете го с 
бутона Continue. Нека в колоната колона PATH да въведем пътя до картинките. Щракнете с десен 
бутон над колоната (където е изписано името PATH) и от контекстното меню изберете опцията Field 

Calculator, изобразена с иконка-калкулатор. В бялото текстово поле, разположено в долната част на 
появилия се прозорец Field Calculator напишете пълния път до картинките, като го оградите с 
кавички. Например, ако сте копирали директорията Hyperlink в C:\TEMP\, трябва да напишете 
“C:\TEMP\Hyperlink\”. След като потвърдите с ОК, на всеки ред от колоната PATH трябва да се появи 
указания път, който в случая е един и същ за всички картинки. Не забравяйте, че за да се въведе 
изписания текст (пътя) във всички редове от колоната, трябва предварително да са маркирани всички 
редове или да не е маркиран нито един ред. Иначе, ако предварително сте маркирали един или 
няколко реда, зададеният път ще се изпише само в маркираните редове, а останалите ще останат 
празни. 

После нека в помощната колонка IMAGE попълним имената на картинките. Ще използваме 
факта, че в нашия случай те са кръстени със същите имена, като градовете, изписани в първата 
колона NAME от таблицата. Освен това, картинките са в т.нар. GIF-формат, т.е. имената им 
завършват с разширението “.gif”. Изберете опцията Field Calculator от контекстното меню на 
колоната IMAGE и в бялото текстово поле задайте израза [NAME] + “.gif”. За тази цел щракнете два 
пъти върху [NAME] от списъка с колоните в горната част, изберете бутона „+”, и в долното поле на 
израза дайте празен интервал и допишете “.gif”. С този израз казваме на програмата на всеки ред да 
препише името от първата колонка ([NAME]) и да му добави суфикс “.gif”. Суфиксът трябва да е 
ограден с кавички, понеже е текстови израз. След като потвърдите с ОК, в колоната IMAGE ще се 
попълнят имената на картинките, които в нашия случай, както вече казахме, съответстват на имената 
на градовете и са с разширение .gif.  

Последният етап от подготовката е да попълним третата, окончателна колона, в която да 
комбинираме пътищата и имената на картинките. Пак изберете бутона Field Calculator от 
контекстното меню на тази колона и в бялото текстово поле задайте израза [PATH]+[IMAGE], като от 
списъка с колоните щракнете два пъти върху [PATH], изберете бутона „+” и щракнете два пъти върху 
[IMAGE]. По този начин, в колоната Hyperlink обединихме текстовите изрази от колоните PATH и 
IMAGE. Така например, ако данните ви са в директория C:\TEMP\Hyperlink\, в първия ред на 
таблицата (за град София), в колоната Hyperlink трябва да сте получили израза 
C:\TEMP\Hyperlink\Sofia.gif. 

С това приключихме подготовката на атрибутната таблица за осъществяването на 
хипервръзките. Приключете редактирането на таблицата, като от лентата за редакция отворите 
бутона Editor и от менюто изберете Stop Editing, а когато програмата ви попита да запише ли 
извършените от вас промени (Do you want to save your edits?), непременно потвърдете с Yes. 

Сега се прехвърлете върху картата, като може да затворите прозореца на таблицата. Ще трябва 
да извършим настройките на хипервръзките. Отворете настройките на слоя bg-towns като щракнете 
два пъти върху името му. В прозореца за настройки на слоя изберете групата Display и в средното 
поле Hyperlinks включете хипервръзките чрез опцията Support Hyperlinks using field, а под нея 
посочете колонката Hyperlink, понеже тук попълнихме необходимата информация. Пак в 
настройките Hyperlinks да укажете дали към обектите от картата привързвате документ (Document), 
адрес (URL) или програма (Script). В първия случай, когато щракнете върху обекта от картата 
програмата ще отвори привързания към него документ чрез зададената в операционната система 
подходяща програма. Ако хипервръзката е към адрес (URL), то посочения адрес ще се отваря в 
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браузъра, а ако е към изпълнима програма – ще се стартира програмата (Script). Изберете опцията 
документ (Document) и потвърдете с ОК.  

След като извършихме и тези настройки, хипервръзките вече трябва да работят. От лентите с 

икони изберете курсора за хипервръзки  (Hyperlink), обозначен с иконка-светкавица. Когато с този 
курсор щракнете върху някой от градовете, трябва да се покаже картинка с картата на съответната 
област, заредена в зададената по подразбиране програма.  

По подобен начин, използвайки хипервръзка към адрес (URL), можете към всеки град да 
привържете негова интернет страница, като в колоната от таблицата попълните интернет адреса на 
страницата.  

Вероятно ще ви е приятно да се позабавлявате с атрактивната функция Hyperlink. Накрая 
запишете проекта, например с името “exercise12” и затворете програмата чрез менюто File > Exit. 

Помислете как бихте могли да използвате горещото свързване при вашата работа с геоложки 
данни. Например, при съставяне на цифрова геоложка карта, към всеки тип скали можете да 
привържете макроскопска снимка на типов образец или външен файл с текстово описание на 
скалата. Към точките на опробване можете да привържете снимка на полевото разкритие или 
съответната страница от геоложкия бележник (разбира се, ако е в цифров вид). Към сондажите от 
картата можете да привържете снимки от сондажната ядка и т.н. 
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Упражнение 13. Създаване и редактиране на пространствени данни. 

В това упражнение ще разгледаме как можете да създадете свои собствени данни или да 
редактирате вече въведени данни. В някои от предишните задачи научихте как можете да въвеждате 
основните типове графични елементи, като точки, линии, полигони и др., но тогава обърнахме 
внимание, че те се запомнят като помощни елементи върху картата, а не във вид на данни. Сега ще 
видим как можете да въвеждате информацията като данни, записвани в стандартен за ArcGIS 
формат. 

 

Създаването на нови данни може да се извършва както в средата на програмата ArcMap, така и 
чрез програмата ArcCatalog. Всъщност ArcCatalog (виж долната фигура) представлява помощна 
програма, подобна на Windows Explorer и служи за управление на данните. В лявата част на 
прозореца на ArcCatalog (в полето Catalog Tree) можете да се придвижвате по дървовидната 
структура на папките от вашия компютър. Ако не виждате някой дял или папка от компютъра, можете 
да я добавите чрез иконата  (Connect To Folder). Освен това, в полето Catalog Tree можете да 
задавате връзки към външни бази данни и сървъри, както и да избирате и стартирате модули за 
обработка на данните от богатата колекция Toolbox. Основната част от прозореца има три режима: 
съдържание (Contents), преглед (Preview) и описание (Description). В режим на съдържание се вижда 
списък с файловете от текущата директория, а в другите два режима може да видите как изглеждат 
маркираните данни и тяхното описание, ако са в стандартен ГИС формат.  

 

 

Точкови данни 

Нека първо чрез ArcCatalog създадем нови данни. В дясната част се придвижете и отворете 
временната папка C:\Temp\ или ако имате ваша работна папка – отворете нея. Щракнете с десен 
бутон на празно място в прозореца на съдържанието и от контекстното меню изберете New > 

Shapefile. В новия прозорец, показан на следващата фигура, се указват параметрите на новия файл. За 
име на файла (Name) задайте, например, Point_Shapefile. Тук трябва да определите и какъв тип ще са 
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данните в новия слой: точкови, линейни или полигонови. Вече сме коментирали, че в програмата 
ArcGIS, в един слой могат да се въвеждат данни само от един тип. В някои други ГИС, като MapInfo, 
обаче, е възможно в един слой да се въвеждат данни от различни типове. Нека в началото да 
създадем точкови данни – от Feature Type изберете Point. Тук следва да укажем и координатната 
система, в която ще бъдат въвеждани новите данни – например, чрез бутона Edit отворете прозореца 
за задаване на координатна система и в него чрез Select изберете Geographic Coordinate Systems\ 

World\ WGS_1984.prj и потвърдете с ОК, за да се върнете в прозореца за създаване на нов shape-
файл. Така зададохме параметрите на новия файл, затова изберете ОК и той ще бъде създаден.  

 

Затворете програмата ArcCatalog и стартирайте ArcMap. Заредете точковия слой, който току що 
създадохте. За да можете да въвеждате данни, първо трябва да позволите редактирането на слоя – 
за тази цел, от контекстното меню на слоя изберете Edit Features > Start Editing. В дясната част на 
основния прозорец на програмата ще се появи поле за въвеждане на данни (Create Features, виж 
лявата част на долната фигура), в чиято горна част се изписват достъпните за редакция слоеве, а 
когато от там изберете даден слой, в долната част се показват възможните команди за въвеждане и 
редакция на данните. Освен това, щракайки с десен бутон върху самата карта се отваря контекстно 
меню, в което също има команди за въвеждане на данни (дясната част на долната фигура). 
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Нека за начало въведем няколко точки по предварително зададени координати. Щракнете с 
десен бутон върху картата и от контекстното меню изберете Absolute X, Y. В новото прозорче (на 
долната фигура) можете да въведете координатите, както и от стрелката в десния му край да укажете 
в каква мерна единица или система ще ги въвеждате. Понеже вече зададохме, че данните от 
точковия слой ще бъдат в географска координатна система, изберете координатите да са в десетични 
градуси (Decimal Degrees) и въведете последователно няколко точки със следните двойки 
координати (географска дължина, географска ширина или Long, Lat): 24.5, 43.8; 26.8, 42.4 и 25.2, 44.6. 
След изписването на двойката координати трябва да потвърдите с клавиша Enter, за да се появи тя 
върху картата и после отново да изберете Absolute X, Y за да въведете следващата точка. После 
използвайте иконата Full Extent за да увеличите картата върху въведените точки. Можете да 
въвеждате координатите и във формат на градуси/минути секунди – за тази цел в прозорчето за 
въвеждане на абсолютните координати изберете Degrees Minutes Seconds и въведете точката със 
следните координати: 25°18'10"E, 44°23'30"N. При изписването на координатите не е необходимо да 
въвеждате символите за градуси, минути и секунди, достатъчно е да отделите числата с празен 
интервал и програмата ще се „досети” кои са градусите минутите и секундите. Така че, достатъчно е 
да въведете 25 18 10 E и 44 23 30 N, за да изпишете координатите на гореспоменатата точка. 

 

Можете да въвеждате точките и просто като посочвате местоположението им върху картата. 
Например, уверете се че в дясната горна част (в полето Create Features) е маркиран точковия слой, от 
долната част (Construction Tools) изберете Point и щракнете няколко точки върху картата. Този начин 
е подходящ, например, когато имате някаква друга карта за основа и по нея се ориентирате къде да 
поставите точките.  

Докато въвеждате и редактирате данни е удобно да ползвате лентата с икони Editor и ако тя в 
момента не се вижда – включете я чрез менюто Customize > Toolbars > Editor. Лентата Editor 
съдържа меню и икони за бърз достъп до основните команди за въвеждане и редакция на данни 
(виж долната фигура). Например, ако точка не си е на мястото, можете да изберете курсора за 

редакция  (Edit Tool), да маркирате точката и да я преместите. После в дясната част да изберете 
отново Point (от Construction Tools) и да продължите с въвеждането.  

 

Когато с курсора за редакция  маркирате дадена точка, щраквайки с десен бутон чрез 
нейното контекстно меню можете да я копирате, вмъкнете, изтриете и т.н., а можете да я изтриете и 
чрез клавиша Delete от клавиатурата.  

С курсора за редакция можете също да щракнете два пъти върху дадена точка и да изберете 

иконата  (Sketch Properties), при което вдясно ще се изпишат координатите на дадения обект – от 
там можете да коригирате числата, ако сте сбъркали при въвеждането на координатите.  

Упражнете описаните варианти за въвеждане промяна и триене на точки, като накрая оставете 
само няколко точки в слоя. За да завършите работата по точковия слой, от бутона Editor (от 
едноименната лента) изберете Stop Editing и отговорете с Yes на появилия се въпрос дали искате да 
запишете промените. Така слоя ще стане отново достъпен само за визуализиране и няма да можете 
да променяте данните в него. Друга опция от бутона Editor е Save Edits, която служи за записване на 
данните. С нея можете от време на време да записвате ново въведените данни и извършените 
промени, без да спирате редактирането на слоя. Имайте предвид, че всички ново въведени данни и 
промени се помнят временно в паметта на компютъра и се записват за постоянно, само когато 
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изберете Save Edits или приключите редактирането със Stop Editing и потвърдите записването с Yes. 
Ако не записвате данните си от време на време и спре тока, информацията която сте въвели ще бъде 
безвъзвратно загубена. 

 

Линейни данни 

След като приключите въвеждането и редакцията на точковата тема, нека да създадем и 
линеен слой. Можете да изключите визуализирането на точковия слой, за да не ви пречи. За да 
създадете нов файл докато работите с ArcMap, трябва да използвате функцията „каталог”. За да я 
стартирате, от главното меню изберете Windows > Catalog или щракнете върху опцията Catalog от 
десния край на главния прозорец на програмата. Вдясно ще се отвори поле (прозорец), в което, 
подобно на помощната програма ArcCatalog, можете да оперирате с папките и файловете от вашия 
компютър. По дървовидната структура на директориите се придвижете до временната или вашата 
работна папка (където записахме предишния файл с точковите данни) и щракнете с десен бутон 
върху тази папка. От контекстното меню изберете New > Shapefile. Подобно на точковите данни, в 
появилия се прозорец кръстете новия файл Line_Shapefile, за тип на обектите (Feature Type) изберете 
Polyline и задайте отново географска координатна система (Geographic Coordinate Systems\ World\ 

WGS_1984.prj). Накрая потвърдете с ОК, и създадения линеен shape-файл автоматично ще се зареди 
и появи в списъка на съдържанието.  

За да стартирате въвеждането на линейните данни, може по познатия ви вече начин да 
използвате контекстното меню на слоя или можете от бутона Editor да изберете Start Editing. Понеже 
допреди малко редактирахме точковите данни, възможно е линейния слой да не се вижда в дясното 
поле за редакция (Create Features). Най-лесният и бърз начин да включите и него в списъка на 
достъпните за редактиране слоеве е първо чрез Editor > Stop Editing да спрете редакцията и после 
пак да я стартирате чрез Editor > Start Editing. 

Както виждате, в полето Construction Tools можете да избирате и изчертавате линя, 
правоъгълник, кръг, елипса и свободна линия. Понеже слоя е линеен, а вече казахме, че програмата 
не позволява смесването на точки, линии и полигони в един слой, то тук правоъгълниците, кръговете 
и елипсите ще бъдат възприемани не като площни обекти, а само като линейни контури на фигурите.  

В дясното поле Construction Tools изберете линия. Изчертаването на права линия, състояща се 
от един сегмент става като щракнете веднъж с мишката в началната точка, преместите курсора и 
щракнете два пъти във втората крайна точка на правата. Изчертаването на полилинии (линии с 
няколко сегмента) става като щракнете веднъж в началната точка, после щракате по един път на 
всяка следваща точка (така добавяте новите сегменти) и накрая трябва да щракнете два пъти в 
крайната точка на полилинията. Начертайте няколко прави линии и няколко полилинии. Изпробвайте 
изчертаването и на другите видове обекти – правоъгълник, кръг и т.н. 

После включете курсора за редакция , маркирайте и преместете няколко линии. Ако 
щракнете два пъти върху дадена линия, ще се покажат нейните съставни сегменти, при което можете 
да местите отделните отделните точки, както и да добавяте и триете вертекси. Накрая изтрийте 
някои линии като ги маркирате и използвате клавиша Delete. 

 

В процеса на изчертаване на линейните обекти също можете да щракнете с десен бутон и да 
използвате полезните функции от контекстното меню (виж следващата фигура). Например, преди да 
щракнете новата точка от линията, можете директно да и въведете координатите (Absolute X, Y), да я 
поставите по зададено направление (Direction), изкривяване (Deflection) или дължина (Length), да 
направите изчертавания сегмент успореден (Parallel) или перпендикулярен на друг сегмент 
(Perpendicular) и други. Пак от това контекстно меню, чрез Finish Sketch можете да завършите 
създаването на линията, а чрез Finish Part ще завършите текущата част. Последното се използва 
когато обекта ви се състои от няколко графични елемента, например – територията на държава с 
няколко острова – всеки остров е представен от отделен графичен обект, но те са неделими части от 
площта на държавата.  
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Освен това, докато чертаете линиите, курсора ви ще бъде съпровождан от плаваща лента с 
икони, показана на долната фигура, чрез която можете да превключвате в режими за изчертаване на 
дъга, трасиране, намиране на средна точка или пресечница на съществуващи сегменти и др., които са 
достъпни и от лентата с икони за чертане и редакция Editor.  

 

След като начертаете дадена полилиния, можете да я промените, като използвате иконите от 

лентата Editor . Чрез тези икони можете да местите отделните точки (Edit Vertices), да 
променяте формата като изрязвате част от полилинията (Reshape Feature Tool), да я разделяте на две 
линии в посочена точка (Split Tool) и да я завъртате (Rotate Tool).  

 

Изпробвайте различните възможности за чертане и редакция на линейни обекти. Ще се 
убедите, че те са многобройни, което прави програмата пълноценен чертожен софтуер. Накрая 
оставете 5-6 линии (ако сте начертали повече, изтрийте другите) и приключете редактирането на 
линейния слой чрез Editor > Stop Editing, като потвърдите с Yes да запишете промените. 

 

Полигонови данни 

Сега нека създадем и полигонов слой. Изключете визуализирането и на линейния слой. 
Отворете пак прозореца Catalog (менюто Windows > Catalog), придвижете се до папката, в която 
записахте точковите и линейните данни и от контекстното меню изберете New > Shapefile. Кръстете 
новия слой, например, с името Polygon_Shapefile, за Feature type задайте Polygon и пак му задайте 
географска координатна система WGS 1984.prj. Новият файл ще се добави в списъка на 
съдържанието на картата. Включете редакцията на данните (Editor > Start Editing) и пак използвайте 

иконата  (Organize Templates), опцията New Template, включете полигоновия слой и потвърдете с 
Finish и Close, за да го добавите в списъка на дясното поле за редакция (Create Features). Сега, като 
маркирате полигоновия слой в дясното поле за редакция (виж следващата фигура), в долната част ще 
можете да избирате да чертаете полигон (Polygon), правоъгълник (Rectangle), кръг (Circle), елипса 
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(Ellipse), полигон чрез свободно чертане (Freehand) и полигон чрез допълване към съществуваща 
фигура (Auto Complete Polygon).  

 

Когато чертаете полигон, всяко щракване в нова точка добавя сегмент към контура на 
полигона, а за да го завършите, трябва да щракнете два пъти в последната точка и тя автоматично ще 
се свърже с първата. Функцията за автоматично допълване (Auto Complete Polygon) ни позволява да 
долепим нов полигон към вече съществуващ и да не повтаряме изчертаването на общата им граница. 
За целта начертайте един полигон, после вътре в него щракнете първата точка от новия полигон, 
сложете следващите точки извън стария полигон, а последната точка от новия щракнете пак вътре в 
стария полигон.  

Начертайте по няколко фигури от различните видове, за да видите как работи програмата. 
Обърнете внимание, че когато чертаете някоя фигура, в долния ляв край се изписва различна 
информация, като дължината, и направлението на последния сегмент, периметъра на полигона, 
общата дължина на сегментите, площ и радиус на окръжността и т.н., като вида на информацията 
зависи от изчертаваната фигура. Тези мерки се изписват в такива мерни единици, каквито са 
зададени в настройките на картата (View > Data Frame Properties > General > Display Units). Както 
вече казахме, текущите координати на курсора пък се изписват в долния десен край на прозореца на 
програмата. Показването на тази информация е много полезно, когато трябва да въвеждате фигури 
по зададени размери и местоположение. Също така, по време на изчертаването, преди щракването в 
следваща точка може да отворите контекстното меню (чрез щракване с десен бутон върху картата), в 
което има богат набор от чертожни функции, като ръчно въвеждане на координатите на следващата 
точка (Absolute X, Y) или отместването спрямо предната (Delta X, Y), задаване на посока (Direction) 
или дължина (Length) на следващия сегмент, чертане успоредно (Parallel) или перпендикулярно на 
избран сегмент (Perpendicular) и др.  

След като начертаете по няколко полигонови фигури от различните видове и изпробвате 

функциите за чертане, включете курсора за редакция  и преместете няколко от тях, а после 
изтрийте някои като ги маркирате и използвате клавиша Delete. 

Обикновено, когато създавате полигонов слой от дадена карта, е необходимо съседните 
полигони да имат една и съща (обща) граница. Например, когато върху геоложка карта изчертавате 
две съседни тела, представящи разпространението на два различни скални типа, трябва границата на 
контакта между двете скали да бъде една и съща (еднаква) граница както за единия така и за другия 
полигон. Не трябва при изчертаването на съседните скални тела да остане празно място между тях 
или те да се припокриват. Подобен е случаят, когато изчертавате парцели в някой район. Границата 
между два съседни парцела е линия, която трябва да е една и съща в двата съседни полигона, 
описващи парцелите. За да се осигури еднаквостта на границите в съседните полигони, или иначе 
казано за да получим точно прилепване между тях, в програмата са добавени функциите за срязване 
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или добавяне на полигони. Както вече видяхме, функцията за добавяне (Auto Complete Polygon) е 
достъпна от списъка с възможните фигури за чертане в дясното поле за редакция. 

Функцията за срязване е достъпна чрез иконата  (Cut Polygons Tool) и работи аналогично на 
изрязването с ножица на фигурки от лист хартия. Когато я използвате, първо трябва да начертаете 
един по-голям полигон, който да включва в себе си всички полигони, които искате да начертаете. 
После, от големия полигон, с функцията за срязване “изрязвате” по границите между съседните по-
малки полигони и по този начин разделяте големия полигон на по-малки части и обособявате 
отделните полигони. Подобно на работата с ножица, изрязването трябва да започне и завърши извън 
изрязваната граница. Функцията за добавяне работи обратно на срязването. При нея, след като е 
начертан един от полигоните, всеки следващ съседен полигон се добавя (прилепва) към предишния. 

Нека упражним функцията за срязване на полигони. Изтрийте всички начертани до сега 
полигони, да не ви пречат и начертайте правоъгълник, удължен в хоризонтално направление. 
Задачата ни е да го разделим на два съседни, допиращи се правоъгълника – ляв и десен. Изберете 
иконата за срязване  (Cut Polygons Tool) и начертайте вертикална права линия, която да минава 
приблизително през средата на правоъгълника. Внимавайте – първата и последната точки на линията 
трябва да са извън правоъгълника. Например, след като изберете бутона за срязване, щракнете 
веднъж над правоъгълника – близо до средата на горната му страна и близо, но извън 
правоъгълника. После, за да укажете втората (последна) точка на правата за срязване, щракнете два 
пъти под правоъгълника – пак близо до средата на долната му страна и близо, но извън 
правоъгълника. В резултат ще получите два съседни, долепени един до друг правоъгълника. Можете 
да се уверите в това, като с курсора за избиране маркирате поотделно левия или десния 
правоъгълник. 

Сега, нека с хоризонтална линия разделим десния правоъгълник на два по-малки (горен и 
долен), като запазим левия правоъгълник непроменен. Изберете отново бутона за срязване на 
полигони и начертайте хоризонтална права линия, която да минава горе-долу през средата на десния 
правоъгълник. Внимавайте: ако изчертавате линията от ляво на дясно, първата точка трябва да е 
близо до средата на лявата страна на десния правоъгълник и извън него, т.е. лявата точка ще попада 
вътре в левия правоъгълник, а дясната (последна) точка трябва да попада вдясно, извън десния 
правоъгълник. Иначе казано, начертаната хоризонтална права линия трябва изцяло да пресича 
десния правоъгълник, но не трябва изцяло да пресича левия. Част от срязващата права ще попадне в 
левия правоъгълник, но за да го запазим, не трябва срязващата права изцяло да пресича левия 
правоъгълник. 

Обърнете внимание, че за да срежете някой полигон, той трябва да е маркиран. 

За да се упражните, разделете правоъгълниците на още по-малки части. От някой 
правоъгълник изрежете триъгълно парче. Освен това, срежете някоя фигура като използвате не 
права, а полилиния, като първата и последната точка на полилинията трябва да са извън срязваната 
фигура, а останалите точки трябва да са вътре в срязваната фигура. 

Сега нека упражним функцията по добавяне на полигони. Отново изтрийте всички начертани 

до сега полигони. Изберете функцията за изчертаване на полигони  Polygon и в единия край на 

картата начертайте някакъв полигон. После изберете функцията за добавяне на полигони  Auto 

Complete Polygon. Ще искаме да добавим нов, съседен полигон. За тази цел, начертайте полилиния, 
като първата точка щракнете вътре в предишния полигон, следващите точки разположете извън 
съществуващия полигон, а за последна точка щракнете два пъти пак вътре в съществуващия полигон, 
но на различно място от първата точка. В резултат ще се добави нов полигон, който е “прилепен” към 
предишния, като общата им граница попада между първия и последния сегмент на начертаната 
полилиния. Ще добавим и трети полигон, който да има обща граница и с двата предишни полигона. 
Начертайте полилиния, като първата точка разположите в единия полигон, следващите точки 
разположете в празното пространство, а последната точка щракнете в рамките на втория полигон. По 
аналогичен начин добавете още няколко полигона. 
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Изтрийте всички полигони и начертайте неголям правоъгълник със сравнително квадратна 
форма. Сега използвайте функцията за добавяне на полигони и се опитайте да добавите нов 
правоъгълник със същите размери, разположен вдясно и прилепен към първия правоъгълник. Ако 
резултатът не ви харесва, изтрийте втория правоъгълник и опитайте отново. Помислете и преценете: 
ако искате да начертаете два съседни правоъгълника със сравнително еднакви размери, кой начин е 
по-лесен – дали да ги получите чрез срязване на един по-голям правоъгълник или чрез добавяне? В 
практиката, когато изчертавате дадена карта, винаги трябва да съобразявате кой е най-лесният начин 
да постигнете желания резултат, като не правите компромиси с прецизността на изчертаваните 
обекти. 

Следващата ни стъпка е да се запознаем с възможностите за редакция на вече въведените 
графични обекти. Всъщност, докато въвеждахте обектите в точковия, линейния и полигоновия слой, 
разгледахме как можете да извършите най-простите операции за редакция: маркиране, преместване 
и изтриване на даден обект. Често, обаче, се налага да променим формата на даден обект, като 

поотделно разместваме съставящите го точки. За тази цел служи функцията  Edit Vertices от 
лентата за редакция. 

Временно оставете изключено визуализирането на точковия и линейния слой. Уверете се, че 
полигоновия слой е в режим на редакция и от него изтрийте всички начертани до сега обекти. 
Начертайте нов по-голям правоъгълник, удължен в хоризонтално направление. След това 
използвайте функцията за срязване и срежете правоъгълника вертикално през средата, като 
използвате не права, а полилиния с няколко зигзага. В резултат следва да получите две фигури – лява 
и дясна, които приличат на правоъгълници с по една зигзагообразна страна. Маркирайте само левия 

полигон и изберете бутона функцията  Edit Vertices. Ще видите, че точките, които го дефинират, се 
показват с малки квадратчета. Когато посочите дадена точка, курсора приема по-специфична форма, 
като квадратче с прилепени триъгълничета от четирите му страни. Сега можете да промените 
формата на левия полигон, като прихващате отделните точки и ги премествате на желаното 
място.Можете да прихванете и отделен сегмент от полигона и да го преместите. Освен това, върху 
картата се показва и контекстна лента с икони (виж долната фигура), където чрез първите три бутона 
може да превключвате съответно между режимите на местене, добавяне и триене на точка от 
полигона. Опитайте да преместите някои точки и сегменти, да добавите и да изтриете точки от 
полигона. Предпоследният бутон (Finish Sketch) служи за приключване на редакцията, а последния 
(Sketch Properties) отваря вдясно прозорец с координатите на всеки вертекс, където при нужда може 
да въведете точните координати на точката.  

 

Обърнете внимание, че когато местите точки от границата между двата полигона, промяната се 
прилага само за контура на редактирания полигон, докато границата на другия полигон остава 
непроменена. Така, когато премествате някоя гранична точка от левия полигон на ляво, между двата 
полигона остава празно място, а ако преместите граничната точка вдясно, левия полигон ще 
припокрие част от десния. Можете да щракнете вътре в десния полигон и по аналогичен начин да 
промените и неговата форма, като размествате съставящите го точки. Освен това, можете да 
изтриете дадена точка и като я посочите с курсора, щракнете десния бутон и от контекстното меню 
изберете Delete Vertex. По този начин ще опростите фигурата. Също така, когато е необходимо да 
нагласите полигона по-прецизно, можете да добавите нова точка като посочите върху някой сегмент 
между две точки, щракнете десния бутон и от контекстното меню изберете Insert Vertex. След това, 
ако е необходимо, можете да преместите новата точка на желаното място. Докато променяте 
формата на дадена фигура, ако промяната не ви удовлетворява можете да отмените последното 

действие или да го направите отново, като използвате иконите  Undo и Redo. 

В предният абзац видяхте как промяната на границата между двата полигона се отнасяше само 
за маркирания полигон, а контура на другия оставаше непроменен. Обикновено се налага, обаче, 
границите да се променят така, че полигоните да остават долепени. Това се осигурява чрез функцията 
за привързване към съседните обекти (Snapping), която ще разгледаме малко по-долу.  
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По аналогичен начин можете да промените формата и на линейните обекти, като премествате, 
добавяте или триете отделните точки (вертекси), дефиниращи сегментите на линиите. Включете 
визуализирането на линейния слой и упражнете тези действия върху начертаните линии. 

 

Други, много полезни възможности са интерактивното движение (Pan), увеличаване и 
намаляване (Zoom In, Zoom Out) по време на чертането. Представете си че трябва да начертаете 
голяма фигура, със сложна форма. Ако настроите мащаба на картата така, че в нея да се побира 
цялата фигура, ще бъде много трудно да начертаете прецизно детайлите от контура на фигурата. От 
друга страна, ако увеличите картата така, че достатъчно детайлно да виждате част от фигурата, ще ви 
е трудно да чертаете или редактирате другите части, които не се виждат понеже се намират извън 
прозореца на програмата. За да се избегне този проблем и да се улесни чертането, можете да 
използвате интерактивните функции за придвижване, увеличаване и намаляване. Нека, например, 
начертаем дълга линия. Първо се уверете, че линейният слой е включен и сте в режим на редакция. 
После, например, от ляво на дясно започнете да чертаете полилиния. Когато стигнете приблизително 
до десния край на прозореца на картата не приключвайте линията с двойно прищракване, а 
натиснете и задръжте средния бутон (scroll) на мишката. Така ще прихванете картата и сега можете 
да я преместите вляво и да продължите чертането на полилинията на дясно. По този начин, докато 
чертаете можете да се премествате в тези участъци от картата, където искате да продължите 
чертането или редакцията. Също така, докато чертаете можете да завъртите средния бутон (scroll) на 
мишката, при което ще увеличите или ще намалите мащаба на картата. Така, по време на чертането 
можете да увеличавате в някои части на картата, където трябва да начертаете някакви по-сложни 
детайли, а после да се връщате в по-общ план за да виждате по-голяма площ от картата. Упражнете 
функциите за интерактивното движение, увеличаване и намаляване докато изчертавате нови 
полилинии. Вероятно ще се убедите, че комбинираното използване на трите интерактивни функции 
много улеснява изчертаването на сложни фигури. 

Вече обърнахме внимание, че по време на чертане в близост до курсора се появява плаваща 

лента с икони за достъп до полезни функции. Последната икона от лентата  (Undo Add Vertex) 
премахва последната поставена точка. Така, ако докато чертаете поставите новата точка на 
неправилно място, няма да можете веднага да я преместите, но чрез тази функция можете да я 
премахнете и да я поставите наново. Ако изберете тази функция няколко пъти последователно, ще 
премахнете последните няколко точки, след което можете наново да ги въведете на желаните места. 
По този начин лесно можете да поправяте фигурата, преди още да сте завършили нейното 
изчертаване.  

От главното меню Edit са достъпни още няколко популярни функции, използвани при 
редакцията на данните. Функцията за изрязване Cut премахва маркираните обекти, като ги запомня 
временно в паметта на компютъра. Чрез Copy маркираните обекти се копират в паметта на 
компютъра, без да се изтриват. Чрез Paste запомнените обекти се вмъкват в редактирания слой. Тези 
три функции са удобни за преместване или копиране на обекти в даден слой или от един слой в друг. 
Опцията Delete изтрива маркираните обекти, без временно да ги запомня. Тези функции са 
стандартни и работят по аналогичен начин, както в другите компютърни програми. Можете да 
упражните тяхното действие в работните слоеве, които създадохте. Все пак, съобразявайте се, че не 
можете да прехвърляте обекти между разнотипни слоеве, например, да копирате точков обект и да 
го вмъкнете в линеен или полигонов слой. 

 

Привързване (Snapping) 

Вече казахме, че при изчертаването често се налага да прилепвате обектите така, че те да имат 
общи точки или общи граници. Видяхме как функциите за срязване и добавяне на полигони спомагат 
за прецизното създаване на общи граници между съседните полигони, за да не се получават 
нежелани дефекти, като припокриване или празнини между съседните обекти. В програмата ArcMap 
има и една друга функция, наречена “привързване” (Snapping), която също служи за прилепване на 
новоизчертаваните обекти към вече съществуващи обекти. Сигурно вече ви е направило 
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впечатление, че докато чертаете нов обект, ако курсора попадне върху вече съществуваща линия или 
контур на полигон се появява квадратче с надпис, че това е точка (Vertex) или линия (Edge) от 
съществуващия обект. За ориентация надписът показва и името на слоя към който принадлежи 
съществуващия обект. Този начин на обозначаване на точки и контури от обектите е част именно от 
функцията за привързване. Освен това, за да се различават по-ясно, точките от съществуващите 
обекти се обозначават с по-големи квадратчета, контурните линии – с по-малки квадратчета с 
диагонална линия, единичните точки (Point) – с кръгчета, а крайните точки (Endpoint) – с квадратче 
със знак „плюс”. Така, докато чертаете нов обект, ако с курсора посочите точка от друг обект и тя се 
изобрази с квадратче, то ако щракнете на това място, точката от новия обект ще се привърже към 
посочената точка от съществуващия обект. Иначе казано, новата точка ще има същите координати 
като посочената точка. Ако докато чертаете посочите сегмент от линия или полигон и посоченото 
място се обозначи с квадратче с диагонална черта, то при щракване на това място новата точка от 
изчертавания обект ще се постави точно върху линията на сегмента. Така функцията Snapping ни 
позволява да долепяме новите към вече начертани обекти, при което да се избегнат нежелани 
ефекти на разстояния или припокривания между съседните обекти. Всъщност, привързването е 
важно свойство при чертането и присъства под една или друга форма в почти всички чертожни 
програми. 

Нека упражним действията по привързване, като използваме вече създадения полигонов слой. 
За да ви е по удобно, временно изключете визуализирането на точковия и линейния слоеве. Уверете 
се, че полигоновия слой е включен за редакция и изтрийте всички обекти в него. В единия край на 
картата начертайте някакъв полигон, съставен от няколко сегмента. После начертайте нов полигон, 
като от начало щракнете първата точка някъде встрани от първия полигон. Преместете курсора и 
върху някой от най-близките върхове на съществуващия полигон, така че да се маркира с квадратче 
(Vertex) и там щракнете втората точка, за да я привържете към този връх. Привържете и следващите 
няколко точки от новия полигон към следващите съседни точки от стария, така че да повторите (да 
привържете към) част от контура на първия полигон. За да стане прецизно привързването на новия 
към първия полигон, внимавайте да не пропуснете някоя от последователните точки от контура на 
първия и привързвайте само към вертекси. Накрая щракнете още няколко точки встрани от първия 
полигон, за да завършим изчертаването на новия. В резултат би трябвало да получите два съседни 
полигона долепени един до друг, като по общата им граница да няма празни разстояния или 
припокриване. Когато привързвате към съществуваща фигура, привързвайте само към точките, които 
я описват, без да привързвате в междинни точки към линиите на контура (Edge), понеже това само 
ще утежни новата фигура, без да я направи по-прецизна. Използвайте привързване към линия (Edge) 
само ако се налага да привържете към място от контура, в което не е описано с точка в предната 
фигура.  

Настройките на функцията за привързване са достъпни от лентата за чертане чрез бутона Editor 

> Snapping. От тук включете помощната лента Snapping Toolbar, показана на следващата фигура. От 
тази лента, чрез четирите икони можете да включвате и изключвате привързването съответно към 
точка (от точков слой), крайна точка, вертекс и линия. Освен това, от менюто на бутона Snapping 
можете да включвате и изключвате като цяло привързването (Use Snapping), както и да включите 
допълнителни възможности за привързване към точка на пресичане (Intersection Snapping), към 
средна точка (Midpoint Snapping) и по тангента (Tangent Snapping). Чрез Options се настройва 
толеранса на привързване и как да се изобразява привързването – цвят, текст и т.н.  
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Упражнете привързването, като начертаете още няколко съседни полигона, прилепени към 
предишните. После включете визуализирането на точковия и линейния слой и привържете нови 
полигони както към предишните, така и към линии и точки от другите слоеве. Начертайте и линии, 
привързани към други обекти. Изпробвайте и привързването към пресечна точка, среда на сегмент и 
по тангента. Сигурно сте се досетили, че привързването по тангента е достъпно, когато привързвате 
към окръжност или елипса.  

Друга възможност за привързване към съществуващи обекти се предоставя от функцията за 

трасиране  Trace. Чрез нея, по време на чертане може да проследявате части от контурите на 
другите обекти и така новия обект ще граничи с тях по трасираните участъци. За да упражним тази 
функция, изтрийте обектите от полигоновия слой, за да не ви пречат, и в единия край на картата 
начертайте един начупен полигон. После ще начертаем нов полигон, който ще привържем към 
първия чрез трасиране. Започнете новия полигон като щракнете първата му точка някъде встрани от 
първия. После от плаващата лента за чертане (виж долната фигура) изберете иконата за трасиране 

 и щракнете втората точка като я привържете към някоя близка точка от първия полигон. Това ще 
бъде началната точка за трасиране. Ще се включи функцията за трасиране и сега придвижете курсора 
на мишката по контура на първия полигон, без да щракате нови точки. При движението на курсора 
програмата автоматично ще проследи контура на предишния полигон. След като проследите няколко 
сегмента от контура на първия полигон, щракнете новата точка като пак я привържете към 
съответната точка от първия полигон – това ще бъде крайната точка на трасиране.В резултат част от 
границата на новия полигон ще съвпадне с трасираната част от контура на предишния. Сега от 
плаващата лента за чертане изберете първата икона за чертане на сегменти  и довършете новия 
полигон като по познатия ви вече начин добавите още няколко точки встрани от първия. Упражнете 
трасирането като изчертаете още един полигон, който привържете към предишните два чрез 
трасиране на контурите им. Можете да трасирате и по границите линии и полигони от други слоеве. 
Освен това, ако трасирате по границите на допиращи или пресичащи се обекти, в точката на 
допир/пресичане можете да поведете курсора в желаната посока и продължите или пак по 
границата на трасирания обект или да продължите по границата на другия обект. Упражнете 
трасирането като изчертаете още няколко полигона и ги привържете към съществуващите полигони и 
линии. 

 

Функцията за трасиране Trace е достъпна както от плаващата лента, така и от лентата за 
чертане Editor. Освен Trace, в менюто на тази икона има още няколко полезни функции за чертане, 
като чертане под прав ъгъл, привързване към среда на отсечка, към точка, намираща се на зададени 
разстояния от други обекти или по направление и разстояние от други обекти, към точка на 
пресичане на две линии и др. (виж горната фигура). Изпробвайте ги за да разберете как работят.  

 

Обединяване и сечение на обекти 

Следващата ни стъпка е да разгледаме някои по-специфични операции с графични обекти, 
които често се използват в ГИС. Това са операциите за обединяване и сечение на обектите. Тук ще 
упражним действието на тези функции върху два обекта, като по аналогичен начин те могат да се 
прилагат и върху по-голям брой обекти. За целта, първо изключете визуализирането на всички 
слоеве, без полигоновия и изтрийте всички обекти от полигоновия слой. В лявата част на картата 
начертайте един по-голям правоъгълник, удължен в хоризонтално направление. След това, вдясно, 
до правоъгълника начертайте кръг, така че част от кръга да припокрива част от правоъгълника. Така 
получихте два обекта, които се припокриват частично. Изберете курсора за редакция  и щракнете 
върху лявата част на правоъгълника – ще видите че той се маркира. После щракнете в дясната част на 
кръга. Последният ще се маркира, а правоъгълника ще се размаркира. Накрая щракнете пак в кръга, 
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но в тази област, където кръга припокрива правоъгълника. В резултат ще се маркира едната фигура, 
но ще се види и областта на припокриване и ще се появи контекстна икона, чрез която може да 
превключвате коя от двете фигури да е маркирана. 

Докато демонстрираме споменатите операции с графични обекти, ще видим как те се 
отразяват и на атрибутните данни. Отворете атрибутната таблица на полигоновия слой и в колоната 
Id задайте различни стойности, например, за правоъгълника въведете 1, а за окръжността въведете 
2. Променете размерите на прозореца с таблицата и го преместете така, че да виждате 
едновременно картата и таблицата. 

Маркирайте окръжността. После от лентата за редакция изберете Editor > Clip за да стартирате 
функцията за изрязване на графични обекти. Чрез нея немаркирания обект се изрязва по контура на 
маркирания. В появилия се прозорец се задават параметрите на изрязване (виж следващата фигура). 
С опцията Buffer Distance се определя разстоянието на изрязване – при стойност нула немаркирания 
обект се изрязва точно по контура на маркирания, а при по-голяма стойност се изрязва на 
зададеното разстояние. Чрез другата опция се определя дали от изрязвания обект да се запази 
площта на пресичане (Preserve the area that intersect) или да се запази останалата част (Discard the 

area that intersect).  

 

Оставете нула за Buffer Distance, включете Discard the area that intersect и потвърдете с ОК. В 
резултат от правоъгълника ще се изреже тази част, която е покрита от кръга. Можете да се уверите в 

това, като маркирате правоъгълника. Използвайте иконата  Undo за да върнете целостта на 
правоъгълника в предишното положение преди изрязването. Маркирайте кръга и пак изберете 
Editor > Clip за да стартирате изрязването, като този път включете Preserve the area that intersect – в 
резултат правоъгълника ще бъде изрязан така, че ще се запази само участъка, покрит от кръга. После 

пак използвайте  Undo за да върнете целостта на правоъгълника. Сега маркирайте пак кръга, и пак 
изрежете, като за Buffer Distance задайте например 3 и включете Discard the area that intersect – този 
път правоъгълника ще се изреже на разстояние 3 от контура на кръга, като зададеното разстояние е в 
мерните единици на картата.  

 

Нека разгледаме и функциите за обединяване на обектите. Пак използвайте  Undo за да 
върнете целостта на правоъгълника. Маркирайте и двете фигури като с курсора  начертайте 
правоъгълник, който да ги обхване или пресече. След като и двете фигури са маркирани, изберете 
Editor > Merge за да обедините двете фигури. Ще се появи прозорец, в който трябва да укажете към 
коя фигура да се добавят останалите (виж долната фигура). Изберете, например, първата (това беше 
правоъгълника) и потвърдете с ОК. В резултат двете фигури ще се обединят в една, която ще получи 
атрибутите на правоъгълника, както можете да видите в атрибутната таблица.  
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После пак използвайте  Undo за да върнете предишната цялост на правоъгълника и кръга. 
Маркирайте пак двете фигури и изберете Editor > Union за да стартирате другия вариант на 
функцията за обединяване. Ще се появи прозорец, в който се посочва в кой слой да се запише 
обединената фигура (виж долната фигура). В случая можете да изберете само полигоновия слой и 
потвърдете с ОК. В резултат ще се получи нова фигура, която представлява обединение от 
правоъгълника и полигона, като предишните фигури се запазват на картата. Както се вижда от 
таблицата, новата фигура е и с различни атрибути от предишните.  

 

По аналогичен начин чрез функциите Union и Merge можете да обедините и обекти, които не се 
допират или припокриват, а са на разстояние един от друг. В резултат се получава комплексен обект, 
съставен от няколко части. Така, например, можете да обедините няколко острова в една държава 
или няколко разкриващи се апофизи в един интрузив. Упражнете това, като раздалечите 
правоъгълника и кръга и приложите последователно функциите Union и Merge, за да видите 
резултатите. 

Друг често срещан случай в практиката е когато някой обект попада изцяло в рамките на друг 
по-голям обект, при което от по-големия трябва да се изключи площта на по-малкия. Това също става 
с функцията за изрязване. В полигоновия слой изтрийте фигурите, с които се упражнявахме и 
начертайте един по-голям полигон. После начертайте и един по-малък полигон, който изцяло да 
попада вътре в по-големия. Маркирайте по-малкия полигон и стартирайте функцията за изрязване 
Editor > Clip. Задайте нула за Buffer Distance, включете Discard the area that intersect и потвърдете с 
ОК. В резултат площта на припокриване ще се изреже от по-големия полигон. За да се убедите, 
можете да хванете и преместите по-малкия полигон, но за да го върнете обратно точно на мястото 

му използвайте  Undo.  

Разгледаните функции за операции с обекти са много полезни и често употребявани при 
редакцията на данните в ГИС. Например, в ГИС можете да имате карта на парцелите в даден район. 
След време може да се наложи през някои парцели да се прекара нов път. Естествено, след 
изчертаването на пътя, неговата площ трябва да бъде изключена от площите на парцелите, през 
които минава, а вероятно и да ги раздели на по-малки парцели. В друг случай, в геоложка карта 
може да сте начертали, например, няколко седиментни пласта. После може да установите, че част 
или всички пластове са пресечени от някакво интрузивно тяло. За да го нанесете, можете да го 
начертаете върху седиментните пластове и после да изрежете неговата площ от пластовете. В трети 
случай може да ви се наложи да обедините няколко тела в едно. Например, искате да обедините 
няколко съседни пласта в една пачка, за да опростите картата. Както виждате, съществуват най-
различни ситуации, в които описаните четири функции за редакция на обектите биха ви били 
полезни. Иначе щеше да се наложи да изтриете старите обекти и да начертаете отново актуалната 
ситуация. 

 

Въвеждане на атрибутна информация 

Въвеждането на атрибутната информация за обектите може да става както паралелно с тяхното 
изчертаване, така и накрая, след като начертаете няколко или всички обекти. За да въвеждате 

атрибутите непосредствено след изчертаването на всеки обект може да използвате иконата  
Attributes от лентата за чертане. Чрез нея в дясната част ще се отвори поле, показващо атрибутите на 
маркирания обект. Изберете я за да включите полето Attributes. В долната част на полето се 
прехвърлете на Create Feature, изберете функцията за чертане на полигони и начертайте един 
полигон. После от долната част на дясното поле се прехвърлете на Attributes и можете да въведете 
желаната атрибутна информация за начертания полигон. Разбира се, вместо да ползвате описаното 
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поле Attributes, можете също да отворите таблицата на слоя и след изчертаването на обекта да се 
прехвърляте в прозореца на таблицата и да я попълвате. Както казахме, другия вариант е да 
начертаете повече или всички обекти от слоя и след това да попълните тяхната атрибутна 
информация в таблицата. Нека припомним, че ако искате да добавите колона в таблицата ще трябва 
първо да спрете редактирането на данните (Editor > Stop Editing), после в прозореца на таблицата да 
създадете желаните колони (иконата Table Options > Add Field), след което пак да стартирате 
редактирането (Editor > Start Editing) за да продължите въвеждането или промяната на данните.  

 

Друга възможност за въвеждане на данни е преобразуването на помощните графика и текст в 
база данни или shape-файл. В упражнение 5 разгледахме как можем да начертаем различни 
помощни фигури и текст в така наречения „козметичен слой“ на картата. Тогава уточнихме, че тези 
фигури и текст не се записват като данни, а се помнят само в документа на картата (в проекта). Все 
пак, има възможност да запишем помощните обекти като реални данни, така че те да са достъпни и 
за други проекти. Това става чрез функцията Convert Graphics to Features. Например, използвайте 
средствата за чертане от лентата Draw и нанесете няколко линии, точки, полигони и текст. После от 
бутона Drawing на същата лента изберете Convert Graphics to Features. В появилия се прозорец (виж 
следващата фигура), чрез опцията Convert можете да укажете кои помощни елементи искате да 
запишете – точките, линиите, полигоните или текста. Може да се експортират и само маркираните 
обекти (Selected graphics only). Указва се също координатната система, в която да бъдат записани 
координатите на обектите: може да са в същата система, като картата (the data frame), в системата на 
избран слой (this layer’s source data) или база данни (the feature dataset), но може и да се запишат 
като анотация към картата (the annotation group - пак вид помощен слой). Самите координати на 
помощните обекти се отчитат спрямо координатната система на картата, върху която са начертани. 
Освен това, в една карта може да присъстват слоеве с данни в различни координатни системи – 
тогава програмата преобразува в реално време координатите от системата на слоя в системата на 
картата, без да променя първичните данни. Затова тук е предвидена възможността да се укаже 
помощните обекти да се запишат в координатната система на даден слой, която може да е различна 
от системата на картата. В долната част на прозореца се указва къде и как да се казват записаните 
данни. Има и опция за изтриване на помощните обекти от картата след преобразуването им 
(Automatically delete graphics after conversion).  

 

Например, преобразувайте полигоновите обекти в нов shape-файл във вашата работна папка, 
като включите изтриването им след преобразуването (Automatically delete graphics after conversion). 
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След като данните бъдат записани, ще се появи запитване, дали искате да се добавят на картата, 
потвърдете с ОК.  

 

Персонални гео-бази данни 

В края на упражнението ще разгледаме още един популярен формат за пространствени данни. 
Това са персоналните гео-бази данни, които се съхраняват в стандартен файлов формат на Microsoft 

Access (.mdb). За разлика от разглежданите до сега shape-файлове, персоналната гео-база данни 
представлява един файл, в който различната информация (координати на обектите, атрибутни данни 
и др.) се съхранява в отделни таблици във файла. Освен това, една персонална гео-база данни (един 
.mdb файл) може да съдържа един или повече слоеве.  

Преди да продължим, премахнете от картата всички заредени до сега слоеве така, че да не 
съдържа никакви данни или просто отворете нова празна карта (File > New). Не е необходимо да 
записвате направените промени в данните и картата, с които работихме до сега. После отворете 
полето на каталога (Windows > Catalog), придвижете се до вашата работна папка и щракнете с десен 
бутон върху нея. От появилото се контекстно меню изберете New > Personal Geodatabase (виж лявата 
част на долната фигура) за да създадете нов файл във формат на персонална гео-база данни. 
Кръстете го, например, GeoMap. После щракнете с десен бутон върху новия файл – чрез New от 
появилото се контекстно меню (виж дясната част на долната фигура) вътре в геобазата данни можете 
да създадете нов слой (Feature Class), нова група от няколко слоя (Feature Dataset), нова таблица 
(Table) или растерен слой (Raster Dataset) и т.н. Освен това, чрез Import можете да вмъкнете в гео-
базата данни вече въведени данни от други файлове, а чрез Export – да запишете информацията в 
друг файл и/или в друг файлов формат.  

 

  

 

Представете си, например, че създавате геоложка карта, на която с точки показвате места на 
опробване, с линиите представяте разломи, а чрез полигони изобразявате разпространението на 
различни типове скали. За тази цел в персоналната гео-база данни ще създадем три слоя – точков, 
линеен и полигонов. От контекстното меню изберете New > Feature Class. В появилия се прозорец 
кръстете новия слой, например, Samples и нагласете типа на слоя да е точков (Type > Point Features), 
както е показано в лявата част на следващата фигура. Изберете бутона Next> и на следващата стъпка 
изберете за координатна система Geographic Coordinate Systems > World > WGS 1984. На следващата 
стъпка се задава толерансът на прецизност на координатите (XY Tolerance), т.е. минималното 
разстояние след което координатите се приемат за еднакви. Обикновено не се налага да променяте 
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зададената тук стойност по подразбиране, затова само изберете Next>. На последната стъпка (виж 
дясната част на долната фигура) се дефинират необходимите колони от атрибутната таблица и се 
задава техния формат. Така, ако имате яснота, можете още в началото да структурирате атрибутната 
таблица на слоя, а ако ли не – може да направите това по-късно. Потвърдете с бутона Finish за да 
завършим дефинирането на точковия слой.  

 

  

 

По същия начин, в персоналната гео-база данни създайте един линеен слой, като го кръстите 
Faults и един полигонов слой, наречен Rocks. После стартирайте редакцията (Editor > Start Editing) и 
в трите слоя начертайте по няколко обекта така, че да наподобяват някаква геоложка карта, но не 
отделяйте много време за това. Например, начертайте няколко съседни полигона, които да 
наподобяват разпространението на различни скали. Начертайте и няколко линии, част от които да 
съвпадат с граници между полигоните, а други да са секущи, за да изобразите разломи. Поставете и 
няколко точки, които ще представляват местата на терена, от които сте взели скални проби за 
анализи. След това, последователно отворете атрибутните таблици и въведете някаква информация 
за обектите. Например, в полето ID за точките можете да въведете числа, които да представляват 
поредните номера на пробите (122, 123, 124…). За разломите (линиите) въведете числа 1 или 2. Така 
можем с код 1 да обозначим установените разломи, а с код 2 – предполагаемите. За полигоните 
въведете нова текстова колона и обозначете различните полигони с различни букви A, B, C, …, които 
могат да представляват индекси за различните типове скали. Ако имате желание и достатъчно време, 
използвайте въображението си и въведете още и по-детайлна информация в нови колони от 
атрибутните таблици. За да се подсетите каква атрибутна информация можете да въведете, 
разгледайте някоя геоложка карта, като обърнете внимание и на нейната легенда. Например, 
можете да въведете пълните имена на скалите от полигоновия слой, вместо да използвате 
предложените по-горе индекси. За разломите пък може да добавите колони с посоките и ъглите на 
затъване. Не забравяйте да запишете последните редакции на слоевете. 

След това, изобразете трите слоя по подходящ начин, като използвате разгледаните по-рано 
методи за класификация (Layer Properties > Symbology). Например, точките на опробване можете да 
представите чрез еднакви символи (Single Symbol) и да ги надпишете с номерата на пробите, като 
използвате вече познатите ви методи за автоматично или ръчно надписване. Разломите от линейния 
слой представете с червени линии (Unique Values), като за установените разломи (1) изберете 
непрекъсната линия, а за предполагаемите (2) – прекъсната. Скалите също класифицирайте според 
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техния тип (Unique Values) и им задайте подходящи цветове и щриховки. В съставената легенда 
въведете подходящи кратки текстове (Symbology > Label), описващи групите обекти, като не 
забравяте, че тези текстове трябва да са достатъчно прецизни, понеже се изписват в легендата на 
окончателната карта. Накрая използвайте знанията си от упражнението за използване на планове и 
създайте окончателна карта. 

 

Когато приключите, запишете проекта, например, с името “exercise13” и затворете програмата. 



 80 

Упражнение 14. Цифроване на геоложка карта. 

Това е последното и може би най-важното упражнение в този курс, понеже ще засегнем 
основните действия по въвеждане на геоложки данни и съставянето на карти, които най-често се 
прилагат в практиката. Всъщност, много от действията вече са разгледани в предните упражнения, но 
сега ще проследим цялата последователност по съставянето на геоложка карта. След като усвоите 
това упражнение, по аналогичен начин можете да създавате не само геоложки, но и всякакви други 
карти. 

За нуждите на упражнението ще използваме една геоложка карта на находище Елаците, която 
е била на хартиен носител. За да бъде въведена в компютъра, картата е сканирана (в растерен 
формат) и записана под името ELATSITE_UTM35.tif, в папка \Elatsi_GeoMap от директорията с 
примерните данни. Същата карта е показана и на следващата фигура, така че, ако нямате 
примерните данни, придружаващи тези упражнения, можете да я сканирате от тук. Ако в папката 
\Elatsi_GeoMap има и други файлове – изтрийте ги преди да започнете, защото ще попречат на 
правилното изпълнение на упражнението (в папката да остане само файла ELATSITE_UTM35.tif)! 
Ако не виждате разширенията на файловете (като *.tif и др.), от настройките на компютъра (Control 

Panel > Appearance and Personalization) отворете настройките на папките Folder Options и от полето 
View изключете опцията за скриване на разширенията Hide extensions for known file types. 

 

Стартирайте програмата ArcMap и заредете сканираната геоложка карта \Elatsi_GeoMap\ 

ELATSITE_UTM35.tif. Програмата може да ви попита дали да създаде допълнителен файл с 
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пирамидална структура за по-бърза работа – потвърдете с YES. Ще се появи и прозорец, че липсва 
информация за координатната система на картата – засега го игнорирайте с ОК.  

Сканираната карта ще се зареди, разгледайте я. За да сте сигурни, че заредената карта е с 
оригиналните си цветовете, от настройките на нейния слой изключете подобренията на контраста 
(Layer Properties > Symbology > Stretch > Type: None)! 

В десния долен край на картата е изобразена мащабна линия и надпис за използваната 
проекция (мерните единици са метри). Обърнете внимание, че в картата са поставени кръстовидни 
маркери на координатната система, а около рамката са изписани координатите в метри. Легендата е 
разположена под картата, като отделните елементи са номерирани. Текстът под картата обяснява 
какво изобразява всеки номериран символ от легендата. 

От картата се вижда, че позицията на находището се контролира от къснокредния Елашки 
интрузив (голямата дайка), съставен от кварцмонцодиоритови и гранодиоритови порфирити и 
отбелязан с номер 3 в легендата, както и от няколко по-малки дайки с вариращ състав, отбелязани с 
номера 1 и 2. Дайките са внедрени в близост до контакта между старопалеозойски 
нискометаморфни скали (5) и долнокарбонския гранитоиден Веженски плутон (4). В екзоконтакта на 
плутона метаморфитите са контактно променени в хорнфелзи и пъпчиви шисти, но те не са 
отбелязани с отделен символ на картата. С червени линии е представено разпространението на 
Кашанския възсед-навлак (6) и главните разломни структури, като установените разломи са 
отбелязани с непрекъсната линия (7), а предполагаемите разломи – с пунктирана линия (8). Освен 
това, за да се покаже позицията на находището, с кафеникави пунктирани линии са показани няколко 
минни хоризонта от кариерата (9). 

Понеже картата е в проекция UITM зона 35, WGS-1984 и мерни единици – метри, от 
настройките View > Data Frame Properties > Coordinate System задайте Predefined\ Projected 

Coordinate Systems\ UTM\ WGS 1984\ Northern Hemisphere\ WGS 1984 UTM Zone 35N. За удобство 
може да увеличите така, че да се вижда само картата, включително и надписите на координатите, 
без да се вижда текста отдолу. 

Следващата стъпка е да привържем сканираната карта в координатната система, отбелязана на 
нея. За тази цел ще използваме функциите за георефериране. Изберете Customize > Toolbars > 

Georeferencing, за да включите лентата с инструменти за георефериране, след което можете да я 
преместите някъде да не ви пречи на картата. В лентата, чрез Layer се посочва кой слой ще бъде 
привързван, тук трябва да посочите ELATSITE_UTM35.tif (виж долната фигура). Първата от трите 
икони в дясната част на лентата дава достъп до функции за завъртане, преместване и мащабиране на 
избрания слой. Чрез втората икона можете да привързвате точки от картата, а третата икона показва 
таблица с грешките на привързването. 

 

Понеже върху картата с кръстчета са отбелязани точки от координатната система (точки с 
известни координати), ще използваме втората икона  (Add Control Points) за задаване на 
контролни точки. Преди това, за да виждате по-добре и да посочите контролните точки по-прецизно, 
използвайте от главното меню Windows > Magnifier, за да включите прозореца за увеличение. 
Можете да движите този прозорец върху картата и в него ще виждате увеличена тази част, върху 
която попада. Сега от лентата за георефериране изберете иконата  (Add Control Points). 
Действието на тази функция е да щракнете върху точка от картата и после да щракнете на мястото, 
където тази точка трябва да се премести. Освен това, избирайки точка от картата, може да зададете 
нейните координати. Обърнете внимание, че най-долното ляво кръстче от координатната мрежа на 
картата е с координати X=256400 m, Y=4737100 m. Преместете увеличителния прозорец върху това 
кръстче (да го виждате по-ясно) и докато е включена иконата  и посочете средата на кръстчето. 
Курсорът на мишката също ще има формата на кръстче, така че се стремете неговия център да 
попада възможно най-точно в центъра на кръстчето от картата. Щракнете веднъж в центъра на 
кръстчето от картата, после щракнете с десния бутон на мишката и от контекстното меню изберете 
Input X and Y. В появилия се прозорец въведете координатите на тази точка, съответно 256400 за X и 
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4737100 за Y и потвърдете с ОК. Точката автоматично ще се премести на указаните координати. 
Понеже заедно с точката се измести цялата карта, вероятно тя ще изчезне от екрана. За да я видите 

използвайте иконата за увеличение върху цялата карта  (Full Extent) и после с иконата-лупа (Zoom 

In) пак увеличете да виждате картата и координатите, без текста към легендата отдолу. После като 
втора опорна точка на координатната система ще използваме, например, най-долния най-десен 
кръст от координатната мрежа (намиращ се вдясно под мащабната линия), който е с координати 
X=258800, Y=4737100. Преместете увеличителния прозорец върху него, изберете иконата  и 
щракнете в средата му. Пак щракнете с десния бутон и чрез Input X and Y от контекстното меню 
въведете неговите координати. Картата автоматично пак ще се размести, за да се привърже и към 
тази точка, затова пак използвайте иконите за увеличение (Full Extent и Zoom In) и нагласете да 
виждате цялата карта. Накрая, по същия начин въведете координатите на най-горния най-ляв кръст и 
на най-горния най-десен кръст, които както виждате са съответно X=256400, Y=4738300 и X=258800, 

Y=4738300. Така вече имаме четири контролни точки със зададени координати, намиращи се по 
краищата на картата. По принцип, ако картата не е деформирана вследствие на износването на 
хартиения носител, при сканирането или поради други причини, четири контролни точки следва да 
са достатъчни за нейното акуратно гео-привързване. Изберете последната икона  (View Link Table) 
от лентата за георефериране за да видите таблицата с информация за контролните точки (виж 
следващата фигура). В таблицата, за всяка контролна точка са показани нейните първоначални 
растерни координати (X Source, Y Source), както са отчитани след зареждането на сканираната карта, 
както и новите координати (X Map, Y Map), където е преместена дадената контролна точка. В 
последната колонка (Residual) е показана грешката на привързване на всяка точка, а в долната част 
на прозореца е пресметната и средно квадратичната грешка (Total RMS Error) на геореферирането. 
Колкото по-малко е деформирана картата и колкото по-прецизно задавате контролните точки, 
толкова по-ниска следва да е стойността на грешката, която тук се показва в мерните единици на 
картата.  

 

Ако се наложи да привързвате деформирана карта и/или ако грешката е голяма, трябва да 
въведете още контролни точки, за да минимизирате средната грешка. Също така, ако грешката на 
дадена точка е по-голяма от грешките на другите точки, то най-вероятно не сте поставили точката 
прецизно или сте сбъркали при въвеждането на координатите. Можете да маркирате сбърканата 

контролна точка и да я изтриете с бутона  от дясната страна на прозореца. Чрез опцията 
Transformation се задава математичния метод за преобразуване на координатите в новата 
координатна система. Най-често прилаганите методи са полиномни от първа, втора или трета степен, 
като по-високите степени се използват за елиминиране на локални деформации. Освен това, за да 
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приложите преобразуване чрез полином от по-висока степен, ще трябва да въведете и повече 
контролни точки.  

Ако в таблицата няма контролна точка със значително по-голяма грешка спрямо останалите и 
ако средно квадратичната грешка не е голяма, значи сте привързали картата достатъчно прецизно. 
Затворете таблицата на контролните точки с бутона ОК. Затворете и увеличителния прозорец.  

След като привързахме картата към отбелязаната върху нея координатна система, можем да 
запишем промените, за да може при следващо отваряне на проекта или при зареждане на 
сканираната карта в друг проект да не трябва да въвеждаме контролните точки наново. За целта 
изберете първия бутон Georeferencing от лентата за георефериране. Първите две опции Update 

Georeferencing и Rectify от появилото се меню служат за запис на информацията от гео-
привързването. Чрез Update Georeferencing се записват два нови файла в същата папка и със същото 
име, като на сканираната карта (но с различни разширения), които съдържат информация за 
използваната координатна система и координатите на картата, като самия файл на сканираната карта 
остава непроменен. Другата опция Rectify служи за същинско преобразуване на сканираната карта 
чрез преподреждане на пикселите според избрания математичен трансформационен метод, като 
преобразуваната карта се записва в нов файл с друго име. Обикновено Rectify се използва когато 
искаме да запазим геореферираната карта за постоянно, ако ни се налага по-често да я ползваме или 
да я отваряме и в други специализирани програми. В дадения случай за нас е достатъчно да 
използваме опцията Update Georeferencing, затова изберете нея. Сканираната карта би трябвало вече 
да е в отбелязаната върху нея координатна система. Може да проверите това, като посочите някой от 
кръстовете върху картата, при което изписаните в долния край на прозореца на програмата 
координати трябва да са почти същите като отчетените по рамката на картата (разликите се дължат 
на факта, че на екрана трудно можете да посочите точно центъра на кръстчето с върха на курсора).  

 

Сега следва да направим една съществена стъпка, преди същинското цифроване (наричано 
още „дигитализиране“). Трябва да съставим план колко слоя и от какъв тип ще са необходими за 
съставяне на картата. Иначе казано, трябва да съобразим как да организираме и въведем в ГИС 
геоложката информация от сканираната карта. За тази цел трябва добре да разгледате картата и 
особено – нейната легенда. Първо следва да разграничите всички налични геоложки обекти от 
картата (скали, разломи и т.н.) в три групи – полигони, линии и точки. Вече знаете, че ще трябва да 
въвеждаме обектите в отделни слоеве от съответния тип. След това, трябва да съобразите колко слоя 
от всеки тип ще са ви необходими, за да организирате информацията. Например, върху някоя карта 
можете да имате както скални типове, така и тектонски единици, изобразени чрез полигони. В този 
случай можете да въведете разпространението и на скалите и на тектонските единици в един общ 
слой, но поради тяхната различна същност, от организационна гледна точка ще е по-добре да ги 
отделите в два отделни полигонови слоя. 

В картата на находище Елаците, която използваме в това упражнение, имаме изобразено 
разпространението на различни скали, които са полигонови обекти. Освен това са нанесени различни 
типове разломи и минните хоризонти, които са изобразени чрез полилинии, както и кръстовете на 
координатната система, които представляват точкови обекти. Така, в един общ полигонов слой може 
да бъде цифрована геоложката основа (скалите), като отделните скални разновидности могат да 
бъдат разграничени в атрибутната таблица на слоя, чрез приписване на кодове или някакъв пореден 
номер за всеки тип скала. Всъщност, в атрибутната таблица можем да въведем и текстови описания 
за отделните типове скали, но като начало и за улеснение ще използваме кодове. При създаването, 
кръстете този полигонов слой с подходящо име, например geobase.shp. Добре е кодовете за 
обособяване на скалните разновидности да бъдат така подбрани, че при сортиране по нарастващ ред 
най-младите скали да попаднат най-отгоре, а най-старите – най-отдолу. Линейните обекти, каквито 
са разломите и минните хоризонти, могат да бъдат цифровани също в един линеен слой, но поради 
различният характер на информацията е по добре тук да се използват два отделни линейни слоя – 
един за различните типове разломи (кръстете го например faults.shp) и един за минните хоризонти 
(можете да го кръстите mining_levels.shp). Типовете разломи също могат да бъдат разграничени, чрез 
задаване на някакви кодове или описания в атрибутната таблица, а след това – представени чрез 
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различни видове линии, като в легендата се зададат подходящи видове линии за всеки тип разломи. 
На тази карта ще ни трябват три кода за отделяне на трите типа разломи: установен, предполагаем и 
възсед-навлак. Минните хоризонти ще бъдат представени с еднакви линии, поради което не е 
необходимо да бъдат разграничавани в атрибутната таблица. Въпреки това, в таблицата на 
хоризонтите е добре да се създаде колона, в която да се въведат нивата на всеки хоризонт, като тези 
нива ще се използват по-късно за автоматично надписване на всяко ниво. Като точкови обекти в тази 
карта могат да бъдат разглеждани кръстовете от координатната мрежа, но не е необходимо 
създаването на слой за тях, тъй като координатната мрежа може да бъде автоматично нанесена от 
програмата. 

Преди да започнете цифроването на обектите е добре предварително да им изберете кодове, 
които да ги разграничават. За тази цел можете да нанесете с молив избраните кодове върху 
легендата на хартиената карта или да си скицирате легендата върху отделен лист. След това, по 
време на цифроването или след това следва да въведете кода на всеки обект. Като кодове можете да 
използвате и поредните номера от легендата (1, 2, 3, 4 и 5). След това изберете кодове за трите типа 
разломи от линейния слой – възсед-навлак, установен и предполагаем. Можете да ги обозначите 
съответно с 6, 7 и 8. За минните хоризонти казахме, че не е необходимо да задаваме кодове, понеже 
са един вид, а направо ще въвеждаме техните нива. 

Най-удобно е отначало да се цифрова полигоновия слой на геоложката основа. Настройте 
картата така, че да виждате геоложката карта максимално уголемена. Създайте нов полигонов shape-
файл като използвате менюто Windows > Catalog и го запишете във вашата работна папка, като го 
кръстите geobase. За координатна система задайте WGS 1984 UTM Zone 35N (както направихме за 
картата). Слоят geobase ще се зареди автоматично. После стартирайте редакцията на данните (Editor 

> Start Editing) и пак нагласете да виждате цялата карта, без текста под нея. Начертайте 
правоъгълник, който точно да обхваща цялата площ, в която са разположени скалите (по вътрешната 
рамка), без да включвате заобикалящите участъци на координатните надписи и външната рамка. 
Естествено, при задаването му, в правоъгълника ще попадне и частта, в която са разположени 
мащабната линия и информацията за проекцията, но после лесно ще я премахнем. След като 
опишете правоъгълника, той ще скрие геоложката основа, понеже по подразбиране ще бъде 
запълнен с плътен цвят. За да избегнем това неудобство, ще трябва да му зададем някаква 
прозрачна щриховка така, че да се виждат отделните обекти от слоя, но и отдолу да прозира и 
сканираната карта. Отворете настройките на слоя geobase, като щракнете два пъти върху името му. 
После в полето Symbology чрез опцията Symbol изберете някаква рядка наклонена щриховка 
(например 10% Simple hatch). В същия прозорец, за цвят на щриховката (Fill Color) задайте например 
средно зелено, а за цвета на контурите (Outline Color) изберете например светло син. Това ще 
направи правоъгълника прозрачен и така на заден план ще виждате сканираната карта, която трябва 
да пречертаете. Ако зададеният от вас правоъгълник не пасва добре на площта на картата, можете да 
го донагласите, като преместите краищата му. За по-прецизно коригиране на координатите на всяка 

от описващите го четири точки може да се използва функцията  Sketch Properties, чрез която 
можете ръчно и точно да въведете координатите на всяка точка. Тази функция е особено удобна, 
когато изчертаваната карта трябва да се помести в рамка с точно зададени координати.  

След като нагласите правоъгълника, обхващащ площта на картата, се уверете, че е маркиран, 
защото изрязването работи само върху маркираните обекти. Изберете иконата за разрязване и 

разделяне на полигона на отделни части  (Cut Polygons Tool от лентата за редакция). С нея можете 
да “нарежете” полигона по контурите на отделните скални разновидности. Това е най-удобният 
начин за цифроване на полигонови основи. Ако има участъци, които не включват някакви скали, 
каквато е площта, в която са разположени мащабната линия и информацията за проекцията, можете 
да я изрежете, след това да я маркирате (само нея) и изтриете с клавиша Delete или чрез менюто Edit 

> Delete. Стремете се да описвате (режете по) границите между скалите колкото се може по-
прецизно, но без да използвате прекалено много точки. В участъците, където границата е 
сравнително праволинейна следва да използвате по-малко точки, раздалечени една от друга, докато 
в участъците, където границата криволичи ще са ви необходими повече близко разположени точки, 
за да пресъздадете извивките. Ако някоя граница съвпада с разлом, съобразявайте и задавайте 
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точките така, че да описват добре както границата така и разлома. По-късно, при изчертаването на 
разлома трябва да използваме същите точки, за да не се получи разместване между геоложката 
граница и разлома, т.е. те точно да съвпадат. 

При тази карта, добра стратегия е първо да изрежете празния участък (с мащабната линия и 
информацията за проекцията), да маркирате само него и да го изтриете. После изрежете по 
границата между разположения на север Веженски плутон и метаморфитите, развити на юг. Така ще 
обособите две тела. От южното тяло изрежете двата участъка с метаморфни скали, разположени в 
горния му край (над голямата дайка). Помнете, че участъци от граница, които вече са изрязани не 
трябва да се повтарят, т.е. не трябва да се изрязват повторно. Иначе казано, за да изрежете двата 
участъка с метаморфити, трябва да изрежете само по техните южни граници, понеже северните им 
граници с Веженския плутон са вече изрязани. След като изрежете двете метаморфни тела, вие 
всъщност ще сте изрязали и северната граница на голямата дайка. Изрежете и нейната южна 
граница. После изрежете и по-малкото дайково тяло в източния край под нея. В резултат ще отделите 
всички скали от южната част на картата. Остава ви в северната част да изчертате малките дайкови 
тела, внедрени в гранодиоритите от Веженския плутон. 

Специфично за малките дайки е, че те попадат напълно в рамките на по-голямото тяло на 
Веженския плутон. В такива случаи трябва първо да отделите по-голямото тяло (Веженския плутон), 
което вече направихте чрез изрязване. След това, като използвате иконата за чертане на полигони 

, а не за изрязване, опишете някое от включените тела (дайките). След изчертаването на всяка 
дайка, докато тя е маркирана използвайте опцията за изрязване Editor > Clip, като задавате буферно 
разстояние 0 и включена опция за премахване на припокриващата се площ (Discard the area that 

intersects). Така в по-голямото тяло ще се образува “дупка”, запълнена с по-малкото тяло, т.е. от по-
голямото тяло ще изключим площта, покрита от по-малкото. Можете да се уверите, като наново 
маркирате само по-малкото тяло и го преместите встрани. При това трябва да видите “дупката” в по-
голямото тяло, но не забравяйте веднага да отмените направеното преместване чрез Undo (не се 
опитвайте да го върнете обратно ръчно, пак чрез преместване, понеже няма да успеете да го 
нагласите точно на мястото му). По аналогичен начин начертайте и останалите малки дайкови тела. 

Добре е от време на време да записвате направените промени, като използвате Editor > Save 

Editing. Имайте предвид, че всички редакции, които правите са временни и ще бъдат изгубени или 
“забравени”, ако например спре тока или изключите програмата. За да бъдат реално записани 
промените, трябва да използвате Editor > Save Editing. Освен това, добре е от време на време да 
записвате и целия проект (File > Save). При първото записване ще трябва да го кръстите (например, с 
името Elatsite_Map). 

Докато цифровате обектите от геоложката основа, не забравяйте че в атрибутната таблица 
трябва да въвеждате техните кодове, които сте избрали за да ги разграничавате. Обикновено, когато 
трябва да цифровате много обекти, най-удобно е по време на цифроването да отворите и 
атрибутната таблица. Така, след като опишете един или няколко обекта, можете директно да 
въведете кодовете им в таблицата. Ако опишете по-голям брой обекти без своевременно да 
попълвате техните кодове, ще трябва след това да ги маркирате един по един, да ги търсите в 
таблицата и чак тогава да въвеждате съответстващия им код. 

Понеже тази карта не съдържа голям брой обекти, можем да въведем техните кодове след 
като привършите цифроването (изрязването или изчертаването) на графичните обекти. Отворете 
атрибутната таблица на слоя geobase и разположете таблицата така, че да не припокрива картата. 
Маркирайте някой от полигоните върху картата и обърнете внимание какъв тип скала описва този 
полигон. После се прехвърлете в прозореца на атрибутната таблица и вижте кой ред съответства на 
избрания полигон – неговия ред трябва да е маркиран. В колоната ID от маркирания ред попълнете 
избрания код, указващ какъв тип скала описва дадения полигон. Например, ако сте маркирали 
полигон, описващ метаморфно тяло и ако за кодове сте избрали поредните номера от легендата, в 
полето ID от маркирания ред в таблицата трябва да въведете 5, понеже метаморфитите са петия 
поред символ в легендата. После маркирайте друг полигон, а в неговия ред в таблицата въведете 
кода, съответстващ на скалата, която маркирания полигон описва. Повторете тези действия, докато в 
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таблицата попълните съответните кодове за всички начертани графични обекти. В този пример 
предложихме за кодове на скалите да използвате поредния номер от легендата. Така всички 
полигони, описващи метаморфни скали, следва в колоната ID от таблицата да имат код 5, лежащите 
на север скали от Веженския плутон трябва да имат код 4, голямата дайка в централните части – код 
3 и т.н. Понеже предложените кодове са от 1 до 5, не трябва да имате обект в таблицата със стойност 
0 в колоната ID. Ако са ви останали редове със стойности 0 за ID, значи сте пропуснали тези обекти 
при въвеждането на кодовете. Следователно трябва да ги откриете на картата и да им въведете 
кодовете. Така, ако ви е останал някой обект без код (със стойност 0), за да го откриете най-лесно в 
картата, можете в таблицата да маркирате неговия ред и върху картата да видите кой графичен обект 
е маркиран. Ако пък имате много и дребни графични обекти и не можете да разпознаете кой от тях е 
маркиран, от таблицата използвайте функцията Zoom to Selected, за да увеличите картата върху 
избрания обект и да го видите по-ясно. 

След като завършите цифроването на полигоновия слой, съдържащ скалните разновидности и 
въведете съответните им кодове, запишете наново крайния вариант (Editor > Save Editing). 

Следващата стъпка е да цифровате някой от линейните слоеве. Понеже слоят, описващ 
минните хоризонти е по-лесен, започнете с него. Създайте нов линеен слой чрез менюто Windows > 

Catalog, кръстете го mining_levels и му задавайте координатна система WGS 1984 UTM Zone 35N. За 
да виждате по-добре докато чертаете хоризонтите, можете да зададете, например, виолетов цвят за 
линиите от този слой. По познатият ви от предното упражнение начин, използвайте иконата за 

организиране на шаблоните  (Organize Templates), за да направите достъпна редакцията и на 
линейния слой. Изберете бутона за чертане на полилинии и начертайте минните хоризонти. Най-
ниското ниво 1045 изглежда като полигон, но опишете и него с полилиния, като привържете 
последната точка към първата. След като начертаете всички минни хоризонти, отворете атрибутната 
таблица на слоя mining_levels и в колоната ID въведете надморските височини на хоризонтите – те са 
надписани до всеки хоризонт. Запишете въведената информация (Editor > Save Editing). 

Остава да цифровате и разломите. Временно изключете визуализирането на слоя mining_levels, 
за да не ви пречат начертаните минни хоризонти докато цифровате разломите. Създайте нов линеен 
shape-файл (Windows > Catalog) и го кръстете faults, пак като му зададете координатна система WGS 

1984 UTM Zone 35N. Чрез настройките на слоя задайте червен цвят за изчертаване на разломите. 
Както вече казахме, понеже на места границите между скалите са разломни, ще трябва да 
привържете част от разломите към вече създадените геоложки граници. Увеличете картата така, че 
да виждате максимално уголемени всички разломи от сканираната карта. Ако междувременно сте 
спрели редакцията на данните – включете я отново (Editor > Start Editing) и използвайте функцията 

за организиране на шаблоните  (Organize Templates), за да направите достъпна редакцията и на 
слоя с разломите. После начертайте, например, разположения на север установен разлом, 
ориентиран в северозапад-югоизточно направление. Започнете, като поставите първата точка в 
началото (горния ляв край) на непрекъснатата черна линия. Пунктираната част от разлома показва 
неговото предполагаемо продължение, което ще цифроваме отделно, по-късно. Продължете 
цифроването на разлома, като добавяте нови точки. Когато стигнете до областта, където разлома 
съвпада с геоложката граница между гранитите и метаморфните скали, използвайте усвоените от 
предното упражнение методи за привързване (Snapping) и поставете новите точки от разлома така, 
че те да се привържат точно към съществуващите вертекси от геоложката граница. Докато 
привързвате към точките от геоложката граница, гледайте да не пропуснете някоя. Също така, не 
поставяйте нови точки от разлома между съществуващите точки от геоложката граница. Напомняме, 
че за да получим пълно съвпадение между разлома и геоложката граница, трябва описващите ги 
сегменти да са съставени от едни и същи точки. Продължете да цифровате разлома, като го 
привързвате към точките от различните геоложки граници, докато стигнете мястото, където този 
разлом се съчленява с лежащия на юг от него изток-западно ориентиран разлом. В мястото на 
съчленяване на двата разлома също трябва да поставите точка, за да може по-късно при 
изчертаването на втория разлом да го привържете към първия. Всъщност, в точката на съчленяване 
би трябвало да сте поставили точка от геоложката граница на голямата дайка, така че привържете 
новата точка към нея. Както вече казахме, когато изчертавахте границите между скалите трябваше да 
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разполагате техните точки така, че те да описват добре и разломите в местата на съвпадение между 
геоложките граници и разломите. Продължете да цифровате разлома, като привързвате към 
геоложките граници, докато стигнете мястото, където двата разлома отново се разделят. Тук също 
поставете точка, която би трябвало да съществува и в геоложката граница. После продължете 
разлома на юг, като не забравяйте да сложите точка в мястото на съчленяване с Кашанския възсед-
навлак. Последната точка от изчертавания първи разлом сложете, като прищракате два пъти в края 
на непрекъснатата линия. 

Сега начертайте втория установен разлом, ориентиран в изток-западно направление. Виждате, 
че той е отместен от първия, поради което ще трябва да го опишете с две отделни линии. Първо 
начертайте, например, западната част, като в местата на съвпадение привързвате точно към 
геоложката граница. Привържете последната точка от западната част на разлома като прищракате 
два пъти в мястото на съчленяване с първия разлом. По същия начин, като нова полилиния 
цифровайте и източния сегмент от този разлом. После, пак чрез отделни полилинии, начертайте 
участъците на предполагаемото продължение на разломите. Имайте предвид, че един предполагаем 
разлом трябва да е описан с една цяла полилиния, а не да слагате отделна линия за всеки пунктир от 
разлома. Вече знаете, че вида на линията (непрекъсната, пунктирана, точкова и т.н.) се задава 
впоследствие при създаването на легендата. Накрая, като две полилинии начертайте и двата 
сегмента от Кашанския възсед-навлак. 

След като начертахте разломите, следва в атрибутната им таблица да въведете и кодове, чрез 
които да различавате техните типове. Отворете атрибутната таблица на слоя faults и като маркирате 
разломите един по един, в колоната ID на таблицата въведете, например, код 6 за сегментите на 
Кашанския възсед-навлак, код 7 за всички установени разломи и код 8 за предполагаемите разломи. 
Когато въведете всички кодове, запишете промените (Editor > Save Editing) и затворете прозореца на 
атрибутната таблица. 

С това привършихме изчертаването на разломите. В процеса на цифроване на даден слой 
може да откриете грешки или пропуски в някой от другите слоеве. В такъв случай можете 
своевременно да поправите обектите от другия слой, след което да продължите с въвеждането на 
текущите данни. 

След като сте приключили с цифроването и редакцията на всички обекти от картата, уверете се 
че сте записали промените и спрете редакцията на слоевете (Editor > Stop Editing). Сега използвайте 
настройките на слоевете (Layer Properties > Symbology), за да зададете подходящите цветове и 
типове линии и щриховки на обектите, както и да настроите надписите. Така, за слоя geobase 
класифицирайте скалите по метода на уникалната стойност (Unique values) според полето ID (Value 

Field: ID). За всеки тип скала (обозначени чрез кодовете 1, 2, 3 и т.н.) нагласете цветовете и 
щриховките, както са в оригиналната сканирана карта. В колоната Label на легендата въведете 
кодовете или наименованията на съответните скали. Слоят с минните хоризонти mining_levels 
оставете некласифициран, т.е. по метода Single symbol, но настройте типа на линията, например, на 
кафява пунктирана линия. Освен това, в полето отдолу (Legend) може да зададете 9, за да се появи 
като надпис в легендата. Като използвате средствата за автоматично или ръчно надписване, 
надпишете всеки хоризонт със стойността на неговата надморска височина, записана в полето ID от 
атрибутната таблица. Разломите от слоя faults също класифицирайте по метода на уникалната 
стойност (Unique values) според техния тип, кодиран в колоната ID от атрибутната таблица. В 
прозореца на легендата задайте съответните типове линии за трите типа разломи (установен, 
предполагаем и възсед-навлак) и ги надпишете в колоната Label. Ако искате да обозначите възсед-
навлака чрез съответната линия с триъгълници, ще трябва да заредите и палитрата Geology 24K (чрез 
бутона Style References). Освен това, може да се окаже, че триъгълниците по линията не сочат в 
правилната посока, понеже тяхната ориентация зависи от посоката на цифроване на линията. В такъв 
случай, за да обърнете направлението на дадена линия, направете следното: включете редакцията, 

маркирайте линията, изберете режима за редакция на точките  (Edit Vertices), щракнете с десен 
бутон върху линията и от контекстното меню изберете Flip. Така ще размените началото и края на 
линията, т.е. ще обърне нейната посока, в резултат на което триъгълниците ще сочат вече в другата 
посока.  
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След като нагласите всички обекти от отделните слоеве така, че да съответстват на сканираната 
карта и им въведете в легендата съответните кодове или обяснителни надписи, слоят със 
сканираната карта вече ще стане излишен. Можете да изключите неговото визуализиране или 
изобщо да го премахнете. 

 

Остава да оформите окончателната карта, като използвате уменията, усвоени от предните 
упражнения. Увеличете картата така, че да обхваща всички начертани обекти, без полетата с 
легендата и текста от сканирания оригинал. Превключете в режим за създаване на окончателна карта 
(Layout View) и настройте страницата на размер А4. Нагласете картата така, че да заема по-голяма 
част от страницата. Освен това, задайте някакъв точен мащаб, като 1 : 20 000. В плана нагласете 
областта (рамката) на картата така, че да обхваща максимално плътно картата, т.е. почти да няма 
празни пространства между картата и нейната рамка. За тази цел прихванете горното или долното и 
лявото или дясното черно квадратче от рамката и ги придвижвайте към картата. Ако е необходимо, 
използвайте и функцията Pan, за да преместите картата в центъра на рамката.  

За да добавите координатната мрежа, използвайте настройките на картата (View > Data Frame 

Properties > Grids > New Grid). Ще се стартира помощникът за обозначаване на координатната 
система. В неговия първи прозорец се указва какъв тип да бъде маркировката – географска 
(Graticule), проекционна (Measured Grid) или референтна (Reference Grid). Понеже нашата карта не е 
в географски координати (градуси дължина и ширина) а в метри, най-удачно ще е да използваме 
втория тип. В долния край на прозореца има няколко бутона, съответно за връщане на една стъпка 
назад (<Back), за продължаване на следващата стъпка (Next>) и за прекъсване на функцията (Cancel). 
Включете опцията Measured Grid и преминете на следващата стъпка чрез бутона Next>. Ще се появят 
нови настройки на координатната мрежа, като начин за изчертаване – само с надписи (Labels only), 
чрез кръстове и надписи (Tick marks and labels) или линии с надписи (Grid and labels), стил на 
линиите или кръстовете, интервал на маркиране (Interval). Включете Tick marks and labels, задайте 
например 400 и 300 метра съответно по X и Y и изберете бутона Next>, за да отидете на следващата 
стъпка. Тук се избират стиловете за изобразяване на главните и второстепенни маркери и 
надписването – засега ги оставете както са по подразбиране. На следващата стъпка се избира дали да 
има вътрешна рамка около картата (Measured Grid Border) и външна рамка около надписите 
(Neatline), както и дали маркировката да се запише като помощни текстови и графични елементи от 
картата или като фиксирана маркировка, която ще се обновява при промяна на мащаба (Grid 

Properties). Тук също оставете настройките по подразбиране и изберете бутона Finish, за да 
приключите настройването на маркировката. В резултат в списъка в полето Grids (от настройките на 
картата) ще се появи нова мрежа, наречена Measured Grid, която можете да включвате и изключвате 
чрез отметката пред нея, да я изтриете чрез бутона Remove Grid, както и да промените нейните 
настройки чрез бутона Properties. Потвърдете с ОК и ще видите зададената координатна маркировка 
върху картата. Ако, поради някаква причина получената координатна система не ви харесва, можете 
чрез бутона Properties да промените нейните настройки или да я изтриете и да я направите наново.  

Сега следва да добавите легендата към картата. Един вариант за оформяне на легендата е да 
надпишете обектите чрез техните поредни номера (индексите от колонката ID от атрибутната 
таблица), а отдолу като отделен текст да опишете всеки номер на каква скала или тип разлом 
отговаря –  така е подходено и в оригиналната сканирана карта ELATSITE_UTM35.tif. Друг вариант е 
в полето на съдържанието предварително да въведете до всеки символ на какво съответства и така в 
легендата срещу всеки символ ще се изписва не поредния номер, а направо типовете скали и 
разломи. Изберете един от двата варианта по ваше желание, а впоследствие може да изпробвате и 
другия. 

Изберете менюто Insert > Legend за да започнете процеса по добавяне на легендата. В първия 
прозорец следва да изберете кои слоеве да бъдат включени в легендата. В централната част на 
прозореца има два списъка, като в левия са изброени заредените слоеве. Използвайте стрелките за 
да прехвърлите в десния списък тези слоеве, които искате да се съдържат в легендата, както и да ги 
подредите така, както искате да са подредени в окончателната легенда. Освен това, тук можете да 
зададете и броя на колоните в легендата. Използвайте бутона Preview за да видите как ще изглежда 
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легендата. Натиснете повторно бутона Preview и после бутона Next>, за да отидете на следващата 
стъпка, където се задава заглавие за легендата, както и настройки за шрифта, големината, стила и 
разположението на заглавието. За заглавие можете просто да въведете текста “Легенда:” (разбира 
се, без кавичките). На следващата стъпка (Next>) се настройва рамката и фоновия цвят около 
легендата, а на по-следващата – начина на визуализиране на площните и линейните обекти. На 
последната стъпка могат да се задават различни разстояния между символите, текстовете, 
заглавието, колоните и др. Накрая използвайте бутона Finish, за да завършите създаването на 
легендата. Ако така получената легенда не ви харесва, можете щракнете два пъти върху нея и 
допълнително да промените настройките по ваше желание или да я изтриете и направите наново. 
Също така, можете да използвате тази функция няколко пъти и да въведете самостоятелни легенди 
за всеки слой по отделно, които след това да подредите или разположите на различни места върху 
страницата. Ако е необходимо, можете да коригирате имената на слоевете и надписите в полето на 
съдържанието, както и да изключите показването на имената на слоевете в легендата, така че 
окончателната легенда да има смислен и завършен вид, без излишни надписи и заглавия, които 
могат да объркат потребителя.  

Накрая добавете помощните обозначения, като мащабна линия и знак за посоката на севера. 
Оформете окончателната карта така, че да добие завършен вид. Запишете проекта и затворете 
програмата ArcMap. 

 

За да затвърдите уменията си можете да повторите това упражнение, като сканирате и 
цифровате някоя ваша геоложка карта, например – карта, която трябва да включите в курсов проект, 
реферат или друга. Преди да сканирате вашата карта не забравяйте да поставите линии или 
кръстове, описващи координатната мрежа, ако върху картата няма такива. Иначе няма да можете да 
привържете картата в съответните координати и проекция. Ако картата, която ще сканирате и 
цифровате не съдържа никаква информация за координати и проекция, можете да зададете и 
използвате относителна координатна система. За тази цел, на долния ляв край на картата можете да 
припишете координати 0,0. После, по четирите страни на рамката на картата нанесете отметки през 
равни интервали в метри, като ги съобразите с мащаба на картата и ги надпишете (например 100, 

200, 300 метра и т.н.). След това свържете отметките от противоположните страни на рамката, за да 
начертаете координатни линии или кръстове. Така ще получите някаква относителна координатна 
мрежа, която е достатъчна за да можете да работите с избраните мерни единици и мащаби. След 
като имате координатна мрежа и сканирате картата, използвайте усвоените от предишното и от това 
упражнение умения за да цифровате и оформите вашата карта. Вероятно вече сте се убедили, че 
Географските Информационни Системи са мощно средство както за анализ на пространствената 
информация, така и за подготовка на прецизни и висококачествени карти. 

 

С това упражнение завършва практическата подготовка от курса по Геоинформационни 
системи. Надявам се, че задачите са ви били интересни и приятни, а получените умения ще ви бъдат 
полезни в по-нататъшната ви практика. 

 

 




